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Introduction
This Release Notes document summarizes the features, enhancements, and updates delivered with 
FlexNet Operations 2025.12 in December 2025. The document includes the following information:

• Resources

• Features and Enhancements

• System Requirements

• Resolved Issues

• Known Issues

• Special Notes

• SOAP API Change Log

• Legal Information

Resources
These resources are available for more information about FlexNet Operations and other Revenera 
products:

• Revenera Resources

• FlexNet Operations Videos

• Previous FlexNet Operations Release Notes

Revenera Resources
The following resources can help you stay up to date with FlexNet Operations news and product 
knowledge:

• In addition to providing case management, the Revenera Community site can help you quickly find 
answers to your questions by searching content from other customers, product experts, and 
thought leaders. You can also post questions on discussion forums for experts to answer. For 
each of Revenera’s product solutions, you can access forums, blog posts, and knowledge base 
articles. You can also access the Product and License Center from the Community’s Other 
Resources menu to download Revenera products.

• You can find documentation for FlexNet Operations and all other Revenera products on the 
Revenera Product Documentation site.

Note that any FlexNet Operations documentation published for UAT is subject to finalization until 
the Production release.

• The Revenera Learning Center offers free, self-guided, online videos to help you quickly get the 
most out of your Revenera products. You can find a complete list of these training videos in the 
Learning Center. 

https://community.revenera.com
https://docs.revenera.com
https://learning.revenera.com
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• Customers who have purchased a maintenance contract for their product(s) can submit a support 
case or check the status of an existing case by first logging into the Revenera Community, clicking 
Support on the navigation menu to open the Support Hub page, and then clicking the Open New 
Case or Case Portal button.

FlexNet Operations Videos
These brief, informative videos walk you through the getting-started exercises found in the FlexNet 
Operations User Guide (online help or PDF version). We recommend that you first read the appropriate 
“Getting Started” section in the User Guide to gain an understanding of the concepts it covers, and 
then click the section title in the table below to view the video.  

Previous FlexNet Operations Release Notes
To view the release notes associated with FlexNet Operations ALM releases from previous years, 
access https://docs.revenera.com/?product=FlexNet%20Operations and select the appropriate year 
from the VERSION list.

Guide Topics

Getting Started with 
Entitlement Management

Creating an account, a user, a product, and an entitlement. 

Getting Started with FlexNet 
Embedded Licensing

Setting up a publisher, identity, and a licensed product. Creating a 
device and activating its license. Creating and provisioning FlexNet 
Embedded license servers. 

Getting Started with 
Electronic Software Delivery

Creating a producer and download packages, associating 
download packages with a product, creating files, associating files 
with download packages, and viewing and downloading files from 
the FlexNet Operations End-User Portal. 

Getting Started with Usage 
Management

Creating a usage-based license model, a feature, a product, and an 
entitlement. Obtaining the license server URL to which the usage 
data is sent. Running a usage-capture client. Viewing usage 
information graphs and gauges.

Getting Started with FlexNet 
Publisher License File-Based 
Licensing

Activating and returning a certificate license.

Getting Started with Cloud 
Licensing Service

Creating a cloud-hosted license server. 

Getting Started with FlexNet 
Customer Growth

Customer growth concepts and configuring notifications for 
expiring entitlements and expired entitlements. 

https://youtu.be/L_DJynsiCRs
https://youtu.be/6-juN9F9OBo
https://www.youtube.com/watch?v=VGnH8dFj_bE
https://youtu.be/1rPRl-NKgJY
https://youtu.be/-OHqqD62fyk
https://www.youtube.com/watch?v=MNX5bgFHPVg
https://youtu.be/u0oCCN-iXJU
https://docs.revenera.com/?product=FlexNet%20Operations
https://community.revenera.com
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Features and Enhancements
The following sections describe the new features and enhancements added to FlexNet Operations in 
2025:

• Features and Enhancements in 2025.12

• Features and Enhancements in 2025.11

• Features and Enhancements in 2025.10

• Features and Enhancements in 2025.09

• Features and Enhancements in 2025.08

• Features and Enhancements in 2025.07

• Features and Enhancements in 2025.06

• Features and Enhancements in 2025.05

• Features and Enhancements in 2025.04

• Features and Enhancements in 2025.03

• Features and Enhancements in 2025.02

• Features and Enhancements in 2025.01

Features and Enhancements in 2025.12 
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.12 
release:

• Device Management Enhancements in 2025.12

• Entitlement Management Enhancements in 2025.12

• SOAP and REST Web Services Enhancements in 2025.12

• User Experience Enhancements in 2025.12

• User Management Enhancements in 2025.12

Device Management Enhancements in 2025.12
The following enhancements to device management were added in the 2025.12 release.

• Devices Template Enhancements: Returning Devices in Bulk

• Obsolete Device and Server Actions in End-User Portal

Devices Template Enhancements: Returning Devices in Bulk 
(Case 02880447, SWM-21905)
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As part of ongoing improvements to the Devices template, we have introduced a new worksheet called 
ReturnHost.

The ReturnHost worksheet enables users to return (de-register) multiple devices in a single operation. 
This approach significantly reduces execution time for bulk device returns.

Implementation Details

To download the template, navigate to Administer > Import Data Objects and select the Data Import 
Templates tab. Click the hyperlinked name of the Devices Template to download it. Open 
DevicesTemplate.xlsx and locate the ReturnHost worksheet.

You can specify the following details on the ReturnHost worksheet:

• Transaction Type

• Host ID

• Publisher Name

• Host Class

• Host ID Type

• Target Host ID

• Target Host Publisher Name

• Target Host Class 

• Target Host ID Type

• Return Material Authorization Number

Note • In the template, column headers formatted in bold indicate mandatory fields.

Tip • For more details, see Importing Entities in the FlexNet Operations User Guide.

Obsolete Device and Server Actions in End-User Portal
(Case 03906962, SWM-29036)

We’ve added new functionality to the End-User Portal, enabling end users to manage devices and local 
license servers more effectively:

• The View Server and Device pages now include the Obsolete Server and Obsolete Device options 
in the Action menu.

https://docs.revenera.com/fno_CURRENT/producer/Content/helplibrary/Importing_Entities.htm
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• These actions provide functionality equivalent to the existing Make Obsolete feature in the 
Producer Portal.

Configuration & Permissions

The new options can be hidden by deselecting the system configuration option Allow Obsolete 
Devices/Servers (under System > Configure > End-User Portal Setup > Devices Page). By default, the 
configuration option is selected.

Only users with the permission Obsolete Devices/Servers (part of the Account Permissions - End-User 
Portal group) can view and use these actions. This permission is assigned by default only to system 
administrator users.

Note • The Obsolete Server menu item is currently only available for local license servers. Revenera 
aims to add the same functionality for Cloud Licensing Service (CLS) instances.

Entitlement Management Enhancements in 2025.12
The following enhancements to entitlement management were added in the 2025.12 release.

• Entitlement Status Change Propagates to All Associated Line Items and CLS

• New Option to Select License Email Template Variations for FlexNet Publisher Licenses

• Copy Order ID in Bulk Upgrade Operations

• Setting a Default Distribution Tier Type for Entitlement Creation

Entitlement Status Change Propagates to All Associated Line Items and CLS 
(SWM-29203)

This enhancement introduces the ability for producers to seamlessly toggle the status of an 
entitlement between Active and Inactive within FlexNet Operations. Building on existing line item-level 
functionality, this feature extends license control to the entitlement level, simplifying bulk license 
management and renewal workflows.
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When a producer deactivates an entitlement, all associated line items—including maintenance line 
items—automatically transition to an Inactive state. The entitlement and its associated features will be 
set to a non-deployed status in Cloud Licensing Service (CLS), ensuring that no licenses are served.

Implementation Notes

The functionality is controlled by the configuration option License server features will become inactive 
when the entitlement or line item state is changed to Inactive (under System > Configure > FlexNet 
Operations > General Options). 

This option can only be enabled both the following configuration options are unselected:

• Remove licenses from CLS when the line item state changes to Inactive/Obsolete

• Allow used entitlement/line item state change to Inactive or Obsolete

Note • This enhancement does not include data template-based entitlement updates.

New Option to Select License Email Template Variations for FlexNet 
Publisher Licenses
(Cases 02448267, 02461390; SWM-19918)

Previously, when emailing a FlexNet Publisher license to a customer, producers had the following 
options: 

• use the DEFAULT variation of the License Email template from the Send License File Via Email 
page (available by selecting a fulfillment on the Support Licenses and Maintenance page and 
clicking Email License)

• add a license template when creating a license technology on the Create a License Technology 
page (under Administer > License Technologies > Add a License Technology).

To provide more flexibility in selecting a License Email template, we added a new dropdown menu 
License Email Template variation to the Send License File Via Email page. This enables producers to 
choose any available License Email template variation from the list when sending a FlexNet Publisher 
license.
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Figure 1: For FlexNet Publisher licenses, producers can select the License Email template from the 
License Email Template variation dropdown menu on the Send License File Via Email page.

This enhancement provides greater control and customisation, ensuring the right template is used for 
each customer communication.

Copy Order ID in Bulk Upgrade Operations
(Case 02795165, 02984932; SWM-20010)

FlexNet Operations now supports copying the order ID from the parent entitlement line item to the 
upgraded line item during Bulk Upgrade operations. 

Previously, users could manually set the order ID when creating an entitlement line item. However, 
during upgrades, the order ID was not automatically carried over to the target line item.

Tip • This enhancement builds on the functionality introduced in the 2022.12 release, where custom 
attributes could be copied during upgrades (see Ability in Bulk Upgrade Wizard to Copy Custom 
Attributes in the FlexNet Operations 2022 ALM Release Notes).

Implementation Notes

In upgrade scenarios (for example, when Product04 is upgraded to Product05), users can now choose 
to copy the order ID from the original entitlement line to the upgraded one.

During the upgrade operation, selecting Yes for the new Copy Order ID? option (on the Entitle 
Customer To Licenses | Bulk Upgrade - Line Item Attributes page) will trigger the system to carry over 
the order ID.

https://docs.revenera.com/fno2022/html/Content/helplibrary/Entitlement_Management_Enhancements_in_2022_12.htm
https://docs.revenera.com/fno2022/html/Content/helplibrary/Entitlement_Management_Enhancements_in_2022_12.htm
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Figure 2: The new Copy Order ID? option on the Entitle Customer To Licenses | Bulk Upgrade - Line 
Item Attributes page.

To verify the that the order ID has been applied to the upgraded line item, navigate to the List 
Entitlements by Order section, where the upgraded line item will display the same order ID as its 
parent.

Additionally, when editing the upgraded entitlement, the retained Order ID is clearly visible, confirming 
successful copying.

Setting a Default Distribution Tier Type for Entitlement Creation
(Cases 03569865, 03569975; SWM-28314)

This enhancement introduces a new configuration option Default Operator Used for default 
Distribution Tier Type (under System > Configure > FlexNet Operations > General Options) that allows 
producers to set a default value for the distribution tier type when creating entitlements. 

Once configured, the Distribution Tier Type dropdown menu in the End Customer And Channel 
Partners dialog (displayed when adding line items to an entitlement) is automatically populated with 
the pre-set value.
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Previously, the Distribution Tier Type order was randomly set when additional partner tiers were added, 
requiring manual selection during entitlement creation. Producers with multiple partner tiers had to 
manually select the correct tier (for example, Distributor) during entitlement creation, as shown in the 
following screenshot:

Figure 3: The Distribution Tier Type dropdown menu will be automatically populated if the option 
Default Operator Used for default Distribution Tier Type is configured.

Missing this step often led to errors and additional corrective actions.

For producers who frequently use a certain distribution tier as the initial partner tier, this enhancement 
simplifies entitlement creation and improves accuracy, reducing operational overhead.

SOAP and REST Web Services Enhancements in 2025.12
The following enhancement was added to the SOAP and REST Web Services module in the 2025.12 
release.

Configurable Inclusion of Line-Item Custom Attributes in Event Notifications
(Case 04198407, SWM-30140)

A new configuration parameter has been added to the Event Notification Service REST API that allows 
system integrators to control whether line-item custom attributes are included in event notifications 
sent to a webhook URL. This parameter, includeLineItemCustomAttributes, is a boolean property 
that can be passed when calling the /notificationService endpoint using either POST (create) or PATCH 
(update). 

Unless explicitly set in a call, includeLineItemCustomAttributes defaults to false, meaning line-item 
custom attributes are excluded from the payload. When set to true, the payload include line-item 
custom attributes.
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This change is fully backward compatible, ensuring that existing webhook consumers are not affected 
when the configuration is not enabled.

User Experience Enhancements in 2025.12
The following user experience enhancement was added in the 2025.12 release.

• Ability to Modify Cookie Policy Selection

• New Resource Center

Ability to Modify Cookie Policy Selection 
(SWM-26567)

In the 2025.12 release, the We value your privacy pop-up in the FlexNet Operations Producer Portal 
has been enhanced to allow users to manage their cookie preferences after initial consent. The 
following screenshot shows the updated pop-up:

Figure 4: The updated We value your privacy pop-up, which now enables users to manage cookies.

Users can now adjust their settings by clicking Manage Cookies in the pop-up, which opens a dialog 
with two options:

• Strictly Necessary—Enabled by default and cannot be changed. These cookies are required for the 
application to function properly.

• Enhanced Experience—Enabled by default. Selecting this option and clicking Save provides 
consent for collecting usage data and enables features such as the Resource Center (see New 
Resource Center, below). If the user clicks Cancel, consent is not given, and the dialog will 
reappear when navigating to a new page.
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Figure 5: The new Manage Cookies dialog.

After saving preferences, a green banner confirms that the settings have been updated. 

Figure 6: Green banner confirming that cookie preferences have been saved.

Users can revisit the Manage Cookies dialog at any time via the Manage Cookies link in the bottom bar 
to change their preferences.
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Clearing the browser cache removes all cookies, and the pop-up will be displayed again when 
navigating to a new page in the Producer Portal.

New Resource Center
(SWM-26567)

The 2025.12 release introduces the Resource Center, a central hub within the FlexNet Operations 
Producer Portal that provides quick access to key customer resources and in-app notifications.
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From the Resource Center, users can access:

• Announcements

• Documentation

• Revenera Community

• Learning Center 

• Support Hub (login required)

• Status Dashboard

To open the Resource Center, click the question mark icon in the lower-right corner of the Producer 
Portal. An additional indicator icon will appear when there are new or unread notices.

Important • The Resource Center is only visible when the Enhanced Experience option is enabled in 
the Manage Cookies dialog.

Please note that the Announcements section on the home page may be deprecated at a future date, as 
announcements will now be available through the Resource Center. We encourage users to enable 
Enhanced Experience cookies to received in-app messages.

User Management Enhancements in 2025.12
The following user management enhancement was added in the 2025.12 release.

OpenID Connect (OIDC) Support in FlexNet Operations Single Sign-On
(SWM-28970)

We have added OpenID Connect (OIDC) as a supported protocol for Single Sign-On (SSO) in the FlexNet 
Operations Producer Portal. This enhancement provides a modern, secure, and standards-based 
approach to authentication, complementing the existing SAML integration.

Key Features

• Improved Interoperability—Integration with a wide range of identity providers that support OIDC.

• Enhanced Security—Reduces reliance on XML-based protocols (SAML) and leverages JSON Web 
Tokens (JWT) for streamlined communication.

Configuration Overview

Configuring OpenID Connect support in the Producer Portal involves the following steps:

1. Identity Provider Setup—Ensure your IdP supports OIDC and configure client credentials (Client ID 
and Client Secret).

2. Producer Portal Configuration—Navigate to Administration > Configure Single Sign-On and select 
OIDC as the protocol.

3. Redirect URIs—Add the FlexNet Operations callback URL to your IdP configuration.
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4. Scopes and Claims—Define required scopes (for example, openid, profile, email) and map claims 
to FlexNet Operations user attributes.

Benefits

• Simplifies integration with cloud-native identity solutions.

• Provides a future-ready authentication mechanism aligned with modern security standards.

• Offers flexibility for organisations adopting hybrid or multi-cloud environments.

Features and Enhancements in 2025.11 
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.11 
release:

• Account and User Management Enhancements in 2025.11

• Electronic Software Delivery Enhancements in 2025.11

• Entitlement Management Enhancements in 2025.11

• SOAP and REST Web Services Enhancements in 2025.11

Account and User Management Enhancements in 2025.11
The following enhancement for the management of accounts and users was added in the 2025.11 
release.

Support for Country Field in FlexNet Operations’ User Synchronization 
Service 
(Case 04164122, SWM-29615)

FlexNet Operations now supports capturing the user's country information during SCIM-based user 
provisioning.

Previously, all users created via FlexNet Operations’ user synchronization functionality (see Automated 
User Provisioning from Identity Providers (IdPs) to FlexNet Operations for more information) were 
assigned a default country code of US. The country code for users based in countries other than the US 
had to be updated manually to reflect the correct country.  

Now, a user’s country information (if available) is passed from the Identity Provider (IdP) during user 
synchronisation and stored directly in the user profile. This enhancement reduces manual effort 
required to update user profiles and helps ensure accurate country data for compliance checks, 
including Electronic Software Delivery (ESD) validations.

Implementation Notes

The country value must be provided in ISO 3166-1 Alpha-2 format (for example, IN for India, GB for 
United Kingdom).

If the country code is invalid or not in the correct format, the system will return an error and the user 
will not be created in FlexNet Operations. 

https://docs.revenera.com/fno_CURRENT/producer/Content/helplibrary/opsIdPSyncIntro.htm
https://docs.revenera.com/fno_CURRENT/producer/Content/helplibrary/opsIdPSyncIntro.htm
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If the country code is missing, the user will still be created in FlexNet Operations, but will be assigned 
a default country code of US. No error message will be displayed in this case.

Customers who need assistance updating their Identity Provide (IdP) configuration to include the 
country code attribute in their user data for FlexNet Operations‘ User Synchronization Service should 
contact Revenera Support. 

Electronic Software Delivery Enhancements in 2025.11
The following enhancement was added to the Electronic Software Delivery (ESD) module in the 
2025.11 release.

Enhanced Registry Status Messaging for Download Packages
(SWM-30139)

The Electronic Software Delivery (ESD) module now provides improved visibility into the status of 
Download Package project creation within the Harbor registry. This enhancement introduces clearer 
messaging in the Container Images and Helm Charts sections on the View Download Package page of 
the FlexNet Operations Producer Portal, helping users quickly identify the registry state of their 
packages.

New Status Messages

Case 1: Project Not Found in Registry

If the project has not yet been created in the registry:

• Container Images:

“Registry project has not been found for this package. Try re-saving the download package.”

• Helm Charts:

“Registry project has not been found for this package. Try re-saving the download package.”

Case 2: Project Created, No Artifacts Present

If the project exists in the registry but no container images or charts are associated:

• Container Images:

“Project created successfully in the registry. No images are currently associated with this 
package.”

• Helm Charts:

“Project created successfully in the registry. No charts are currently associated with this 
package.”

Entitlement Management Enhancements in 2025.11
The following enhancement to entitlement management was added in the 2025.11 release.
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Display Account Name in Entitlement History
(Case 02917663, SWM-24012)

Previously, in the Change History window of an entitlement (available by clicking View > View History 
on the Entitle Customers to Licenses | Create An Entitlement page), the event Channel Partner Change 
displayed only the updated account ID when the sold-to account was changed. To view the 
corresponding account name, users had to navigate to View Transactions > View details for that 
entitlement.

Starting with the 2025.11 release, the Change History window now includes both the account name 
and the account ID for the Channel Partner Change event for better clarity. This improvement enables 
users to immediately see account details related to entitlement changes without performing extra 
searches.

The following screenshot illustrates the changes: the Change History window shows the account ID 
and the name of the updated account, Delta Production Studios. 

Figure 7: The Change History window—available by clicking View > View History in the Entitle 
Customers to Licenses | Create An Entitlement page—now displays the account name if the sold-to 
account of the entitlement is updated.

SOAP and REST Web Services Enhancements in 2025.11
The following enhancements were added to the SOAP and REST Web Services module in the 2025.11 
release:

• Restriction on Modifying publisherIDname After Device Creation

• Flexible Filtering for Null and Blank LicenseStatus Values

Restriction on Modifying publisherIDname After Device Creation
(SWM-28354)

Previously, users were able to modify the publisher identity name (publisherIDname) of a device after 
its creation, even when the device’s identity had already been mapped. This led to inconsistencies in 
license management, as changing the publisherIDname could result in mismatches between devices 
and their allocated licenses, potentially causing compliance issues and inaccurate license counts.
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From the 2025.11 release onwards, users will no longer be able to change the publisherIDname once 
a device has been created and its identity is mapped. Attempts to change the publisherIDname after 
device creation will now result in an error. 

This change applies to all device updates made through the ManageDeviceService SOAP API. It 
ensures data integrity, maintains accurate license tracking, and aligns device management with 
licensing policies, ultimately reducing the risk of license misallocation and improving compliance for 
customers.

Note • If a change to publisherIDname is necessary, the device must be deleted and recreated with the 
desired identity.

Flexible Filtering for Null and Blank LicenseStatus Values
(SWM-29626)

Previously, querying the /report/device endpoint of the Data Access API (see FlexNet Operations Data 
Access APIs) with a filter for an empty LicenseStatus (for example, "$eq": "") returned all devices, 
regardless of their actual LicenseStatus value. This behavior limited the ability to accurately filter 
devices based on missing or blank license information.

Starting with the 2025.11 release, the API now supports enhanced filtering logic for null and blank 
values in query parameters. This update work on the following operators:

• equalsTo

• notEqualsTo

These operators allow users to explicitly filter records where a specific field (such as LicenseStatus) is 
either null or blank, or explicitly not null or blank.

This enhancement enables precise filtering and therefore improves report accuracy and usability. 

Example Usage

The following examples show how to filter device records where the LicenseStatus field is null or 
blank.

{"LicenseStatus":{ "$eq": "" }}
{"LicenseStatus":{ "$eq": null }}
{"LicenseStatus":{"$eq":"null"}}

The following examples show how to filter device records where the LicenseStatus field is explicitly 
not null or blank:

{"LicenseStatus":{ "$ne": "" }}
{"LicenseStatus":{ "$ne": null }}
{"LicenseStatus":{"$ne":"null"}

Features and Enhancements in 2025.10 
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.10 
release:

https://fnoapi-da.redoc.ly/
https://fnoapi-da.redoc.ly/
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• Dynamic Monetization Enhancements in 2025.10

• Device Management Enhancements in 2025.10

• Entitlement Management Enhancements in 2025.10

• User Experience Enhancements in 2025.10

Dynamic Monetization Enhancements in 2025.10
The following enhancement for Dynamic Monetization was added in the 2025.10 release.

Unified Documentation for Dynamic Monetization 
Starting October 2025, the Dynamic Monetization User Guide and API Reference have been merged 
into a single, comprehensive document. This update simplifies navigation and ensures a more 
cohesive experience for developers and users alike.

The consolidated documentation continues to be accessible from the Revenera Documentation site for 
Dynamic Monetization. The link there—Dynamic Monetization Documentation - Comprehensive 
Guide—directs you to the new documentation site at https://fnoapi-
dynamicmonetization.redocly.app/.

Throughout October, both the new combined documentation and the previous separate documents 
will be available. The older versions will be retired in November 2025. Please update your bookmarks 
and references accordingly.

Device Management Enhancements in 2025.10
The following enhancement to device management was added in the 2025.10 release.

Device Event Notifications to Include CLS Instance
(Case 03008370, FNE-22963)

Previously, when a device notification was triggered for a feature update, the notification included the 
relevant device ID and the state of the license update. However, it did not include information about 
the Cloud Licensing Service (CLS) instance where the update occurred. This made it difficult for 
producers to selectively update any middleware (for example, their own licensing database) with the 
relevant licensing information. 

Starting with the 2025.10 release, producers can now receive real-time notifications that include the 
Cloud Licensing Service (CLS) instance ID whenever a CLS instance is updated (e.g., license or 
configuration changes). This enables producers to then trigger targeted /features requests to only 
those CLS instances, without increasing the load on other instances.

Implementation Details 

A device event notification is generated for any update on a CLS instance. This includes license 
changes, configuration updates, or metadata modifications.

Each notification payload includes the unique device ID of the updated CLS instance.

https://fnoapi-dynamicmonetization.redocly.app/
https://fnoapi-dynamicmonetization.redocly.app/
https://docs.revenera.com/?product=Dynamic%20Monetization
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Activating CLS Device Event Notifications 

To receive device event notifications from a CLS instance, update the CLS configuration using the 
following API call: 

PUT https://<siteID>-uat.compliance.flexnetoperations.com/api/1.0/instances/<CLS-
instanceID>/configuration

Payload

In the payload, specify true to receive CLS device event notifications, or false to deactivate CLS device 
event notifications.

{
"licensing.enableChangeNotification":"true"

}

Sample Payload for a Cloud Licensing Service Device Event Notification

The following shows a sample payload that would be delivered to a webhook endpoint when a certain 
event occurs on a Cloud Licensing Service instance.

{
"eventHeader": {

"event": "CLS_INSTANCE",
"eventType": "UPDATE",
"userId": "producer",
"tenant": "ADMN",
"timeStamp": "1752645569000"

},
"eventBody": {

"deviceName": "H6WF4YMBFGGK",
"deviceId": "H6WF4YMBFGGK",
"version": "4",
"id": "434485",
"siteName": null,
"owner": null,
"identity": null,
"deploymentType": "CLOUD",
"hostType": null,
"status": "License Updated",
"active": "Active",
"notes": null,
"errorMessage": null,
"idtype": null,
"lastUpdated": "1752645569000",
"ownerName": null,
"addOnInfoList": null

}
}

Entitlement Management Enhancements in 2025.10
The following enhancement to entitlement management was added in the 2025.10 release.
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Simplified Activation and Deactivation of Line Items in FlexNet Operations
(03038349, SWM-25089)

FlexNet Operations now offers a unified and streamlined operation that allows producers to 
seamlessly toggle the status of an entitlement line item between active and inactive states. This 
enhancement allows efficient control over license allocation without requiring manual interventions, 
significantly improving operational efficiency and user experience.

Important • This enhancement is still under active development and may not perform consistently 
across all use cases. We advise using it with care and thoroughly validating any results it produces.

Overview

When a line item is marked Inactive, Cloud Licensing Service (CLS) instances will stop serving licenses 
associated with that line item. However, if the line item state is changed back to Deployed, the CLS 
instance will resume serving the license as usual. 

This behavior is controlled by a new configuration option, License server features will become inactive 
when the line item state is changed to Inactive (under System > Configure > FlexNet Operations > 
General Options). This option is disabled by default. Enable the configuration option to use this new 
functionality. 

The configuration License server features will become inactive when the line item state is changed to 
Inactive can only be enabled if both the following two configurations are disabled:

• Remove licenses from CLS when the line item state changes to Inactive/Obsolete

• Allow used entitlement/line item state change to Inactive or Obsolete.

Attempting to enable this setting while either of the above configurations is active will result in a 
conflict. In such cases, the following error message is displayed:

"You can only enable either 'License server features will become inactive when the line item state 
is changed to Inactive' or 'Remove licenses from CLS when the line item state changes to 
Inactive/Obsolete' or 'Allow used entitlement/line item state change to Inactive or Obsolete'."

Behavior When Configuration is Enabled

When the configuration License server features will become inactive when the line item state is 
changed to Inactive is enabled and you make a line item associated with the CLS instance inactive, the 
/features endpoint will reflect this change. 

Specifically, when /features is called with the includeInactive parameter, the response will indicate 
that the feature status for the line item is marked as Inactive. 

Important • Enabling both the License server features will become inactive when the line item state is 
changed to Inactive setting and the Enable feature count aggregation option (located under System > 
Configure > FlexNet Operations > Embedded Device Settings) can prevent users from marking certain 
individual line items as Inactive. For this reason, Revenera strongly advises against activating both 
configurations simultaneously. 
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Obsoleting Line Items 

When License server features will become inactive when the line item state is changed to Inactive is 
enabled, FlexNet Operations will not allow the line item state to be changed to Obsolete. If an attempt 
is made to do so, an error message will be triggered: 

"You cannot set the line item state to Obsolete while the configuration 'License server features will 
become inactive when the line item state is changed to Inactive' is enabled. Disable this 
configuration to proceed."

Limitations

Feature deactivation is not supported when using feature aggregation. Therefore, the configuration 
option Enable feature count aggregation must be deselected (under System > Configure > FlexNet 
Operations > Embedded Device Settings).

User Experience Enhancements in 2025.10
The following user experience enhancement was added in the 2025.10 release.

Enhanced Login Experience in End-User Portal
(Case 02820421, SWM-25340)

The login screen now includes a password visibility toggle to improve usability and reduce login errors. 
Users can press and hold the new eye icon to temporarily reveal their password:

• Closed eye icon (default): Password is hidden

• Open eye icon (while pressed): Password is visible
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This enhancement enables users to confirm the password they’ve entered, which is especially helpful 
in avoiding mistakes caused by caps lock, keyboard locale changes, or other typing errors.

Features and Enhancements in 2025.09 
This section lists new capabilities, features and enhancements that were introduced in the 2025.09 
release. New capabilites are introduced first, see New Capabilities in 2025.09.

As part of this release, we are also providing an early advisory regarding a potential configuration 
conflict. See Early Notice for Possible Configuration Conflict for details.

Features and enhancements were added to the following areas of FlexNet Operations in the 2025.09 
release:

• Device Management Enhancements in 2025.09

• Entitlement Management Enhancements in 2025.09

• Export and Import Enhancements in 2025.09

• SOAP and REST Web Services Enhancements in 2025.09

• User Experience Enhancements in 2025.09

New Capabilities in 2025.09
In the 2025.09 release, FlexNet Operations introduces the following new capability:

• Enhanced Visibility into Cloud Licensing Service Instance Details and Features
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Enhanced Visibility into Cloud Licensing Service Instance Details and 
Features 
The Producer Portal and End-User Portal now feature an upgraded interface that provides extended 
visibility into Cloud Licensing Service (CLS) instances.

The new built-in, intuitive user interface offers a clearer view of features, licenses and devices, which 
simplifies license operations for both producers and customers. 

As an out-of-the-box solution, the interface eliminates the need for producers to develop custom UIs—
reducing overhead, accelerating time-to-value, and helping customers better understand entitlement 
purchases and usage.

Key Enhancements

• Producer Portal and End-User Portal users can now view Cloud License Server information 
equivalent to that available for Local License Servers in the FlexNet License Server Manager.

• Clicking a Cloud License Server device name on the Devices page opens a redesigned page with a 
tabbed layout.

Tabbed Interface Breakdown

This release introduces the following new tabs. Click on the relevant link to jump to the section: 

• Overview Tab 

• Features Tab

• Active Clients

• Named License Pools

Note • The pages to display device information for standalone devices, served devices and local 
license servers remain unchanged. 

Overview Tab

The Overview tab displays the same server information previously shown on the View Server page. 
This tab is selected by default.
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Figure 8: Example of the Overview tab with information for a Cloud License Server.

Note • No changes have been made to the commands available from the View, Edit, and Licenses 
menus on this page.

Features Tab

The Features tab contains two subtabs: Summary and Details. The Details tab can also display a 
detailed feature view. Use the following links to jump to each section: 

• Summary Tab

• Details Tab

• Details Tab - Feature View

Summary Tab  

The Summary tab (default view) provides a consolidated view of feature usage on the license server. It 
groups feature records by feature name, summing up counts across different entitlements, 
activations, or product associations. This view is ideal for high-level monitoring and reporting. The 
invididual columns are described in the following table:

Column Description

Feature The name of the feature or capability available on the license server.

Version The version number of the feature. 

Total Count The total number of license units available for this feature across all 
entitlements and activations.
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This screenshot shows the layout of the Features tab with the Summary subtab:

Details Tab 

The Details tab displays all individual feature records as they exist on the license server. This granular 
view helps in troubleshooting, auditing, and understanding how licenses are distributed. The following 
table gives details about each column:

Total Used The number of license units currently checked out or in use by clients.

Total Available The number of license units still available for checkout. Calculated as Total 
Count minus Total Used.

First Expiration The earliest expiration date among all line items for this feature. Helps 
identify the soonest expiring entitlement.

Last Expiration The latest expiration date among all line items for this feature. Indicates the 
longest validity period.

Total Overdraft The number of overdraft units used, if any. Overdrafts allow usage beyond the 
entitled count under specific conditions.

Metered Indicates whether the feature is metered (usage is tracked and reported) or 
not.

Counted Indicates whether the feature is counted (limited by quantity) or uncounted 
(unlimited usage allowed).

Column Description

Feature The name of the feature or capability. Each row represents a distinct record, 
even if the feature name is the same.

Column Description
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This screenshot shows the layout of the Features tab with the Details subtab:

Details Tab - Feature View 

Clicking a hyperlinked feature name on the Details subtab opens a detailed view for the selected 
feature. The view includes the following fields: 

Version The version of the feature. This helps differentiate between multiple releases 
of the same feature.

Count Number of license units allocated for this specific feature record.

Available The number of license units still available for checkout from this record.

Expiry The expiration date of this feature record. If marked as permanent, the 
feature does not expire.

Start Date The date from which this feature record becomes valid and available for use.

Vendor String Optional metadata defined by the producer, often used for filtering or 
categorization.

Column Description

Feature Name The name of the feature or capability.

Version The version of the feature. This helps differentiate between multiple releases 
of the same feature.

Start Date The date from which this feature record becomes valid and available for use.

Total Count The total number of license units available for this feature across all 
entitlements and activations.

Column Description
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The feature view also includes an Active Clients section, which lists the active client devices that 
currently have counts from this feature currently checked out. The following information is provided: 

This screenshot shows the Features tab with detailed information for a selected feature: 

Available The number of license units still available for checkout from this record.

Used Count The count currently being used.

Reserved Count The number of reserved licenses within the used count.

Vendor String Optional metadata defined by the producer, often used for filtering or 
categorization.

Feature Expiry The expiration date of this feature record. If marked as permanent, the 
feature does not expire.

Column Description

Device ID The ID identifying the device that has count checked out. 

Device ID Type The device host ID type.

Device Type The device on which the feature is used (client, served client, or license 
server).

Device Alias A user-defined name (sometimes called host name) for the device.

Total Count 
Served

The total count served to the device.

Expiry The expiration date of this feature record on the device. If marked as 
permanent, the feature does not expire.

Column Description
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Figure 9: Example of a detailed view for a selected feature.

Users can click the Back button to return to the Details subtab.

Active Clients

The Active Clients tab displays the client devices recognized by the license server as having been 
served licenses from the server’s shared pool or from licenses reserved for the client. Each client is 
identified by its device ID, the ID type, and the device type—physical, virtual, or unknown. In addition, a 
device alias might be displayed if this has been set on the device. (A device alias is also sometimes 
referred to as a device name or host name. It is a human-readable alias—in contrast to the hostid—
which can optionally be included in a capability request.)

Figure 10: Example of the active clients overview.

When you click the device ID for a specific client, a detailed view opens, showing details about the 
client device and the list of features currently served to the client. (Click Back to exit the page.)
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Figure 11: Example of a detailed view of an active client.

Note that the Device Expiry field shows the timestamp when all currently checked-out features will 
expire on the device. This timestamp is determined either by the borrow expiration for the checked-out 
concurrent features or the final expiration date (as defined in the back office) for checked-out metered 
features.

The Expiry field for a feature in the Consumed Features list shows its final expiration date as defined in 
the back office.

Named License Pools

The Named License Pools tab is divided into the Existing License Pools and Upload Model File 
subtabs. The Existing License Pools subtab displays the list of named license pools that have been 
defined on the CLS instance as well as the default license pool.

When you click a license pool name, the view expands to show details about the features that are 
currently included in the license pool.
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Figure 12: Example of the Named License Pools view.

The Upload Model File tab displays the model definition that is currently active on the license server. 
The model definition specifies the license pools and the rules of access that define how licenses are 
allocated to license pools (named or default). 

Figure 13: Example of the view for uploading a model definition. 

To change the model definition, browse for the model definition that you want to use by clicking 
Browse and then click Upload.
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Early Notice for Possible Configuration Conflict
Revenera is working to enhance the behavior of entitlement line items when toggled between Active 
and Inactive states. As part of this effort, a new configuration option License server features will 
become inactive when the line item state is changed to Inactive has been introduced (under System > 
Configure > FlexNet Operations > General Options). 

This configuration is currently under development and not yet fully functional. It is disabled by default. 

This new option is interdependent with the following existing configurations:

• Remove licenses from CLS when line item state is changed to Inactive/Obsolete

• Allow used entitlement/line item state change to Inactive or Obsolete

Starting with the 2025.09 release, the above configuration options cannot be enabled simultaneously. 
If more than one is selected, the system will display the following error message:

"You can only enable either 'License server features will become inactive when the line item state 
is changed to Inactive' or 'Remove licenses from CLS when the line item state changes to 
Inactive/Obsolete' or 'Allow used entitlement/line item state change to Inactive or Obsolete'."

Customers encountering this error message should verify their configuration settings to ensure that 
only one of the configuration options is enabled—either Remove licenses from CLS when line item 
state is changed to Inactive/Obsolete or Allow used entitlement/line item state change to Inactive or 
Obsolete—but not both.

Device Management Enhancements in 2025.09
The following enhancement to device management was added in the 2025.09 release.

New Job “Obsolete Inactive Devices”
(SWM-27146)

The 2025.09 release introduces a new job, Obsolete Inactive Devices. This job enables producers to 
mark any devices as Obsolete that have not been updated within a specified period of inactivity. This 
feature is particularly useful for generating accurate analytics reports that reflect only active devices.

Devices are evaluated based on their Last Modified date. Any device that exceeds a configured 
inactivity threshold will be updated to an Obsolete status. 

The inactivity threshold is defined using the new configuration option Device inactivity period (under 
System > Configure > FlexNet Operations > Embedded Device Settings). 

The value must include a number followed by a time unit:

• D = Days

• W = Weeks

• M = Months

• Y = Years

Examples for Configuration Values 
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• 2Y—Devices not modified in the last 2 years will be marked obsolete.

• 20W—Devices inactive for 20 weeks will be marked obsolete.

Setting up the Obsolete Inactive Devices Job

You can access the Obsolete Inactive Devices job on the Configure Alerts/Jobs page (available by 
clicking Administer > Configure Alerts/Jobs). 

To activate the job:

• On the Configure Alerts/Jobs page, change its status to Active. 

• Set the configuration option Device inactivity period to the desired value.

Important Notes for the Obsolete Inactive Devices Job

Marking a device as Obsolete is a permanent action and cannot be undone. Use this job with caution, 
especially in production environments. To help prevent accidental obsolescence, the following 
safeguards are in place:

• The Obsolete Inactive Devices job is disabled by default. 

• The default device inactivity period is set to 100 years (100Y).

Entitlement Management Enhancements in 2025.09
The following enhancement to entitlement management was added in the 2025.09 release.

Assigning Account When Processing Capability Requests Without User-
Related Information
(SWM-23219)

When a capability request that does not include an enterprise ID or activation ID is uploaded to the 
End-User Portal, FlexNet Operations creates the corresponding device. However, the device does not 
appear on the End-User Portal’s Devices page, because it is created without an associated account.

This release introduces an enhancement that changes this behavior: When a capability request is 
uploaded via the End-User Portal, the device can now be automatically assigned to the account of the 
logged-in user, ensuring it is visible on the Devices page. 

Behavior Details

The following happens when uploading a capability request without user-related information in the 
End-User Portal (under Devices > Offline License Management):

• If the logged-in user is associated with a single account, a dropdown menu is displayed with that 
account pre-selected. 
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Figure 14: The new Account ID dropdown menu shows the account that the user will be 
associated with. 

• If the logged-in user is associated with multiple accounts, the dropdown menu lists all associated 
accounts. The user can then select the appropriate account to associate with the device.

Figure 15: Using the Account ID dropdown menu, the user can select the account to be 
associated with the device.

Enabling New Behavior

By default, this new behavior is disabled. Producers who wish to enable it should contact Revenera 
Support to request the necessary configuration change.
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Note • When the configuration option Allow Server Without Activation IDs is enabled, FlexNet 
Operations can process capability requests generated by a FlexNet Embedded local license server that 
do not include an activation ID. 

Export and Import Enhancements in 2025.09
The following enhancement involving the Data Export and Import functionality was added in the 
2025.09 release.

Removing Field Values for Download Packages Using the Download 
Packaging Template
(02840821, SWM-22856)

Producers can now remove values from any string-accepting fields in the Download Packages 
template by entering "NULL" or "null" in the desired field. During import, these entries will result in 
blank fields, effectively clearing the original content.

In previous releases, it was not possible to remove values using the Download Package template. 
Leaving fields empty during import would retain existing values. This behavior made it challenging for 
producers to clear values in bulk.

This enhancement applies to all non-mandatory columns that can accept a null string, for example, 
ExtendedDescription, Version, ReleaseGroup, and DownloadInstructions (non-exhaustive list). 

To determine whether a column supports null string values, refer to the column’s note. Any column 
designated to accept string input will also accept "NULL" or "null" to clear its value.

For any columns left blank in the Download Packages template, the previous behavior is unchanged. If 
a column is left blank or is removed from the template, the existing value will be retained.

SOAP and REST Web Services Enhancements in 2025.09
The following enhancement was added to the SOAP and REST Web Services module in the 2025.09 
release.

Retrieving Devices Not Associated to Any Account
(Case 02874971, SWM-21765)

The 2025.09 release now enables producers to retrieve devices or servers that are not linked to any 
account, expanding flexibility in device management workflows.

In the ManageDeviceService SOAP web service (version 7), a new enum value IS_EMPTY has been 
added to the simpleSearchType for the searchDevices SOAP request. This allows searching for devices 
where soldToAcctId is blank.

Usage Example

To use the new IS_EMPTY searchType in a searchDevices request:
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<urn:soldToAcctId>
<urn:value></urn:value>
<urn:searchType>IS_EMPTY</urn:searchType>

</urn:soldToAcctId>

Note that the <urn:value> field must remain empty for the query to work as intended.

For detailed information about the changes made to the v7/manageDeviceTypes.xsd file, see the 
Change Log for 2025.09.

Sample Request and Response for searchDevices

The following shows sample code for a searchDevices request.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v7.fne.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:searchDevicesRequest>
<urn:queryParams>

<urn:deviceClasses>
<urn:deviceClass>CLIENT</urn:deviceClass>

</urn:deviceClasses>
<urn:soldToAcctId>

<urn:value></urn:value>
<urn:searchType>IS_EMPTY</urn:searchType>

</urn:soldToAcctId>
<urn:status>

<urn:value>ACTIVE</urn:value>
<urn:searchType>EQUALS</urn:searchType>

</urn:status>
<urn:lastModifiedDate>

<urn:value>2024-06-14</urn:value>
<urn:searchType>AFTER</urn:searchType>

</urn:lastModifiedDate>
</urn:queryParams> 
<urn:responseConfig>

<urn:name>true</urn:name>
<urn:soldTo>true</urn:soldTo>

</urn:responseConfig>
<urn:sortBys> 

<urn:sortBy>
<urn:sortKey>LAST_MODIFIED_DATE</urn:sortKey>
<urn:ascending>true</urn:ascending>

</urn:sortBy>
</urn:sortBys>
<urn:pageNumber>1</urn:pageNumber>
<urn:batchSize>25</urn:batchSize>

</urn:searchDevicesRequest>
</soapenv:Body>

</soapenv:Envelope>

The following shows sample code for a searchDevices response.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema "xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Body>
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<searchDevicesResponse xmlns="urn:v7.fne.webservices.operations.flexnet.com">
<statusInfo>

<status>SUCCESS</status>
</statusInfo>
<devices>

<device>
<deviceId>

<id>Cloud purpose</id>
<idType>ETHERNET</idType>
<publisherName>fnetest</publisherName>
<deviceClass>CLIENT</deviceClass>

</deviceId>
<name>Test_5_Aug</name>
<lastModified>2024-08-05T11:30:37.333Z</lastModified>

</device>
<device>

<deviceId>
<id>a</id>
<idType>STRING</idType>
<publisherName>fnetest</publisherName>
<deviceClass>CLIENT</deviceClass>

</deviceId>
<name>a</name>
<lastModified>2024-08-15T15:37:57.103Z</lastModified>

</device>
</devices>

</searchDevicesResponse>
</soapenv:Body>

</soapenv:Envelope>

User Experience Enhancements in 2025.09
The following user experience enhancement was added in the 2025.09 release.

Selective Retriggering of Failed Bulk Operations for FlexNet Publisher 
Entitlements
(Case 02840512, SWM-28102)

In the 2025.07 release, an enhancement was introduced to the Bulk Operations page, which would 
now list failed upgrade lines along with their failure reasons. This improvement allowed administrators 
to quickly identify and selectively reprocess only the failed items. For details, see Selective 
Retriggering of Failed Bulk Operations for FlexNet Publisher Entitlements.

Initially, this functionality was available exclusively for entitlements using FlexNet Embedded.

As of the 2025.09 release, the same capability has been extended to entitlements using FlexNet 
Publisher, ensuring consistent handling of bulk operation failures across both entitlement types.

On the Bulk Operations page, administrators can rerun failed upgrade jobs using the following 
methods:

• Retrigger a single job: Click the new Retry icon next to a failed job entry.
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• Retrigger multiple jobs: Select the checkboxes for multiple failed jobs and click the new Retry 
button (located above the table).

Features and Enhancements in 2025.08
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.08 
release:

• Data Analytics Enhancements in 2025.08

• Device Management Enhancements in 2025.08

• Entitlement Management Enhancements in 2025.08

• User Experience Enhancements in 2025.08

Data Analytics Enhancements in 2025.08
The following enhancements were made to the Analytics functionality in 2025.08.

• Enhanced Visibility in License Server Usage and Denials Report

• Bundle Information in Product-Feature View

Enhanced Visibility in License Server Usage and Denials Report 
(Case 02993983, SWM-25566)

To improve clarity and contextual understanding for customers, the License Server Usage and Denials 
report (available from the Analytics menu) now includes two new fields: SITE_NAME and 
DESCRIPTION. 

The new fields, part of the usage entity, can also be extracted using a data share or the Data Access 
API (DAPI). 

These additions help users quickly identify where license usage is occurring and what each site 
represents, making it easier to audit, analyze, and manage license consumption across environments.

Bundle Information in Product-Feature View
(SWM-28187)

Previously, producers wanting to build a report that presented all the features used in a product could 
only produce a simple view, where each product was linked directly to individual features:

https://fnoapi-da.redoc.ly/
https://fnoapi-da.redoc.ly/
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To address this, new fields have been added to the Data Warehouse, with a hierarchical, bundled 
structure: 

The new fields can be extracted using a data share or the Data Access API (DAPI). 

The following table lists the new fields which are part of the product-feature entity:

Field Name in DAPI Field Name in Data Share Description 

FeatureBundleName FEATUREBUNDLE_NAME The name of the feature bundle.

FeatureBundleDescription FEATUREBUNDLE_DESCRI
PTION 

The description of the feature bundle.

https://fnoapi-da.redoc.ly/
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Customer Benefits

• Layered Insight—Understand both high-level capability (via bundles) and granular functionality 
(via features) without navigating multiple systems.

• Better Discoverability—Easily trace which features belong to which bundles—and which bundles 
are tied to which products.

Device Management Enhancements in 2025.08
The following enhancement to device management was added in the 2025.08 release.

Devices Template Enhancements: Bulk Device Creation
(Case 02880444, SWM-27074)

In the third iteration of the Devices Template enhancements, a new worksheet named CreateHost has 
been introduced. This addition streamlines the creation of devices and servers via Excel import, 
eliminating the need for manual entry — which is often time-consuming and error-prone.

Producers would perform the following steps to create devices in bulk using the updated template:

1. Navigate to Administer > Import Data Objects and select the Data Import Templates tab.

2. Click the hyperlinked name of the Devices Template to download it.

3. Open DevicesTemplate.xlsx and locate the CreateHost sheet. Provide relevant details for each 
device or server. The following details can be specified:

• Host ID

• Host alias

• Identity

• Publisher name

• Host class

• Server deployment type

• Host ID type

BundleFeatureRelationFeat
ureID 

BUNDLE_FEATURE_RELAT
ION_FEATURE_ID 

The feature ID of the feature that is 
included in the bundle.

BundleFeatureDeleted BUNDLE_FEATURE_DELET
ED 

Indicates the relationship between the 
feature and the bundle:

• Y: Feature was removed from the 
bundle.

• N: Feature still included in the 
bundle.

Field Name in DAPI Field Name in Data Share Description 
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• Host model

• Account ID

• Site name

• Notes

• User ID

• Backup server ID

Note • In the template, column headers formatted in bold indicate mandatory fields.

4. Save the populated spreadsheet as a Unicode .txt file.

5. Return to the Import Settings tab on the Import Data Objects page and upload the .txt file to 
import the new entities (see also Importing Entities in the FlexNet Operations User Guide).

This screenshot shows an example of a populated template:

Entitlement Management Enhancements in 2025.08
The following enhancements to entitlement management were added in the 2025.08 release.

Email Template Enhancement: Filtering Expired Activation IDs 
(Cases 02429882, 02449414; SWM-9903)

Previously, email templates could filter line items based on state (for example, excluding drafts), but 
not based on expiration. This limitation meant that expired activation IDs could still appear in 
entitlement communications.

With the 2025.08 release, FlexNet Operations introduces the [[Expired]] merge tag to exclude 
expired line items. This is especially useful for co-termed entitlements, where multiple subscriptions 
are aligned to renew at the same time. 

This enhancement allows customers to include only active activation IDs in their entitlement emails, 
ensuring that recipients receive relevant and current licensing information.

To use this enhancement:

• Update your DEFAULT entitlement email template to include the [[Expired]] tag logic.

• Alternatively, create a new version of the entitlement email template tailored for co-termed 
entitlements.

https://docs.revenera.com/fno_CURRENT/producer/Content/helplibrary/Importing_Entities.htm
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Example Template
XYZ Corporation grants

[[FOR-EACH TAG="Entitlement" child-only="true"]]
[[FOR-EACH TAG="ChannelPartners" child-only="true"]]
[[FOR-EACH TAG="ChannelPartner"]]

Partner Tier Name: [[PartnerTierName]]
Org Display Name: [[Name]]
Org Name: [[OrgName]]
Contact Name: [[ContactName]]

[[END FOR-EACH]]
[[END FOR-EACH]]
the right to activate the following product(s):    
[[FOR-EACH TAG="EntitlementLineItem"]]

[[IF TAG="Expired" value= "No"]]
ActivationID:    [[ActivationID]]
[[FOR-EACH tag="EntitledProduct"]]

Product Name: [[Name]]
Product Description: [[Description]]
Count: [[Count]]

[[END FOR-EACH]]
Order ID: [[OrderID]]
Quantity: [[SeatCount]]
Start Date: [[StartDate]]
Expiration Date: [[ExpirationDate]]
Expired : [[Expired]]
Permanent: [[Permanent]]
Duration :

Length: [[Length]]    
Units: [[Units]]

[[END IF]]
[[END FOR-EACH]]

The Activation IDs will be required to login. You will also need the Hostid of the computer 
with which these licenses will be associated.
If you have any questions, contact your local XYZ Corporation office.                 
Rights and restrictions on the use of the products are set forth in XYZ Corporation License 
Terms agreement.

[[END FOR-EACH]]

Example Email

The email template above could produce an email similar to the following:
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User Experience Enhancements in 2025.08
The following user experience enhancement was added in the 2025.08 release.

Monitoring Status of FlexNet Publisher Bulk Upgrade Jobs
(Case 02840512, SWM-27668)

Producers can now monitor the status of upgrade bulk operations for FlexNet Publisher licenses.

Clicking the Status column on the Entitle Customers To Licenses | Bulk Operations page (under 
Entitlements > Bulk Operations) for a FlexNet Publisher bulk operation opens the Bulk Job Status 
dialog, which displays the progress of mapping activation IDs from parent activation IDs to 
corresponding child activation IDs.

The following table outlines how the columns in the Bulk Job Status dialog will be populated based on 
the outcome of the bulk job and the auto-fulfill configuration.

Scenario Parent Activation ID Child Activation ID Auto-Fulfill

Upgrade 
successful, no 
auto-fulfill

Populated Populated Blank

Upgrade 
successful, with 
auto-fulfill

Populated Populated Success or Failure

Upgrade failed Populated Blank Failure



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  46

Figure 16: Example of the Bulk Job Status dialog for a successful upgrade without auto-fulfill 

Features and Enhancements in 2025.07
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.07 
release:

• Data Analytics Enhancements in 2025.07

• SOAP and REST Web Services Enhancements in 2025.07

• User Experience Enhancements in 2025.07

Data Analytics Enhancements in 2025.07
The following enhancements were made to the Analytics functionality in 2025.07.

• Adoption Trend Reports in Analytics

• Usage Expiry Data Available in Data Access API and Analytics Reports

• Logging of Recent Downloads for Updates Downloaded By Bevices

Adoption Trend Reports in Analytics 
(SWM-27312)

The main dashboard within the Analytics functionality (available by clicking Analytics > Analytics 
Dashboard) has been redesigned to deliver more targeted and actionable insights. It now helps users 
across functions—such as Sales, Renewals, Product, and Marketing—track adoption trends across key 
entities. The charts and reports highlight activities including new account creation, user onboarding, 
entitlement creation, product usage, and activations. This enhanced visibility enables teams to monitor 
how users and organizations adopt your platform and get actionable insights to make data-driven 
product decisions.



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  47

Figure 17: The Analytics Dashboard with redesigned tiles (cropped view).

All tiles in the dashboard are now clickable. Clicking a tile will drill through to a detailed report with 
charts and tables that give a clearer picture of the relevant entities.

The dashboard includes the following tiles:

• Entitlements

• Devices

• Accounts

• Users

• Downloads

Note • By default, the data for all dashboard tiles is filtered to show a 12-month period, but this can be 
adjusted to meet specific reporting needs. To change the filter, open the Filters panel on the right side 
of the screen and scroll down to the CREATE_DATE. Click the CREATE_DATE filter and adjust it as 
required.  

Entitlements
The Entitlements tile displays the total number of entitlement line items created in the past 12 
months.

How Entitlements Graphs Benefit You

Tracking the trend of entitlements created each month (see chart “Entitlement Line Items”) and 
cumulative entitlement line items (see chart “Cumulative Entitlement Line Items”) provides valuable 
visibility into customer adoption and product engagement.
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Filtering entitlements by account helps identify how individual customers are adopting your product. 
This enables your Customer Success and Operations teams to:

• Tailor engagement strategies.

• Identify accounts needing support.

• Identify upsell opportunities.

• Monitor onboarding effectiveness.

Analyzing entitlements by product or product line gives Product Management insights into:

• Which offerings are gaining traction.

• Which products may need repositioning or enhancement.

• Opportunities to refine pricing, packaging, or feature bundling.

Quick Filters for Entitlements

• Created On (dynamic options available, such as, today, yesterday, last 7 days, last 30 days, current 
month and previous month)

• End Customer Account ID

Visualizations for Entitlements 

Click the Entitlements tile to access the following visualizations: 

• Monthly Trend Bar Chart “Entitlement Line Items”—Shows the number of new entitlement line 
items created each month during the last 12 months.. 

Tip • Click a bar in the bar chart to show the data for a particular month. The cumulative line graph 
and table will automatically apply the same filter.  

• Cumulative Line Graph “Cumulative Entitlement Line Items”—This line graph of total entitlements 
highlights long-term growth patterns or plateaus.
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• Table “Detailed Entitlement Line Items Created”—Provides raw data for auditing, reporting, and 
deeper analysis.

Devices
The Devices tile shows the total number of devices recorded over the past 12 months.

How Devices Graphs Benefit You

Monitoring trends in device creation and updates offers valuable insights into customer engagement 
levels and overall account health.

Analyzing Device Creation Trends

A spike in device creation often signals:

• New customer onboarding.

• Expansion within existing accounts.

• Positive account health check.

A decline or plateau in device creation—especially when correlated with other indicators such as 
strategic shifts, product roadmap changes, or usage patterns—may indicate:

• Customer disengagement.

• Technical or onboarding issues.
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• A need for proactive outreach by Customer Success Managers (CSMs) to re-engage and support 
the customer.

Analyzing Device Update Trends

Frequent updates suggest:

• Active usage and healthy operational practices.

• Customers are keeping devices current, possibly adopting new features.

Infrequent or declining updates may indicate:

• Reduced engagement or usage.

• Potential technical challenges or lack of awareness.

• An opportunity for CSMs to check in, understand the cause, and offer support.

Quick Filters for Entitlements

• Created Date (dynamic options available, such as, today, yesterday, last 7 days, last 30 days, 
current month and previous month)

• Account ID

Visualizations for Devices

Click the Devices tile to access the following visualizations: 

• Pie Chart “Device Types”—Shows the relative distribution of device types. Devices are grouped 
into:

• Servers 

• Served clients

• Standalone devices
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Tip • Click an area in the doughnut chart to focus on a particular device type. The filter you choose 
will also be applied to all other charts and the table on this page.

• Monthly Trend Bar Chart “Devices Created”—Tracks how adoption of devices is growing month 
over month.

Tip • Click a bar in the bar chart to show the data for a particular month. The other graphs and 
table on the page will automatically apply the same filter.  

• Cumulative Line Graph “Cumulative Devices Created”—Showing overall system engagement.

• Line Chart “Devices Updated”—Illustrates the number of devices updated each month over the 
past 12 months, offering insights into how frequently customers maintain or reconfigure their 
devices.
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• Table “Devices Details”—Provides visibility into each device and its associated events.

Accounts
The Accounts tile shows the total number of accounts created in the past 12 months.

How Accounts Graphs Benefit You

The graphs provide insights into how accounts are split across the different account types—Customer, 
Channel Partner, Producer, and Self-Registered.

When correlated with projections, account creation trends offer valuable insights into:

• Market traction, campaign performance, and onboarding effectiveness.

• Identification of high-performing regions or sales representatives.

• Support for pipeline forecasting and revenue planning.

A decline in account creation—particularly when measured against targeted expectations—may 
indicate market saturation or challenges in the onboarding journey.

This insight enables teams to reassess current strategies and make necessary adjustments to better 
align with evolving market needs.
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Quick Filters for Accounts

• Created Date (dynamic options available, such as, today, yesterday, last 7 days, last 30 days, 
current month and previous month)

• Account ID

Visualizations for Accounts

Click the Accounts tile to access the following visualizations: 

• Pie Chart “Account Types”—Shows a breakdown of account types. Accounts are grouped into:

• Customers 

• Channel Partners

• Self-registered

• Publishers

Tip • Click an area in the doughnut chart to focus on a particular account type. The filter you 
choose will also be applied to all other charts and the table on this page.

• Monthly Trend Bar Chart “Accounts Trends”—Shows the number of new accounts created each 
month during the last 12 months.
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Tip • Click a bar in the bar chart to show the data for a particular month. The other graphs and 
table on the page will automatically apply the same filter.  

• Cumulative Line Graph “Cumulative of Accounts”—Helps track net growth and retention of active 
accounts over time.  

• Table “Accounts Created”—Offers detailed insights for operational and strategic follow-up.
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Users
The Users tile shows the total number of users created in the past 12 months.

Quick Filters for Users

• Created Date (dynamic options available, such as, today, yesterday, last 7 days, last 30 days, 
current month and previous month)

• Account ID

Visualizations for Users

Click the Users tile to access the following visualizations: 

• Pie Chart “User Accounts”—Shows a breakdown of user types. User types are grouped into:

• Customer users 

• Self-registered users

• Partner users

• Publisher users

Tip • Click an area in the doughnut chart to focus on a particular user type. The filter you choose 
will also be applied to all other charts and the table on this page.

• Monthly Trend Bar Chart “User Trends”—Shows the number of new users created each month 
during the last 12 months.
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Tip • Click a bar in the bar chart to show the data for a particular month. The other graphs and 
table on the page will automatically apply the same filter.  

• Cumulative Line Graph “Cumulative User Trend”—Helps track net growth and retention of active 
users over time.  

• Table “User Details”—Offers detailed insights for operational and strategic follow-up.
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Downloads
The Downloads tile shows the total number of downloads created in the past 12 months.

How Download Graphs Benefit You

The monthly trend in software downloads offers valuable insights into adoption patterns over time:

• A spike in downloads may reflect increased customer interest, measures the impact of product 
launch for sales and marketing. 

• By applying the right filters—such as product line, download package, or geography—Product 
Management can gain deeper visibility into how specific offerings are performing across different 
regions.

The file size trend over the past 12 months offers insights into storage utilization. An upward trend 
may indicate the need for producers to either optimize their storage usage to reduce costs or consider 
upgrading to accommodate growing storage demands.

Quick Filters for Users

DOWNLOAD_END_DATE (dynamic options available, such as, today, yesterday, last 7 days, last 30 
days, current month and previous month)

Visualizations for Users

Click the Downloads tile to access the following visualizations: 

• Monthly Trend Bar Chart “Downloads Trends”—Shows the number of completed downloads per 
month for the last 12 months. 
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Tip • Click a bar in the bar chart to show the data for a particular month. The other graphs and 
table on the page will automatically apply the same filter.  

• Line Chart “Cumulative of Downloads Trends”—Helps track the number of downloads completed 
for the last 12 months.

• Bar Chart “Downloads File Size”—Represents file size downloaded in GB over the past 12 months. 
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• Line Chart “Cumulative of Downloads File Size”—Visualizes the growth of downloads.

 

• Table “Download Details”—Offers detailed insights for operational and strategic follow-up. 

Usage Expiry Data Available in Data Access API and Analytics Reports
(SWM-27603)

For all concurrent usage data, the usage expiry information is critical for customers to optimize license 
pooling and forecast future license availability. 
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To support this requirement, the Data Share customers can now query the database field 
BORROWED_UNTIL. The field can be queried through the Usage report in the Data Access API (field 
name: usageExpiry) and using the Analytics functionality (field name: USAGE_EXPIRY) in the Producer 
Portal.

For Cloud Licensing Service instances and local license servers, BORROWED_UNTIL shows the 
expiration of the concurrent usage, expressed as milliseconds since 1970-01-0. (No value is returned 
for metered usages.)

Example of the Usage report 

{
"correlationId": "1c63ebee-0965-41a7-9c54-4f5258a3ceeb",
"usageTime": "1740635429456",
"writeTime": "1740635470469",
"accountId": "111444aaabbbc",
"accountName": "ab_cde-12-34",
"consumerId": "h1",
"consumerType": "STRING",
"meter": "feature",
"meterType": "concurrent",
"meterCost": "1",
"meterCostList": "",
"meterQuantity": "1",
"item": "f1-demo",
"itemVersion": "1.0",
"itemQuantity": "1",
"activationId": "[\"9055-abcd-1234-5678-defg-xyzq-ui45-824c\"]",
"instanceId": "ABCD1234PPPP",
"mappedEntitledCount": "100000",
"used": "1",
"metaData": "{}",
"sessionId": "",
"sessionState": "",
"requestResponse": "",
"isPartial": "FALSE",
"isIncremental": "FALSE",
"overdraftCount": "0",
"controlsApplied": "{\n  \"partition\": \"default\"\n}",
"entitledArticles": "[\"p1-demo\"]",
"entitledArticleVersions": "[\"1.0\"]",
"UsageExpiry": "1740635459000"

}

Logging of Recent Downloads for Updates Downloaded By Bevices
(Case 03046832, SWM-27374)

Note • This enhancement is only relevant for producers using the Updates and Insights module.

Device downloads are now recorded as anonymous downloads. While individual devices are not 
identifiable, each download occurrence is logged.

Software producers can access records of recent device downloads through the Analytics feature in 
FlexNet Operations or by querying the Data Access API using the AccountID field.
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In the Analytics functionality, the AccountID is returned in the CONTACT_ACCOUNT_ID column. The 
following screenshot shows the CONTACT_ACCOUNT_ID column in the Download Details table of the 
Software Delivery Download History report:

Figure 18: Example of the CONTACT_ACCOUNT_ID column in the Software Delivery Download History 
report.

Tip • If the CONTACT_ACCOUNT_ID column is not displayed in a table, click the Select Columns button 
above the table, scroll to the entry (or use the Search field to locate it) and then select the column 
name to add the column to the table.

SOAP and REST Web Services Enhancements in 2025.07
The following enhancements were added to the SOAP and REST Web Services module in the 2025.07 
release.

• Excluding Expired Activation from Search Results in getEntitlementLineItemPropertiesQuery

• New APIs Added to Entitlement Management RESTful Services
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Excluding Expired Activation from Search Results in  
getEntitlementLineItemPropertiesQuery
(Cases 03002310, 03047299; SWM-27421)

In the EntitlementOrderService version 9, a new optional input query parameter named 
excludeExpired has been introduced for the getEntitlementLineItemPropertiesQuery to enable you to 
exclude expired activations from search results. 

• True—When excludeExpired is set to true, all expired activations—those with expiration dates 
earlier than the current local date—will be excluded from the results. 

• False—If excludeExpired is omitted or set to false, all activations, including expired ones, will be 
included.

For detailed information about the changes made to the EntitlementOrderService.wsdl and the .xsd 
files that it references, see the Change Log for 2025.07.

The following sections shows sample code for getEntitlementLineItemPropertiesQuery.

Sample request for getEntitlementsAttributeQuery

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v9.webservices.operations.flexnet.com">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:searchEntitlementLineItemPropertiesRequest>
         <urn:queryParams>
            <urn:isPermanent>false</urn:isPermanent>
            <!--Optional:-->
            <urn:expirationDate>

<!--type: date-->
<urn:value>2025-06-30</urn:value>
<!--type: datedSearchType - enumeration: [BEFORE,AFTER,ON]-->
<urn:searchType>BEFORE</urn:searchType>

            </urn:expirationDate>
            <urn:excludeExpired>true</urn:excludeExpired>
         </urn:queryParams>
         <urn:entitlementLineItemResponseConfig>
            <urn:activationId>true</urn:activationId>
            <urn:expirationDate>true</urn:expirationDate>
         </urn:entitlementLineItemResponseConfig>
         <!--type: integer-->
         <urn:batchSize>100</urn:batchSize>
         <!--Optional:-->
         <!--type: integer-->
         <urn:pageNumber>1</urn:pageNumber>
      </urn:searchEntitlementLineItemPropertiesRequest>
   </soapenv:Body>
</soapenv:Envelope>

Sample response for getEntitlementsAttributeQuery

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   soapenv:Body
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      <searchEntitlementLineItemPropertiesResponse 
xmlns="urn:v9.webservices.operations.flexnet.com">
         <statusInfo>
            <status>SUCCESS</status>
         </statusInfo>
         <entitlementLineItem>
            <activationId>

<uniqueId>HID-1</uniqueId>
<primaryKeys>
   <activationId>58b1-6e12-3bfa-4ffd-b1b5-45ed-11d3-019c</activationId>
</primaryKeys>

            </activationId>
            <expirationDate>2025-06-25</expirationDate>
         </entitlementLineItem>
         <entitlementLineItem>
            <activationId>

<uniqueId>HID-5</uniqueId>
<primaryKeys>
   <activationId>f479-77c6-64d5-4ba5-ac68-cdf8-d70f-9010</activationId>
</primaryKeys>

            </activationId>
            <expirationDate>2025-06-25</expirationDate>
         </entitlementLineItem>
         <entitlementLineItem>
            <activationId>

<uniqueId>HID-9</uniqueId>
<primaryKeys>
   <activationId>37e5-f876-1b8b-476f-9ed4-db83-0255-adec</activationId>
</primaryKeys>

            </activationId>
            <expirationDate>2025-06-26</expirationDate>
         </entitlementLineItem>
      </searchEntitlementLineItemPropertiesResponse>
   </soapenv:Body>
</soapenv:Envelope>

New APIs Added to Entitlement Management RESTful Services
This release expands the set of RESTful Services for Entitlement Management that was introduced in 
the 2025.04 release. 

The new set adds entitlement and line-item management capabilities. It introduces the following 
endpoints.

Method Endpoint Description

Maintenance Line Item

POST /entitlement/{entitlementId}/mainte
nance-line-items

Creates maintenance line items for a given 
entitlement, allowing producers to manage 
support and maintenance entitlements 
separately.

Entitlement 
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Additional Documentation

Detailed information about the Entitlement Management REST APIs is available on Swagger. Use the 
following URL to access it:

https://<siteID>.flexnetoperations.com/entitlements-api/swagger-ui/index.html 

where <siteID> is your organization’s site ID which is supplied by Revenera.

Important • The Entitlement Management REST API is currently in its beta version and remains under 
active development. As such, it is not yet fully optimized, and may undergo significant changes or 
enhancements. Revenera strongly advises against using this API in production environments.

User Experience Enhancements in 2025.07
The following user experience enhancements were added in the 2025.07 release.

• Cookie Consent Banner in the End-User Portal

• Selectively Retriggering Failed Bulk Operations

• New Role-based Permissions for Email and View Certificate Options in End-User Portal

• Enhanced UI for Import Tab in System Configuration

• Web Service Transactions “generateCapabilityResponse” and “generatePrebuiltLicense“ Visible in 
Producer Portal

POST /entitlement Creates an entitlement.

Entitlement Line Item 

GET /entitlement/{entitlementId}/line-
items

Retrieves line item details for a specified 
entitlement, providing visibility into line-item 
details in FlexNet Operations.

POST /entitlement/{entitlementId}/line-
items

Creates line items for a given entitlement.

PATCH /entitlement/{entitlementId}/line-
items/{activationId}/policies

Updates the policies of a given line item under 
an entitlement, allowing producers to modify the 
license model rules and other settings 
associated with that line item.

PATCH /entitlement/{entitlementId}/additio
nal-properties

Sets additional entitlement, line item, and 
license model attributes after an entitlement has 
been created, to help complete the 
configuration of entitlement.

Method Endpoint Description
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Cookie Consent Banner in the End-User Portal 
(Case 02993847, SWM-25549)

The End-User Portal can now display a cookie consent banner to inform users about the use of 
essential cookies on the website. This feature helps ensure compliance with data privacy regulations 
such as the General Data Protection Regulation  (GDPR), ePrivacy Directive, and the California 
Consumer Privacy Act (CCPA)).

Figure 19: The cookies banner on the Home page of the End-User Portal.

Banner Behavior

The cookie consent banner is shown to users upon accessing the End-User Portal. It remains visible 
until the user either clicks the Dismiss button or the X (close) button.

Once dismissed or closed, the banner will not reappear during the current session. The banner will be 
displayed again if the user logs out and logs back in.

Banner Configuration

Producers can control the display of the cookie consent banner in the End-User Portal using the 
configuration option Enable Cookie consent dialog (under System > Configuration > End-User Portal 
Setup > General Options). By default, this option is enabled (meaning the banner is displayed).

Selectively Retriggering Failed Bulk Operations
(Case 02840512, SWM-25800)

Previously, when a bulk upgrade job completed but failed to upgrade entitlement line items, there was 
no way to identify which items had failed or succeeded to upgrade. This lack of visibility made it 
challenging to selectively retrigger only the failed upgrades. 
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To address this challenge, the Bulk Operations page now lists failed upgrade lines along with their 
failure reasons, which enables administrators to efficiently identify and reprocess only the failed items, 
improving both reliability and operational efficiency. This enhancement is available for entitlements 
using FlexNet Embedded.

Administrators can rerun failed upgrade jobs in the following ways:

• Retrigger a single job: Click the new Retry icon next to a failed job entry.

• Retrigger multiple jobs: Select the checkboxes for multiple failed jobs and click the new Retry 
button (located above the table).

This screenshot shows the Bulk Operations page with the new button and icon:

Figure 20: An example of the Bulk Operations page with the new Retry button.

New Role-based Permissions for Email and View Certificate Options in End-
User Portal
(Case 02978952, SWM-25242)

This release introduces two new permissions to allow a more granular, role-based control over the 
visibility of the Email and View certificate menu items on the List Entitlements page in the End-User 
Portal.
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Figure 21: View of the List Entitlements page in the End-User Portal (cropped view).

Previously, the visibility of the Email and View certificate menu items was controlled globally by the 
configuration settings Hide View Certificate and Hide Email (under System > Configure > End-User 
Portal Setup > Entitlements Page). These settings applied to all users, limiting flexibility for 
organizations with diverse user roles and access needs.

To allow a more tailored access control, two new permissions have been introduced under Account 
Permissions - End-User Portal: 

• View Certificate  

• Email Licenses

These permissions allow administrators to control access to the respective menu items based on user 
roles.

Behavior Details

• The configuration takes priority. If the global configuration to hide a menu item is enabled, the 
item will remain hidden for all users, regardless of their permissions.

• If the global configuration is disabled, only users with the corresponding permission will see the 
Email or View Certificate menu items.

• By default, all existing roles that have the permission Email Licenses (listed under Operations 
License Management - Producer Portal) are granted these new permissions to maintain current 
behavior and avoid disruption.

Enhanced UI for Import Tab in System Configuration
(SWM-26018)

The UI for Import settings (under System > Configure > Import) has been redesigned to improve 
usability and clarity.

The two sections for importing a configuration .JAR file and a digital certificate .DER file have been 
clearly separated and renamed for better understanding. The following screenshot shows the 
improved UI (for comparison, a screenshot of the previous UI can be found in Auto-Upload of Default 
Public Key for CLS).
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Figure 22: Redesigned UI of the Import section in the system configuration.

Web Service Transactions “generateCapabilityResponse” and 
“generatePrebuiltLicense“ Visible in Producer Portal 
(SWM-24814, SWM-27695)

The list of transactions displayed on the Search Transactions page in the Producer Portal (under 
System > Transaction History) now also includes the following transactions:

• A response was generated for a device using web services. 

• A pre-installed license is generated for a device using web services. 

These enhancements are a continuation of the transparency improvements made in the previous 
releases (2025.04 through 2025.06).  

Tracked Operations In 2025.07

Transactions are tracked for standalone devices, Cloud Licensing Service instances and local license 
servers. The following table lists the operations of the ManageDeviceService web service that are now 
tracked: 

Transaction Web Service Operation Event Type Description

Transactions tracked from release 2025.07 onwards
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Generating a 
capability 
response

generateCapabilityRespo
nse 

UPDATE Tracks transactions where a 
capability response was generated 
for a device. 

Generating a pre-
installed license

generatePrebuiltLicense  UPDATE Tracks transactions where a pre-
installed license was generated for 
a device. 

Transactions tracked from release 2025.06 onwards

Returning a host returnHost UPDATE Tracks transactions where the 
status of a host is set to 
"RETURNED".

Transactions tracked from release 2025.05 onwards

Deleting a line item 
from a device

deleteAddOnLineItemsReq
uest

UPDATE Tracks transactions where an 
entitlement line item was deleted 
on a device. 

Obsoleting the 
host for a device 

obsoleteHostRequest DELETE Tracks transactions where a host 
for a device was deleted.

Removing add-on 
line items

decrementAddonLineItems
Request

UPDATE Tracks transactions where an add-
on line item was removed from a 
device. 

Moving a device to 
a different account

moveDeviceRequest UPDATE Tracks transactions where a device 
is moved to a different account. 

Deleting a device deleteDeviceRequest DELETE Tracks transactions where a device 
is deleted. 

Transactions tracked from release 2025.04 onwards

Creating a device createDeviceRequest CREATE Tracks all successful and failed 
attempts to create a device. 

Linking 
entitlement line 
items to a device

linkAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was linked to 
a device, or where a metered 
license was removed from a 
device. 

Incrementing 
entitlement line 
items to devices

IncrementAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was 
incremented on a device. 

Transaction Web Service Operation Event Type Description
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Features and Enhancements in 2025.06
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.06 
release:

• Data Analytics Enhancements in 2025.06

• Device Management Enhancements in 2025.06

• SOAP and REST Web Services Enhancements in 2025.06

• User Experience Enhancements in 2025.06

• User Management Enhancements in 2025.06

Data Analytics Enhancements in 2025.06
The following enhancement was made to the Analytics functionality in 2025.06.

New Analytics Bar Chart “Downloads by Product Line”
(SWM-26396)

As part of ongoing efforts to improve visibility and usability within the Software Delivery Download 
History dashboard (available from the Analytics menu), Revenera introduces a new interactive bar 
chart, Downloads by Product Line.

This new chart draws data from the Downloads dataset that are used by the FlexNet Operations Data 
Access API (for more information, see Data Access API and Data Share Entity Relationship Details). It 
visualizes the number of downloads categorized by product line. 

Key Functionality

• Each bar represents the total downloads for a specific product line.

• Clicking on a bar dynamically filters the dashboard to display all downloads corresponding to the 
selected product line.

Updating a device updateDevice UPDATE Tracks transactions where a device 
was updated.

Transaction Web Service Operation Event Type Description

https://docs.revenera.com/fno_CURRENT/fnoapi-da/fnoapi_dataaccess_reportfields.htm
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Figure 23: An example of the new Downloads by Product Line bar chart.

This enhancement provides users with a clearer overview of download trends by product line and 
enabling quick drill-down into detailed records.

Key Benefits 

• Quickly identify which product lines have the highest or lowest download activity.

• Seamlessly drill down into download details with one click.

• Enhanced user experience for tracking and analysing download trends.

Device Management Enhancements in 2025.06
The following enhancements to device management were added in the 2025.06 release.

• Bulk Updating Device Attributes

• Optional Site Name Information in AssignAccountToHost Sheet of Devices Template

Bulk Updating Device Attributes
(SWM-26157)

The Devices Template, first introduced in the 2025.05 release, has undergone further enhancements 
to provide producers with greater flexibility in managing device attributes at scale. As part of this 
update, a new sheet called UpdateHost has been added to the template, enabling bulk updates to the 
following device attributes: site name, notes, user ID, backup server ID, and device display name.

In the template, the following properties must be provided to update device attributes: host ID, host 
alias, publisher name, host class, and host ID type. 

This screenshot shows an example of a populated template:



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  72

Figure 24: Example of a populated UpdateHost sheet.

To download the Devices Template (XLSX format), click Administer > Import Data Objects and select 
the Data Import Templates tab.

Figure 25: The Devices Template can be downloaded from the Import Data Objects page.

Once the Devices Template has been populated, it must be saved as a Unicode .txt file before it can be 
imported into FlexNet Operations, using the Import Settings tab on the Import Data Objects page.

Optional Site Name Information in AssignAccountToHost Sheet of Devices 
Template
(SWM-27230)

A new optional column, SiteName, has been added to the AssignAccountToHost sheet of the Devices 
Template. While this column cannot be used as input for this operation, it helps producers more 
effectively differentiate between devices and servers based on their site name.
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Figure 26: Example of a populated SiteName column on the AssignAccountToHost sheet of the 
Devices Template.

SOAP and REST Web Services Enhancements in 2025.06
The following enhancements were added to the SOAP and REST Web Services module in the 2025.06 
release.

• New API Commands to Report Custom Attributes for Entitlements and Line Items

• Entitlement Order Service Now Returning Activatable Item Owner Details

• Optional vendorAuthString parameter in getFeaturesQueryRequest API in 
ProductPackagingService v3

New API Commands to Report Custom Attributes for Entitlements and Line 
Items
(Case 02852081, SWM-19774) 

This release introduces version 9 of the EntitlementOrderService web service. Version 9 enables 
users to retrieve details of all custom attributes—including Entitlement, Line Item, and Maintenance 
attributes—using the operations getEntitlementsAttributeQuery and getEntitlementAttributeCount 
with the query parameters searchEntitlementAttributeRequest and 
getEntitlementAttributeCountRequest.

The response contains an optional element activationId  for searchEntitlementAttributeRequest 
and getEntitlementAttributeCountRequest.

The new API command returns all entitlements, line items and maintenance line items with their 
custom attributes. 

Key changes:

• New version 9 of EntitlementOrderService.wsdl

• New Operations: getEntitlementsAttributeQuery, getEntitlementAttributeCount

• New Parameters: searchEntitlementAttributeRequest, getEntitlementAttributeCountRequest

For detailed information about the changes made to the EntitlementOrderService.wsdl and the .xsd 
files that it references, see the Change Log for 2025.06.
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Sample Request and Response for getEntitlementsAttributeQuery

The following sections show sample code for getEntitlementsAttributeQuery.

Sample Request for getEntitlementsAttributeQuery

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v9.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:searchEntitlementAttributeRequest>
<urn:entitlementAttributeSearchCriteria>

<!--Optional:-->
<urn:entitlementId>

<urn:value>ENT_Test_AutoRenew9</urn:value>
<urn:searchType>EQUALS</urn:searchType>

</urn:entitlementId>
</urn:entitlementAttributeSearchCriteria>
<urn:batchSize>10</urn:batchSize>

</urn:searchEntitlementAttributeRequest>
</soapenv:Body>

</soapenv:Envelope>

Sample Response for getEntitlementsAttributeQuery

This sample has been condensed to fit within space constraints.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Body>
<searchEntitlementAttributeResponse xmlns="urn:v9.webservices.operations.flexnet.com">

<statusInfo>
<status>SUCCESS</status>

</statusInfo>
<entitlement>

<simpleEntitlement>
<entitlementId>

<id>ENT_Test_AutoRenew9</id>
</entitlementId>
... 
<maintenanceLineItems>

<maintenanceProduct>
<uniqueId>HID-2000000001928</uniqueId>
<primaryKeys>

<name>Main_Test3</name>
<version>1.0</version>

</primaryKeys>
</maintenanceProduct>
<orderId>2001</orderId>
<orderLineNumber>201</orderLineNumber>
<startDate>2024-03-01</startDate>
<expirationDate>2026-02-26</expirationDate>
<isPermanent>false</isPermanent>
<parentLineItem>

<uniqueId>HID-2000000142914</uniqueId>
<primaryKeys>
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<activationId>TestAct_AutoRenew</activationId>
</primaryKeys>

</parentLineItem>
<associatedLineItems>

<uniqueId>HID-2000000142914</uniqueId>
<primaryKeys>

<activationId>TestAct_AutoRenew</activationId>
</primaryKeys>

</associatedLineItems>
<maintenanceLineItemAttributes>

<attribute>
<attributeName>MLIA_ET_Boolean</attributeName>
<booleanValue>true</booleanValue>

</attribute>
<attribute>

<attributeName>TempCA1_Boolean_FNO_54060</attributeName>
<booleanValue>false</booleanValue>

</attribute>
<attribute>

<attributeName>TempCA_Boolean_FNO_54060</attributeName>
<booleanValue>false</booleanValue>

</attribute>
</maintenanceLineItemAttributes>
<state>DEPLOYED</state>

</maintenanceLineItems>
...
</entitlementAttributes>

</simpleEntitlement>
</entitlement>

</searchEntitlementAttributeResponse>
</soapenv:Body>

</soapenv:Envelope>

Sample Request and Response for getEntitlementAttributeCount

The following sections show sample code for getEntitlementAttributeCount.

Sample Request for getEntitlementAttributeCount

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v9.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:getEntitlementAttributeCountRequest>
<urn:queryParams>

<!--Optional:-->
<urn:entitlementId>

<urn:value>ENT_Test_AutoRenew9</urn:value>
<urn:searchType>EQUALS</urn:searchType>

</urn:entitlementId>
</urn:queryParams>

</urn:getEntitlementAttributeCountRequest>
</soapenv:Body>

</soapenv:Envelope>
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Sample Response for getEntitlementAttributeCount

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Body>
<getEntitlementAttributeCountResponse 

xmlns="urn:v9.webservices.operations.flexnet.com">
<statusInfo>

<status>SUCCESS</status>
</statusInfo>
<count>1</count>

</getEntitlementAttributeCountResponse>
</soapenv:Body>

</soapenv:Envelope>

Entitlement Order Service Now Returning Activatable Item Owner Details
(Cases 02847862, 03002310, 03004150, 03033984, 03034028; SWM-20135)

Producers can now extract information about self-registered end-users using the new version 9 of the  
EntitlementOrderService web service. This enhancement is especially useful for renewals, because it 
enables producers to tie self-registered end-users to the details in their ERP system. 

Most importantly, producers can extract the end-users’s email address that is displayed in the 
Activatable Item Owner field for a line item, as seen in this sample screenshot:
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Details of Changes to EntitlementOrderService.wsdl

The following new filters were added to getEntitlementLineItemPropertiesQuery:

• productLine: For searching a line item based on the entitled product’s product line.

• expiresIn: For searching a line item based on the expiration period. Available search units: DAYS, 
WEEKS, MONTHS, YEARS. This enables producers to filter for entitlements expiring within, for 
example, 30 days or 3 months. 

• activatableItemOwnersSearch: Can have multiple activatableItemOwner child nodes. Retrieves 
all line items that belong to either of the emails provided as child elements.

• soldToDisplayName: For searching based on the display name of the assigned account.

The following optional response field was added to getEntitlementLineItemPropertiesQuery:

• activatableItemOwners: Can have multiple activatableItemOwner child nodes. Lists all the 
owners of a given line item.

For detailed information about the changes made to the EntitlementOrderService.wsdl and the .xsd 
files that it references, see the Change Log for 2025.06.
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Optional vendorAuthString parameter in getFeaturesQueryRequest API in 
ProductPackagingService v3 
(SWM-27118)

The getFeaturesQueryRequest API in the ProductPackagingService web service (version 3) now 
supports a new optional parameter: vendorAuthString.

The vendor auth string is used to sign license files for FlexNet Publisher licenses.  

When a non-null, non-empty value is provided for vendorAuthString, it will be included in the API 
response. This enhancement allows producers to:

• Retrieve the vendor auth string alongside other feature properties.

• Query feature information using the vendor auth string as a filter.

For detailed information about the changes, see the Change Log for 2025.06.

Sample Request and Response for getFeaturesQuery

The following sections show sample code for getFeaturesQuery.

Sample Request for getFeaturesQuery

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v3.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:getFeaturesQueryRequest>
<!--Optional:-->
<urn:queryParams>

<!--Optional:-->
<urn:featureName>

<!--type: string-->
<urn:value>zstart</urn:value>
<!--type: simpleSearchType - enumeration: 

[STARTS_WITH,CONTAINS,ENDS_WITH,EQUALS]-->
</urn:searchType>EQUALS</urn:searchType>

</urn:featureName>
</urn:queryParams>
<!--type: integer-->
<urn:pageNumber>1</urn:pageNumber>
<!--type: integer-->
<urn:batchSize>100</urn:batchSize>

</urn:getFeaturesQueryRequest>
</soapenv:Body>

</soapenv:Envelope>

Sample Response for getFeaturesQuery

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Body>
<getFeaturesQueryResponse xmlns="urn:v3.webservices.operations.flexnet.com">

<statusInfo>
<status>SUCCESS</status>
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</statusInfo>
<responseData>

<feature>
<uniqueId>HID-8</uniqueId>
<featureName>Zstart</featureName>
<versionFormat>DATE_BASED</versionFormat>
<version/>
<description/>
<state>DEPLOYED</state>
<vendorAuthString>AUTH={ demo=( LK=0 SIGN=0 SIGN2=0) demo2=( SIGN=0 SIGN2=0) 

}</vendorAuthString>
<featureOverrideParams>

<dupGroup>
<dupGroupOption>NO_OVERRIDE</dupGroupOption>

</dupGroup>
</featureOverrideParams>

</feature>
</responseData>

</getFeaturesQueryResponse>
</soapenv:Body>

</soapenv:Envelope>

Vendor Auth String in Producer Portal

The vendor auth string can also be displayed in the Producer Portal on the Create A Feature page 
(under Products > Features > Add new Feature):

By default, the Vendor Auth String field is hidden. Producers who wish to have it displayed should 
contact Revenera support. 

User Experience Enhancements in 2025.06
The following user experience enhancement was added in the 2025.06 release.

• Auto-Upload of Default Public Key for CLS
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• Shortened Configuration Option Name

• Web Service Transaction “returnHost” Visible in Producer Portal

• Extended File Download Period on “Recent Files Added” Page in End-User Portal

• Enhanced Performance for Cloud Licensing Service

Auto-Upload of Default Public Key for CLS
(SWM-26018, SWM-26942)

Producers can now configure a default .DER public key in the Producer Portal. This key will be 
automatically applied to all newly created Cloud License Server (CLS) instances. It means that 
producers no longer need to manually upload the public key (.DER) file to each of their CLS instances, 
saving time and effort. 

Once a .DER file has been uploaded via the Import tab, it cannot be overwritten using the existing 
import_access_key REST API endpoint of the Cloud Licensing Service Module. Also, there is currently 
no option to view or delete an uploaded .DER file. However, you can upload a new .DER file, which will 
replace the existing one.

Producers upload the .DER file on the Import tab of the System Configuration page (under System > 
Configure). Uploaded .DER files are validated to confirm they are in the correct format. The following 
screenshot shows the new interface for the upload: 
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Figure 27:  The Import tab on the System Configuration page now includes the Import Default Public 
Key button for uploading a .DER file that will be automatically applied to all newly created Cloud 
Licensing Service (CLS) instances.

Shortened Configuration Option Name
(SWM-26378)

The 2025.04 release introduced a configuration which allows producers to change the behavior when 
mapping renewal licenses to devices. This configuration was called Retain mapping of the parent 
activation to the devices when mapping a child activation (available under System > Configure > 
Embedded Devices > Host Options; see also Allow Renewal License to Start Upon Expiry of Parent 
License). 

In the 2025.06 release, the configuration name was shortened to Retain parent activation ID on 
devices/servers, to provide a better user experience. 

Web Service Transaction “returnHost” Visible in Producer Portal 
(SWM-24819) 

The list of transactions displayed on the Search Transactions page in the Producer Portal (under 
System > Transaction History) will now also include host returns performed using web services. This 
enhancement is a continuation of the transparency improvements made in the 2025.04 and 2025.05 
releases.  
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Tracked Operations In 2025.06

Transactions are tracked for standalone devices, Cloud Licensing Service instances and local license 
servers. The following table lists the operations of the ManageDeviceService web service that are now 
tracked: 

Transaction Web Service Operation Event Type Description

Transactions tracked from release 2025.06 onwards

Returning a host returnHost UPDATE Tracks transactions where the 
status of a host is set to 
"RETURNED".

Transactions tracked from release 2025.05 onwards

Deleting a line item 
from a device

deleteAddOnLineItemsReq
uest

UPDATE Tracks transactions where an 
entitlement line item was deleted 
on a device. 

Obsoleting the 
host for a device 

obsoleteHostRequest DELETE Tracks transactions where a host 
for a device was deleted.

Removing add-on 
line items

decrementAddonLineItems
Request

UPDATE Tracks transactions where an add-
on line item was removed from a 
device. 

Moving a device to 
a different account

moveDeviceRequest UPDATE Tracks transactions where a device 
is moved to a different account. 

Deleting a device deleteDeviceRequest DELETE Tracks transactions where a device 
is deleted. 

Transactions tracked from release 2025.04 onwards

Creating a device createDeviceRequest CREATE Tracks all successful and failed 
attempts to create a device. 

Linking 
entitlement line 
items to a device

linkAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was linked to 
a device, or where a metered 
license was removed from a 
device. 

Incrementing 
entitlement line 
items to devices

IncrementAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was 
incremented on a device. 

Updating a device updateDevice UPDATE Tracks transactions where a device 
was updated.
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For a use case example or information about how to view transaction details, see Improved 
Transaction Visibility in Producer Portal.

Extended File Download Period on “Recent Files Added” Page in End-User 
Portal
(Case 02844268, SWM-19857)

Previously, the End-User Portal allowed quick access to file downloads on the Recent Files Added 
page for recent periods of 30, 60, 90, and 120 days. To meet customer requirements, the available 
selection on the Recent Files Added page has been expanded to include a 180-day option. This 
enhancement provides greater flexibility for retrieving older content on this page.

Figure 28: The dropdown menu on the Recent Files Added list now includes a new Last 180 Days 
option.

Enhanced Performance for Cloud Licensing Service
(Cases 02869447, 02904288, 02908404; SWM-16623)

Performance upgrades to the Cloud Licensing Service (CLS) now enable faster processing and better 
scalability for high-volume operations:

These enhancements dramatically reduce wait times and improve efficiency for high-volume licensing 
operations.

Previous Performance Current Performance

Processing 200 CLS license updates took 5-7 
minutes

3,000 CLS instances mapped to a product with 
feature quantity change completed in 2 
minutes 20 seconds.

Changes for 1,400 CLS instances took up to 1.5 
hours.

10,000 CLS license updates now processed in 
just 7 minutes.

High-volume CLS changes took up to 12 hours.
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User Management Enhancements in 2025.06
The following user management enhancement was added in the 2025.06 release.

Automated User Provisioning from Identity Providers (IdPs) to FlexNet 
Operations
(SWM-21825)

Revenera is introducing a new capability that simplifies user management for producers implementing 
Single Sign-On (SSO) with FlexNet Operations.

Previously, producers were required to manually replicate user information from their Identity Provider 
(IdP)—such as Okta or Entra—into FlexNet Operations. This manual process was time-consuming and 
error-prone, especially for SaaS providers managing large user bases.

Starting with the 2025.06 release, the Producer Portal now enables producers to automate their user 
provisioning from IdPs. Any changes to user data—including new user creation, identity updates, and 
user deletions—are automatically synced from the IdP to the Producer Portal, ensuring consistency.

This enhancement enables seamless synchronization of user identities, eliminating the need for 
manual duplication.

For detailed information, refer to the relevant section:

• Prerequisites for User Synchronization

• Supported IdPs

• Configuring Your IdP

• Impact of IdP User Changes on FlexNet Operations

• Setting Up User Synchronization in FlexNet Operations

• Enabling and Configuring User Synchronization in Each Portal

• Assigning Users to Accounts Post Sync

• Monitoring User Synchronization

Prerequisites for User Synchronization

By default, user synchronization is disabled. To enable this feature, contact Revenera Support. 

The user configuring the user synchronization for the Producer Portal and/or the End-User Portal must 
have a role with the Manage SAML SSO permission.

Single sign-on with SAML must be configured for the portal whose users are to be synced (Producer 
Portal and/or End-User Portal). For more information, see the topic Single Sign-On Support with SAML 
in the FlexNet Operations User Guide. 

Supported IdPs

FlexNet Operations supports any identity provider that complies with SCIM 2.0 and later. Examples 
include:

• Okta (https://www.okta.com)

https://www.okta.com/
https://docs.revenera.com/fno_CURRENT/producer/Content/helplibrary/opsAdminConfigSAML.htm
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• Microsoft  Entra (https://www.microsoft.com/en-gb/security/business/microsoft-entra) 

• Salesforce (https://www.salesforce.com).

Configuring Your IdP

To enable secure communication for user synchronization between the IdP and FlexNet Operations, 
you must provide the following information in your IdP:

• Base URL—Point your IdP to the following endpoints to communicate with FlexNet Operations: 

• Producer Portal

https://<siteID>-fno.flexnetoperations.com/scim/v2 

• End-User Portal

https://<siteID>.flexnetoperations.com/scim/v2 

In both URLs, replace <siteID> with your organization’s site ID which is supplied by Revenera.

• API Token—Provide the access token generated by FlexNet Operations. This can be generated in 
the Producer Portal (under Accounts & Users > Manage Access Tokens). The token type must be 
NORMAL. 

Tip • For more information about token generation, see the topic Managing Access Tokens in the 
FlexNet Operations User Guide. 

Impact of IdP User Changes on FlexNet Operations 

The following changes made to users in the IdP are synced with FlexNet Operations:

• New users created

• Updated user data (for example, email address, contact details)

• Users deleted 

Important • Users deleted in the IdP are not removed from FlexNet Operations. Instead, their 
status is set to Inactive. Inactive users cannot access the system unless reactivated.

Setting Up User Synchronization in FlexNet Operations

You set up user synchronization on the Manage User Synchronization page (available from the 
Administer menu). 

You have two setup options: 

• Configuring User Synchronisation for Producer Portal.

• Configuring User Synchronisation for End User Portal.

The setup process is identical for both portals.

https://www.microsoft.com/en-gb/security/business/microsoft-entra
https://docs.revenera.com/fno_CURRENT/producer/Content/helplibrary/platUserMgeAccessTokens.htm
https://www.salesforce.com
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Figure 29: The Manage User Synchronization page serves as the starting point for setting up user 
synchronization in both the Producer Portal and End-User Portal..

Enabling and Configuring User Synchronization in Each Portal

Clicking Configure on the Manage User Synchronization page opens the page where you can configure 
the user synchronization settings for the Producer Portal and the End-User Portal, respectively. 

The first checkbox, Enable User Synchronization, lets you easily switch user synchronization between 
your IdP and the Producer Portal or the End-User Portal on and off. 

Assigning Users to Accounts

You need to define the account to which synced users will be associated. Your options are:

• Use an account—Select this option if all synced users should be associated with a specific 
account. You can select this account using the Select Account dropdown, which will display all 
accounts that are currently set up for your organization.

This option, when paired with IdP group mapping to FlexNet Operations roles (see Mapping IdP 
Groups to FlexNet Operations Roles), provides the most efficient user synchronization method, 
requiring no additional manual intervention.

• Use the locked account—Select this option if all synced users should be associated with the 
default account, which is automatically created by the IdP sync process. The default account is 
named IDP_SYNC_DEFAULT_PRODUCER for the Producer Portal and IDP_SYNC_DEFAULT_CUSTOMER for 
the End-User Portal.

This option is suitable if you are creating users for multiple FlexNet Operations accounts. In a later 
step, discussed in section Assigning Users to Accounts Post Sync, you can map these users to an 
account of your choice and also assign them a role.
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Figure 30: Here’s a possible view of the Configure User Synchronization for Producer Portal page 
where synced users are added to the MYORG account, and IdP groups are mapped to FlexNet 
Operations roles.

Mapping IdP Groups to FlexNet Operations Roles

Optionally, if your IdP organizes users into groups, you can map each group to one or more FlexNet 
Operations roles. Upon sync, these users will be assigned the role(s) that you specified for their group.

Example: If your IdP has a group called Customer Support and you want to give all users in this group 
the roles Customer Rep 2.0 and IT BackOffice Manage, you could add the following row: 

Important • When mapping groups, the group name must be entered exactly as it appears in your IdP, 
including capitalization. 

If groups are not mapped to roles, or if a user does not belong to a group, they are automatically 
created in FlexNet Operations and assigned the default role:

• Default Producer Role for the Producer Portal

• Default Portal Role for the End-User Portal

These default roles grant only the View Feature permission, which allows users to view the Home page 
and access the Logout button.
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Assigning Users to Accounts Post Sync 

If you selected the option Use the locked account on the Configure User Synchronization page for 
either of the portals, the Approve User Access page (also available from the Administer menu) will list 
all users linked to the default account (IDP_SYNC_DEFAULT_PRODUCER for the Producer Portal and 
IDP_SYNC_DEFAULT_CUSTOMER for the End-User Portal). The tabbed interface groups users into 
customer users and producer users.

 The Approve User Access page is tabbed and lists all users synced from your IdP to FlexNet 
Operations that were associated with the locked (default) account.

Note • Users assigned to a locked account will be listed on the Approve User Access page until they 
are assigned a new account. 

On the Approve User Access page, you can efficiently associate users with accounts and assign roles. 
The interface provides options for assigning accounts to individual users via the Assign Account 
hyperlink or managing multiple users simultaneously by selecting them and clicking the Assign 
Account button above the table.
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Figure 31: Example view of the Associate Users to Account and Roles window. The search bar is used 
to locate a specific account, and the Roles field supports text-based filtering to narrow down role 
selections.

Monitoring User Synchronization

Producers can easily monitor and track failed user synchronization attempts from the User 
Synchronization Logs page (also available from the Administer menu). The interface offers advanced 
search capabilities, allowing users to filter results by:  

• Email address

• Date

• Time of failure

Each log entry provides key details, including:  

• User’s email address

• Associated portal (Producer Portal or End-User Portal)  

• Date and time of failure

• Failure reason or error details (for example, missing role mapping, invalid account reference, IdP 
attribute mismatch)  
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Figure 32: An example of the User Synchronization Logs page.

With these insights, producers can quickly identify and resolve onboarding issues, ensuring a 
smoother synchronization workflow.

Features and Enhancements in 2025.05
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.05 
release:

• Data Analytics Enhancements in 2025.05

• Device Management Enhancements in 2025.05

• Entitlement Management Enhancements in 2025.05

• SOAP and REST Web Services Enhancements in 2025.05

• User Experience Enhancements in 2025.05

Data Analytics Enhancements in 2025.05
The following enhancement was made to the Analytics functionality in 2025.05.

New "Created By" and "Last Modified By" Information in Data Warehouse
(Case 02969613, SWM-25037)

Several new fields have been added to the Data Warehouse. The most prominent updates are fields for 
"Created By" and "Last Modified By" information, which can now be extracted using the Analytics 
functionality, a data share or the Data Access API (DAPI). The information enables producers to track 
the origin and updates of data for better accountability and data management. 

https://fnoapi-da.redoc.ly/
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The following tables list all the fields that have been added to the data sets, along with a description of 
the data. 

Table 1 • Data set: device

DAPI Data Share Description

OrderID ORDER_ID The value entered in FlexNet Operations 
while configuring the entitlement line 
items. (This may be imported from your 
CRM/ERP application.)

StartDate LINE_ITEM_START_DATE Start date of the line item.

DeviceCreatedBy DEVICE_CREATED_BY This field identifies the user who 
created the device.

DeviceUpdatedBy DEVICE_UPDATED_BY This field identifies the user who 
updated the device.

AddOnCreatedBy ADDON_CREATED_BY This field identifies the user who first 
mapped the line item to the device.

AddOnUpdatedBy ADDON_UPDATED_BY This field identifies the user who 
updated the mapped line item to the 
device.

Table 2 • Data set: entitlement

DAPI Data Share Description

ActivatableItemOwners ACTIVATABLE_ITEM_OWN
ERS

This field identifies users who self-
register by logging in to the End-User 
Portal with an activation ID and set up 
their own user account.

EntitlementDescription ENTITLEMENT_DESCRIPTI
ON

A brief, optional description of the 
entitlement as defined in FlexNet 
Operations.

EntitlementCreatedBy ENTITLEMENT_CREATED_
BY

This field identifies the user who 
created the entitlement.

EntitlementUpdatedBy ENTITLEMENT_UPDATED_
BY

This field identifies the user who 
updated the entitlement.

LineItemCreatedBy LINEITEM_CREATED_BY This field identifies the user who 
created the line item.
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LineItemUpdatedBy LINEITEM_UPDATED_BY This field identifies the user who 
updates the line item.

MaintenanceLineItemCreate
dBy

MAINTENANCE_LINEITEM
_CREATED_BY

This field identifies the user who 
created the maintenance line item.

MaintenanceLineItemUpdate
dBy

MAINTENANCE_LINEITEM
_UPDATED_BY

This field identifies the user who 
updated the maintenance line item.

ProductCreatedBy PRODUCT_CREATED_BY This field identifies the user who 
created the product.

ProductUpdatedBy PRODUCT_UPDATED_BY This field identifies the user who 
updated the product.

Table 3 • Data set: fulfillment

DAPI Data Share Description

FulfillmentCreatedBy FULFILLMENT_CREATED_
BY

This field identifies the user who 
created the fulfillment.

FulfillmentUpdatedBy FULFILLMENT_UPDATED_
BY

This field identifies the user who 
updated the fulfillment.

Table 4 • Data set: account

DAPI Data Share Description

AccountCreatedBy ACCOUNT_CREATED_BY This field identifies the user who 
created the account.

AccountUpdatedBy ACCOUNT_UPDATED_BY This field identifies the user who 
updated the account.

AccountHierarchyCreatedBy ACCOUNT_HIERARCHY_C
REATED_BY

This field identifies the user who 
created the account hierarchy.

AccountHierarchyUpdatedBy ACCOUNT_HIERARCHY_U
PDATED_BY

This field identifies the user who 
updated the account hierarchy.

Table 2 • Data set: entitlement

DAPI Data Share Description



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  93

New Fields in FlexNet Operations Analytics

Producers using the Analytics functionality need to know that by default none of the new fields are 
selected for display in the Analytics report tables. As an example, the following screenshot shows the 
default column selection for the Devices Details report:

Table 5 • Data set: product-feature

DAPI Data Share Description

ProductCreatedBy PRODUCT_CREATED_BY This field identifies the user who 
created the product.

ProductUpdatedBy PRODUCT_UPDATED_BY This field identifies the user who 
updated the product.

FeatureCreatedBy FEATURE_CREATED_BY This field identifies the user who 
created the feature.

FeatureUpdatedBy FEATURE_UPDATED_BY This field identifies the user who 
updated the feature.

Table 6 • Data set: user

DAPI Data Share Description

UserCreatedBy USER_CREATED_BY This field identifies the user who 
created the user.

UserUpdatedBy USER_UPDATED_BY This field identifies the user who 
updated the user.
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Device Management Enhancements in 2025.05
The following enhancements to device management were added in the 2025.05 release.

• Device History Now Listing Users Who Triggered Events

• Bulk Updating Account Information for Devices

Device History Now Listing Users Who Triggered Events 
(Cases 02685529, 02869243; SWM-13895)

The Device History page (available by clicking View > View Device History on a Device or View Server 
page) now includes a User Details column, which lists the name of the user who triggered an event (for 
example, creating a device or mapping entitlements). 

 This improvement enhances transparency by identifying who performed particular actions on a 
device, making it easier to troubleshoot issues. 

Figure 33: Example of the Device History page with the User Details column.

Bulk Updating Account Information for Devices
(SWM-25969) 
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Producers can now use the newly introduced Devices Template to assign an account to multiple 
devices at a time. This offers an easier and faster UI-based way to perform bulk transfers of 
entitlements between accounts, including stock returns and the transfer of faulty appliance 
entitlements.

• To download the Devices Template (XLSX format), click Administer > Import Data Objects and 
select the Data Import Templates tab.

Figure 34: The Devices Template can be downloaded from the Import Data Objects page.

In the template, the following properties must be provided to update account information for devices: 
host id, publisher name, host class, host id type and account ID. 

This screenshot shows an example of a populated template:

Figure 35: Example of a populated XLSX template.

Once the Devices Template has been populated, it must be saved as a Unicode .txt file before it can be 
imported into FlexNet Operations, using the Import Settings tab on the Import Data Objects page.

Entitlement Management Enhancements in 2025.05
The following enhancements to entitlement management were added in the 2025.05 release.
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• Ability to Limit Activation of FlexNet Embedded Nodelocked Licenses to Servers and/or 
Standalone Devices

• CONTAINER_ID Host ID Now Available for Docker Containers

• Merge Tags Added to Fulfillment On Hold Email Template to Improve Communication

• Advanced Search for Entitlements Includes Custom License Models

Ability to Limit Activation of FlexNet Embedded Nodelocked Licenses to 
Servers and/or Standalone Devices 
(SWM-19823, SWM-24434)

Producers can now specify whether a nodelocked FlexNet Embedded license can only be activated on 
license servers, standalone devices, or both. This enhancement increases a producer’s control over 
license activation, and prevents license leakage caused by uncounted licenses being activated on a 
license server. 

Controlling the activation of FlexNet Embedded licenses is done during license model creation 
(Administer > License Models > Create new license model). When selecting the license model type 
Embedded, producers can select where the license model can be activated using the new option, 
Hosted On. The following options are available:

• License Servers—Licenses can only be activated on license servers. Attempts to activate a license 
on a standalone device will fail.

• Standalone Devices—Licenses can only be activated on standalone devices. Attempts to activate 
a license on a license server will fail.

• Both—Licenses can be activated on license servers and on standalone devices. This is the default 
option.
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Figure 36: The Hosted On property is set during license model creation.

The above controls apply to online and offline activations and are enforced regardless of activation 
type (Producer Portal, Web services, capability requests).

Behavior when changing a license model for a product

To explain the behavior, consider that you have the following license models defined: 

• License model 1: HostedOnServerOnly, Hosted On property set to License Servers

• License model 2: HostedOnStandalone, Hosted On property set to Standalone

When the license model of an existing product is changed—for example, the license model is changed 
from HostedOnServerOnly to HostedOnStandalone—FlexNet Operations will correctly validate license 
applicability based on device type.

While the entitlement line items are not removed automatically, once the license model is changed, 
licenses with HostedOnStandalone are no longer shown for Cloud Licensing Service (CLS) instances or 
local license servers. Users must manually remove entitlements if they are no longer valid for the 
device.



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  98

This behavior ensures that licenses meant only for standalone devices won't mistakenly appear for 
license servers, reducing confusion and helping enforce correct usage.

CONTAINER_ID Host ID Now Available for Docker Containers
(Case 02758504, SWM-19930)

The list of hostid types available for Flexnet Publisher certificate-based licensing now also includes the 
host ID type CONTAINER_ID. The CONTAINER_ID is used to node-locking a license server and feature 
licenses to a docker container host ID. 

Figure 37: The CONTAINER_ID can be selected in the Create License Host window.

Producers wanting to use CONTAINER_ID as a host ID must build a new version of the Vendor Certificate 
Generator (VCG) executable and need to change the generator configuration to version 16.2.3.0. 
Instructions on how to build a new version can be found in the Flexnet Operations User Guide, topic 
Creating a FlexNet Publisher Licensing Toolkit License Generator (VCG) Configuration.

Merge Tags Added to Fulfillment On Hold Email Template to Improve 
Communication
(SWM-25684)

When an on-hold fulfillment is created, an email can be triggered to notify the producer that the 
fulfillment is waiting for a license to be set. The Fulfillment On Hold template, on which such an email 
would be based, has now been enhanced to include additional merge tags to include relevant details. 
(Previously, the only merge tag available in this template was [[FulfillmentID]].)

https://docs.revenera.com/fno_CURRENT/producer/Content/helplibrary/opsCreateVcgConfig.htm
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List of Merge Tags in Fulfillment On Hold Template

The following table lists all merge tags currently available in the Fulfillment On Hold template. 

Sample Code for Fulfillment On Hold Template

This sample shows how the merge tags could be used in the Fulfillment On Hold template.  

Merge Tag Description Example Preview Value

[Acctld]] Account ID ACME

[[AcctName]] Account Name MYORG

[ACTIVATION_DATE]] Activation Date Feb 28, 2007

[[ActivationID]] Activation ID 9e8f-8b6f-0fbf-4488-950b-
e4a5-1bfe-e73c

[[EntitlementID]] Entitlement ID bf1a-1191-4957-46aa-4f7f-fe

[[EXPIRATION_DATE]] Order Line - Last day that 
the object is effective 
(exclusive)

2/1/2003

[[FulfillmentCount]] Fulfillment Count < FulfillmentCount >

[[FulfillmentID]] Fulfillment ID < FulfillmentID >

[[LICENSE_MODEL_ATTRIBUTES]] License Model Attributes < LICENSE_MODEL_ATTRIBUTES >

[[LICENSE_MODEL_NAME]] License Model Name < LICENSE_MODEL_NAME >

[[LicenseTechnology]] License Technology FlexNet Licensing

[[OverdraftCount]] Overdraft Count < OverdraftCount >

[[PartnerTierName]] Partner Tier Name End Customer

[[PartNumber]] Part Number PartNumberOne

[[PRODUCT_NAME]] Product Name Test Product

[[PRODUCT_VERSION]] Product Version 7.6

[[ShipToAddress]] Ship To Address < ShipToAddress >

[[ShipToEmail]] Ship To Email < ShipToEmail >

[[START_DATE]] Start Date < START_DATE >
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License text has not been set for the following generated fulfillment. The administrator was 
notified. You will receive an email when the license is ready to download. <br/>
------------------------------------------------------------------------------<br/>
Fulfillment On Hold<br/>
------------------------------------------------------------------------------<br/>
FulfillmentID = <b>[[FulfillmentID]]</b><br />
Activation ID: [[ActivationID]]<br />
Entitlement ID: [[EntitlementID]]<br />
------------------------------------------------------------------------------<br/>
Sold to AccountName:  [[AcctName]]<br />      
Sold to AccountID:  [[AcctID]] <br/>
ChannelPartnerDetails: <br/>
[[PartnerTierName]]: <br /> 
------------------------------------------------------------------------------<br/>
ProductName:  [[PRODUCT_NAME]] <br/>       
ProductVersion: [[PRODUCT_VERSION]] <br/>
PartNumber: [[PartNumber]] <br/>
LicenseTechnology: [[LicenseTechnology]] <br/>
LicenseModel: [[LICENSE_MODEL_NAME]] <br/> 
------------------------------------------------------------------------------<br/>
LicenseModelAttributes: <br/>
[[LICENSE_MODEL_ATTRIBUTES]] <br/>
------------------------------------------------------------------------------<br/>
StartDate: [[START_DATE]] <br/>
ExpirationDate: [[EXPIRATION_DATE]] <br/>
FulfillmentDate: [[ACTIVATION_DATE]] <br/>
------------------------------------------------------------------------------<br/>
OverdraftCount :[[OverdraftCount]] <br/>
FulfillmentCount : [[FulfillmentCount]] <br/>
------------------------------------------------------------------------------<br/>

Sample Email Based on the Fulfillment On Hold Template

The code above would result in an email similar to the following:
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Figure 38: Example of an email with detailed fulfillment information, based on the Fulfillment On Hold 
template. 

Advanced Search for Entitlements Includes Custom License Models
(Case 02987224, SWM-25152)

On the List Entitlements page, the Advanced Search now allows users to filter entitlements by custom 
license models. This enhancement is available in both the Producer Portal and the End-User Portal.
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Figure 39: The Advanced Search window now includes custom license models when searching for 
entitlements.

SOAP and REST Web Services Enhancements in 2025.05
The following enhancement was added to the SOAP and REST Web Services module in the 2025.05 
release.

Zero Mapping of Activation IDs on Cloud Licensing Service Instances 
(SWM-25022) 

The 2025.05 release introduces version 7 of the ManageDevice SOAP web service. The new version 
contains a new operation, zeroCountAddonLineItems, which enables producers to explicitly set an 
activation ID with a zero allocation mapping on a Cloud Licensing Service (CLS) instance. 

This enhancement enables customers to clearly distinguish between activation IDs that are fully 
entitled for allocation (full count) and those that are restricted for allocation on the CLS.

Previously, when querying activation IDs via SOAP services like searchDevices, there was no easy way 
to identify activation IDs that were intentionally restricted from allocation. Such activation IDs simply 
did not appear, making it difficult for customers to differentiate between no mapping and full 
allocation from the master entitlement.

By explicitly creating a zero allocation mapping, producers can track and manage entitlement behavior 
accurately, improving license compliance and allocation control across their deployments.
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Notes for Using zeroCountAddonLineItems

• The configuration option Allow mapping zero counts to FlexNet Embedded devices (under System 
> Configure > FlexNet Operations > Embedded Device Settings) must be selected.

• Values submitted in the web request are not validated. As long as the request contains a valid 
device ID and line item details, the relevant mapping will be updated.

• No validation takes place. Whatever mapping line item customer provides is mapped to a 
particular device, regardless of e.g. whether the license model is supported. 

• Information related to calling the zeroCountAddonLineItems operation will be tracked and can be 
reviewed on the Search Transactions page in the Producer Portal (under System > Transaction 
History).

Example Request for zeroCountAddonLineItems

The sample code, below, shows a request to allocate zero counts from activation ID 83a2-9824-c72b-
488t-bbde-9bbb-fce3-1344 to the device with ID devicel_type.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
<soapenv:Header/>
<soapenv:Body>
<urn:zeroCountAddonLineItemsRequest>
<!-- 1 or more repetitions: -->
<urn:requestList>
<urn:deviceIdentifier>
<urn:deviceType>SERVER</urn:deviceType>
<!-- Optional: -->
<urn:deviceId>devicel_type</urn:deviceId>
<!-- Optional: -->
<urn:serverIds>
<!-- 1 or more repetitions -->
<urn:serverId>device1_type</urn:serverId>

</urn:serverIds>
<!-- Optional: -->
<urn:deviceIdType>ETHERNET</urn:deviceIdType>
<!-- Optional: -->
<urn:publisherName>FLEXERA</urn:publisherName>

</urn:deviceIdentifier>
<!-- 1 or more repetitions: -->
<urn:lineItem>
<urn:lineItemIdentifier>
<!-- Optional: -->
<urn:activationId>83a2-9824-c72b-488t-bbde-9bbb-fce3-1344</urn:activationId>
<!-- Optional: -->
<urn:count>0</urn:count>
<!-- Optional: -->

</urn:lineItemIdentifier>
</urn:lineItem>

</urn:requestList>
</urn:zeroCountAddonLineItemsRequest>

</soapenv:Body>
</soapenv:Envelope>
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Example Response for zeroCountAddonLineItems

The sample code, below, shows a response for a successful request.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
soapenv:Body
<zeroCountAddonLineItemsResponse xmlns="urn:v7.fne.webservices.operations.flexnet.com">
<statusInfo>
<status>SUCCESS</status>

</statusInfo>
<responseData>
<deviceIdentifier>
<deviceType>SERVER</deviceType>
<deviceId>device1_type</deviceId>
<serverIds>
<serverId>device1_type</serverId>

</serverIds>
<deviceIdType>ETHERNET</deviceIdType>
<publisherName>FLEXERA</publisherName>

</deviceIdentifier>
</responseData>

</zeroCountAddonLineItemsResponse>
</soapenv:Body>

</soapenv:Envelope>

User Experience Enhancements in 2025.05
The following user experience enhancement was added in the 2025.05 release.

• Additional Web Service Transactions Visible in Producer Portal

• Selecting Individual Line Items in Entitlement Notification Email

Additional Web Service Transactions Visible in Producer Portal
(SWM-24811, SWM-24812, SWM-24813, SWM-24817, SWM-24818) 

The 2025.04 release introduced a number of enhancements that increase transparency into 
transactions performed on a device—whether initiated via web services or in the Producer Portal or 
End-User Portal. Such transactions are displayed on the Search Transactions page in the Producer 
Portal (under System > Transaction History). 

In the 2025.05 release, the following additional webservice-based actions are now captured on the 
Search Transactions page: 

• Deleting line items from a device

• Obsoleting a host

• Removing add-on line items from a device

• Move device from one account to another

• Deleting a device
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Tracked Operations In 2025.05

Transactions are tracked for standalone devices, Cloud Licensing Service instances and local license 
servers. The following table lists the operations of the ManageDeviceService web service that are now 
tracked: 

For a use case example or information about how to view transaction details, see Improved 
Transaction Visibility in Producer Portal.

Selecting Individual Line Items in Entitlement Notification Email 
(Case 02971350, SWM-24682)

Transaction Web Service Operation Event Type Description

Transactions tracked from release 2025.05 onwards

Deleting a line item 
from a device

deleteAddOnLineItemsReq
uest

UPDATE Tracks transactions where an 
entitlement line item was deleted 
on a device. 

Obsoleting the 
host for a device 

obsoleteHostRequest DELETE Tracks transactions where a host 
for a device was deleted.

Removing add-on 
line items

decrementAddonLineItems
Request

UPDATE Tracks transactions where an add-
on line item was removed from a 
device. 

Moving a device to 
a different account

moveDeviceRequest UPDATE Tracks transactions where a device 
is moved to a different account. 

Deleting a device deleteDeviceRequest DELETE Tracks transactions where a device 
is deleted. 

Transactions tracked from release 2025.04 onwards

Creating a device createDeviceRequest CREATE Tracks all successful and failed 
attempts to create a device. 

Linking 
entitlement line 
items to a device

linkAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was linked to 
a device, or where a metered 
license was removed from a 
device. 

Incrementing 
entitlement line 
items to devices

IncrementAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was 
incremented on a device. 

Updating a device updateDevice UPDATE Tracks transactions where a device 
was updated.
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On the List Entitlement By Orders page, producers can now select individual line items to be included 
in the entitlement notification email, instead of including all line items in the email. This is useful in 
scenarios where only some of an entitlement’s line items have been added or updated. 

To include only certain line items from an entitlement, a producer needs to select the desired line 
items on the List Entitlement By Orders page and click the Email button, as shown in this screenshot:

The next screen will show the entitlement notification email, which only contains the selected line 
item. The notification email might look like this: 

Previously, if an entitlement contained more than one line item, the entitlement notification email 
would always include all of the entitlement’s line items.
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Features and Enhancements in 2025.04
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.04 
release:

• Entitlement Management Enhancements in 2025.04

• User Experience Enhancements in 2025.04

• SOAP and REST Web Services Enhancements in 2025.04

Entitlement Management Enhancements in 2025.04
The following enhancements to entitlement management were added in the 2025.04 release.

• Allow Renewal License to Start Upon Expiry of Parent License

• Grouping Product Information in Entitlements Email Template

• New “Features” Column on List Entitlements Page

Allow Renewal License to Start Upon Expiry of Parent License
(Case 02679546; SWM-21239) 

Currently, mapping a renewal license to a device can result in the parent license being unmapped, 
temporarily leaving the device without a license. 

This issue occurs when a renewal relation is set up between the parent and the child line items, and 
the renewed (child) line item has a future start date. When the renewed line is activated, it replaces the 
parent line mapped to the device. It is possible to create a renewal line item without linking to the 
parent line item; in this case there is no gap in license coverage. 

To address this issue, the 2025.04 release introduces a configuration which allows producers to 
change the behavior when mapping renewal licenses to devices. The new configuration called Retain 
mapping of the parent activation to the devices when mapping a child activation is available under 
System > Configure > Embedded Devices > Host Options. By default, the option is unselected, 
maintaining the behavior of previous releases.

When this option is selected, the parent license remains mapped to the device even when a child 
license (for a renewal, upgrade or upsell) is applied. This means that the parent license continues to be 
available after the child line item has been mapped. 

This enhancement allows producers to issue renewal licenses well before the parent license expires, 
and it enables customers to apply the renewal license early. This ensures uninterrupted license 
coverage throughout the device's activation lifecycle, preventing any interruptions.

There has been no change to the user experience. Activations are mapped as before: 

• Producer Portal—On the View Device or View Server page (under Devices > Devices, click a 
hyperlinked device name), click Licenses > Map Entitlements or Map by Activation IDs.

• SOAP web services—Using the the incrementAddonLineItems and linkAddonLineItems operations 
of the ManageDeviceService web service.
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Note • Producers are responsible for explicitly unmapping unused/expired activations.

Grouping Product Information in Entitlements Email Template 
(Cases 02749254, 02956269; SWM-21546)

This release introduces a new merge tag [[FOR-EACH tag="EntitledProductLine"]] for the 
Entitlement email template. This tag can be used to group all the products from a product line along 
with information about each product in the Entitlement email that customers will receive. 

Use of the new merge tag is controlled by the configuration option Allow grouping of product 
information based on product line in entitlement email template (under System > Configure > FlexNet 
Operations > General Options). By default, this option is disabled.

This enhancement gives producers more flexibility when structuring their entitlement emails. 
Depending on whether the configuration option is selected or unselected, the Entitlement email can 
either:

• iterate the product line and print product information, or

• iterate the product and print product line information. 

The following examples illustrate the different Entitlement emails that can be generated:

• Configuration Option Selected, Iterating Product Lines

• Configuration Option Unselected, Iterating Products

Configuration Option Selected, Iterating Product Lines  

The following example code shows how to use the merge tag [[FOR-EACH 
tag="EntitledProductLine"]] to iterate through product lines and then iterate the products for each 
product line, along with sample output.

[[FOR-EACH TAG="Entitlement" child-only="true"]]
[[FOR-EACH TAG="EntitlementLineItem"]]

[[IF TAG="LicenseGenerator" VALUE="demo"]]
[[FOR-EACH tag="EntitledProductLine"]]

Product Line - [[ProductLine]]
[[FOR-EACH tag="EntitledProduct"]]

Product Name: [[Name]]
Product Description: [[Description]]

[[END FOR-EACH]]
[[END FOR-EACH]]

Part Number: [[PartNumber]]
Permanent: [[Permanent]]
Start Date: [[StartDate]]
Expiry Date: [[ExpirationDate]]
ActivationID: [[ActivationID]]

[[END IF]]
[[END FOR-EACH]]

[[END FOR-EACH]]

A resulting Entitlement email might look like this:
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Figure 40: Entitlement email using the [[FOR-EACH tag="EntitledProductLine"]] merge tag

Configuration Option Unselected, Iterating Products

When the configuration option Allow grouping of product information based on product line in 
entitlement email template is unselected, the merge tag [[FOR-EACH tag="EntitledProduct"]] 
iterates through products and includes product line information. Below is some sample code and an 
example of a resulting Entitlement email.

[[FOR-EACH TAG="Entitlement" child-only="true"]]
[[FOR-EACH TAG="EntitlementLineItem"]]

[[IF TAG="LicenseGenerator" VALUE="demo"]]
[[FOR-EACH tag="EntitledProduct"]]

Product Name: [[Name]]
Product Description: [[Description]]
Product Line: [[ProductLine]]

[[END FOR-EACH]]
Part Number: [[PartNumber]]
Permanent: [[Permanent]]
Start Date: [[StartDate]]
Expiry Date: [[ExpirationDate]]
ActivationID: [[ActivationID]]

[[END IF]]
[[END FOR-EACH]]

[[END FOR-EACH]] 

A resulting Entitlement email might look like this:
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Figure 41: Entitlement email using the [[FOR-EACH tag="EntitledProduct"]] merge tag

New “Features” Column on List Entitlements Page 
(Case 02982636, SWM-25094)

In the Producer Portal and the End-User Portal, the List Entitlements page can display an additional 
Features column, which would show the name and the version of the feature that is associated with a 
product. If a product includes more than one feature, a more... link is displayed. Pointing to the link 
lists all features that are linked to the product. 

This enhancement makes it easier for producers and their customers who might be more familiar with 
feature names than product names to identify and manage the features associated with a product. 

Displaying the Features Column

This enhancement is disabled by default. Producers who would like the Features column to be 
displayed should send a request to Revenera support. Revenera strongly recommends that producers 
ensure that displaying the Features column does not interfere with the way they currently use the List 
Entitlements page.
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Figure 42: The List Entitlements page with the Features column displaying feature information in the 
Producer Portal 

Figure 43: The List Entitlements page with the Features column displaying feature information in the 
End-User Portal 

User Experience Enhancements in 2025.04
The following user experience enhancement was added in the 2025.04 release.

• New In-App Messaging Functionality

• Improved Transaction Visibility in Producer Portal
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• Updated Localizations of Field Labels on List Entitlements Page in End-User Portal

• Changes Around Security Question Now Localized

• New Endpoint for Displaying Date of Next Database Refresh

• Easier Login to Revenera Registry

New In-App Messaging Functionality
We are introducing a new capability in the FlexNet Operations Producer Portal, to help us modernize 
in-app messaging, streamline product on-boarding, and understand product usage. The main 
difference you should notice is improved messaging about FlexNet Operations maintenance, and new 
features being released.

However, the utility requires the use of optional cookies, and so upon logging into FlexNet Operations 
Producer Portal for the first time after this release, a pop-up will prompt your producer users to accept 
the cookie policy to enable the utility. (Until now, only essential cookies have been used in FlexNet 
Operations, which is why this is the first time we have introduced a cookie opt-out dialog. This dialog 
will only affect optional cookies for in-app messaging and product usage.)

 

Refer to the FAQs article if you have additional questions.

Note •  This change will not affect the End-User Portal.  

Improved Transaction Visibility in Producer Portal
(SWM-24573, SWM-24815, SWM-24816, SWM-24820) 

Producers can now view all transactions performed on a device—whether initiated via web services or 
in the Producer Portal or End-User Portal—on the Search Transactions page in the Producer Portal 
(under System > Transaction History). There are four exceptions to the webservice-based transactions 
reported: 

• Move device from one account to another

• Return device when it is no longer in use

• Any changes initiated using generateCapabilityResponse

• Any requests to generate a clone detection report

https://community.revenera.com/s/article/FlexNet-Operations-ALM-In-App-Messaging-FAQs
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These transactions will be added during the coming releases in Q2 this year.

Previously, only transactions performed through the Producer Portal or the End-User Portal interface 
were tracked in the Transaction History. 

This enhancement provides a comprehensive audit trail, enabling better tracking of past actions for 
compliance and troubleshooting purposes.

For more details, see the following sections:

• Tracked Operations

• Use Case Example

• Viewing Transaction Details

Tracked Operations

Transactions are tracked for standalone devices, Cloud Licensing Service instances and local license 
servers. The following table lists the operations of the ManageDeviceService web service that are now 
tracked: 

Use Case Example

Your company  provides industrial software licenses via FlexNet Operations. A customer complains 
that their software has stopped working. Your support team checks the Transaction History in the 
Producer Portal and sees that your customer’s own IT administrator mistakenly deactivated the 
license. Instead of escalating the issue, you can immediately guide them to reactivate their license, 
saving time and frustration.

Viewing Transaction Details

To view transaction details for a device, click System > Transaction History. On the Search Transaction 
History page, select the entity type Device, and enter any other search criteria. The Search 
Transactions: Results page displays a list of transactions. Click the View details link to see the details 
of a particular transaction. The details will look similar to this: 

Transaction Web Service Operation Event Type Description

Creating a device createDeviceRequest CREATE Tracks all successful and failed 
attempts to create a device. 

Linking 
entitlement line 
items to a device

linkAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was linked to 
a device, or where a metered 
license was removed from a 
device. 

Incrementing 
entitlement line 
items to devices

IncrementAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was 
incremented on a device. 

Updating a device updateDevice UPDATE Tracks transactions where a device 
was updated.
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Figure 44: The Transaction Details page showing updates made to a device

Updated Localizations of Field Labels on List Entitlements Page in End-User 
Portal
(SWM-22971) 

In the End-User Portal, on the List Entitlements page, two of the labels in the Search drop-down menu 
had been changed in the 2024.10 release to more meaningful names as well as to match the 
equivalent labels used in the Producer Portal (see User Experience Enhancements in 2024.10). The 
new labels are Sold-to Account Name and Sold-To Account ID.

To provide the same enhanced user experience for users of the localized interface of FlexNet 
Operations, the translations of these two labels have now been updated.

The following screenshot shows the List Entitlements page in the End-User Portal: 

https://docs.revenera.com/fno2024/rn/Content/helplibrary/User_Experience_Enhancements_in_2024_10.htm
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Figure 45: The Sold-to Account Name and Sold-to Account ID fields on the List Entitlements page in 
the End-User Portal now have more meaningful translations.

Changes Around Security Question Now Localized 
(SWM-25768) 

In the 2025.03 release, the dialog for the security question was updated for existing users who had 
selected “Where were you when you first heard about 9/11?” as their security question (see Removed 
Security Question). The warning text that was added in 2025.03 has now been translated and will 
appear in the localized versions of the End-User Portal. 

Figure 46: This screenshot shows the (English) text that has been localized in the 2025.04 release.

New Endpoint for Displaying Date of Next Database Refresh 
(Case 02912896, SWM-23482) 

https://docs.revenera.com/fno_CURRENT/rn/Content/helplibrary/User_Experience_Enhancements_in_2025_03.htm
https://docs.revenera.com/fno_CURRENT/rn/Content/helplibrary/User_Experience_Enhancements_in_2025_03.htm
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For Production Copy Service (PCS) environments, a new REST endpoint 
/flexnet/operations/rest/pcsRefreshDate has been introduced. When called, it returns the next 
production copy refresh date. The refresh date could be displayed in a banner like this: 

Figure 47: An example of a banner displaying the PCS refresh date.

Knowing the database refresh date can provide guidance when the PCS environment is used as a 
staging instance before deploying changes to the production environment. 

Easier Login to Revenera Registry
(SWM-20249)

An end customer wanting to pull a container image must first log into the registry. However, this 
presumes that the customer already knows the registry URL, which is not always the case. 

To make this process easier for customers, on the Downloads page, the End-User Portal now contains 
a new button, Container Registry login, which will copy the Docker login command with the 
appropriate tenant URL to the clipboard. Customers can then easily paste the command into the 
Docker command-line interface to log into the registry.



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  117

 

Figure 48: The Downloads page of the End-User Portal with the new Container Registry login button.

SOAP and REST Web Services Enhancements in 2025.04
The following enhancement was added to the SOAP and REST Web Services module in the 2025.04 
release.

New Entitlement Management REST API
This release introduces the beta version of the first REST API in a series of new APIs aimed at 
simplifying integration with low-code platforms and improving overall performance. The first API, for 
creating a simple entitlement, is designed to streamline the process of creating entitlements in 
FlexNet Operations through an easy-to-use RESTful interface, making it ideal for low-code users. The 
new APIs are also optimized for performance, ensuring faster response times and improved scalability.

To authenticate requests to the Entitlement Management API, users must provide an authentication 
token, which can be obtained using the REST web service access-token-controller or using the 
Manage Access Tokens page in the Producer Portal.

For details about the new REST API, see the section RESTful Services for Entitlement Management in 
the Web Services Integration Guide.

Features and Enhancements in 2025.03
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.03 
release:

• Entitlement Management Enhancements in 2025.03

• User Experience Enhancements in 2025.03

Entitlement Management Enhancements in 2025.03
The following enhancements to entitlement management were added in the 2025.03 release.

https://docs.revenera.com/fno_CURRENT/webservicesintegration/Content/helplibrary/EntMgmtAPIIntro.htm
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• Inactive Line Items Can Now Be Changed to Draft to Allow Editing

• Warning Message When Activating Licenses for Upgrade Line Items

• Confirmation Message Displayed After Merging Entitlements

• Visibility of Product Lines Created by Other Producer Users

• Changing the Prefix for Trial Activation IDs

Inactive Line Items Can Now Be Changed to Draft to Allow Editing
(Case 02552542, SWM-25355) 

The 2025.03 release now allows producers to change the state of line items from Inactive to Draft. 
Previously, to edit an inactive line item, its status had to be changed to Deployed. This enhancement 
means that producers can edit or re-use previously inactive line items, without the need to deploy 
these line items first. 

Example: A producer wants to update the part number for a certain product. The products are already 
associated with entitlements, some of which are inactive. The producer can now change a line item’s 
status from Inactive to Draft, which then makes the line item editable. The producer can update the 
part number and then change the status back to Inactive.

The following screenshots show the Line Items section, where a line item has its status changed to 
Inactive, and the Customers to Licenses page with the subsequent success message.

Figure 49: Changing the line item status from Inactive to Draft in the Line Items section of the Entitle 
Customers to Licenses page
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Figure 50: The Entitle Customers to Licenses page shows a confirmation message after changing the 
line item’s status.

Warning Message When Activating Licenses for Upgrade Line Items
(Case 02733304, SWM-19396) 

In FlexNet Operations, when a base line item is associated with an upgrade line item, and the upgrade 
line item is activated, the quantity is consumed on the parent line. Returning the upgrade line item will 
not free up the count on the base line item. This is to prevent license leakage. 

However, customers who are not aware of this behavior might be frustrated. Imagine the following 
scenario: a customer upgrades to a new product version and activates the upgraded version. For some 
reason, the upgraded version of the product does not live up to their expections. When the customer 
tries to return the upgraded line item, in the hope of being able to use the previous product, they find 
that this is no longer possible. They now have no choice but continue using the upgrade that they do 
not like. 

To help users make conscious decisions when upgrading, FlexNet Operations now includes a new 
configuration option Display warning message when activating upgrade line item linked to parent line 
item (under System > Configure > FlexNet Operations > General Options). The option controls the 
behavior of the Producer Portal and the End-User Portal: 

• When the configuration option is selected, and a user tries to activate an upgrade line item that is 
linked to the parent line item (by navigating to the List Entitlements page, selecting an 
entitlement and clicking Activate), the following warning is displayed: 

“If you activate the selected upgrade line item, you will no longer be able to activate previous 
versions of that line item. Are you sure you want to activate the upgrade line item?“

This message makes it clear to the user that they cannot revert back to the previous version after 
the upgrade.

• When the configuration option is unselected, and a user tries to activate an upgrade line item that 
is linked to the parent line item, no warning message is displayed. The Generate Licenses page 
opens for activating the license. (This is the current behaviour.)
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Figure 51: Example of the warning message in the End-User Portal

Confirmation Message Displayed After Merging Entitlements
(Case 02974495, SWM-24762) 

Previously, when a user initiated a merge operation by selecting the assets to be merged and clicking 
Complete on the List Entitlements By Order | Merge Entitlements page, the Producer Portal redirected 
the user to the List Entitlements By Order page which then listed the merged assets. This behavior was 
confusing, because the user had no immediate way of knowing whether the merge was successful.

To improve the user experience, the List Entitlements By Order | Merge Entitlements page now 
displays a confirmation message which indicates whether the merge was successful. In the event of 
an error, a meaningful error message is displayed. 

The following screenshot shows the List Entitlements By Order | Merge Entitlements page with a 
confirmation message for a successful merge operation: 



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  121

Figure 52: The confirmation message after a merge on the List Entitlements By Order | Merge 
Entitlements page

After the merge, users can navigate away from the page using the options in the top navigation bar. 

This enhancement applies to operations for merging entitlements and fulfillments and for merging 
users. 

Visibility of Product Lines Created by Other Producer Users
(Case 02774078, 02848224; SWM-20402)

In previous FlexNet Operations releases, a producer user could only access the product lines they 
created. However, this could create issues when system administrators left and new staff had to take 
over their responsibility for product lines. Product lines that were created by the previous 
administrator were not visible to the new administrators, making product line management very 
difficult. 

The 2025.03 therefore introduces a new configuration option Enable visibility of all product lines for 
system administrators (under System > Configure > FlexNet Operations > General Options). If 
enabled, the Product Lines section on the Create a User and Create an Account pages in the Producer 
Portal displays all product lines, including those created by other producer users. The Link product 
lines button in that section, which was previously limited to product lines created by the logged-in 
user, now allows linking of product lines created by other producer users. 

By default, the Enable visibility of all product lines for system administrators option is disabled.

Note that the configuration option Enable Product Lines for Products, Users, and Accounts (also under 
System > Configure > FlexNet Operations > General Options) must be selected for the new 
configuration option Enable visibility of all product lines for system administrators to be effective.



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  122

Figure 53: When Enable Product Lines for Products, Users, and Accounts is selected, the Product 
Lines section on the Create a User page (pictured) and the Create an Account page displays all product 
lines, including those created by other producer users.  

Figure 54: Clicking Link product lines in the Product Lines section on the Create a User page and the 
Create an Account page displays the Select Product Lines for the User window, where producer users 
can link or remove a product line, including those product lines created by other producer users. 
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Changing the Prefix for Trial Activation IDs
(Case 02461881, SWM-21200)

The 2025.03 release allows producers to customize the short string that is used as a prefix for trial 
activation IDs. 

Previously, customization was not allowed. When a trial entitlement was created, its activation ID had 
the fixed prefix “Act”, which was a limitation when the entitlement needed to match or validate old or 
existing licenses and made trial conversions or renewals difficult. A configurable prefix gives 
producers the flexibility to match the activation IDs in these various phases.

Producers wanting to change the prefix can do so in the configuration option Custom pre-fix string 
from Trial License Activation ID (under System > Configure > FlexNet Operations > General Options). 

User Experience Enhancements in 2025.03
The following user experience enhancement was added in the 2025.03 release.

Removed Security Question
(Case 02954443, SWM-24008) 

When users set or change their password for the Producer Portal or the End-User Portal, they need to 
select a security question as an additional authentication factor. In previous releases, the list of 
security questions included the question “Where were you when you first heard about 9/11?”. In the 
2025.03 release, inclusion of this question has changed because it could be distressing for some 
users:

• New users and users who did not use 9/11 as a security question will no longer see the question 
“Where were you when you first heard about 9/11?” when they are setting their password and 
security question. 

• Existing users who had already selected “Where were you when you first heard about 9/11?” as 
their security question are not forced to select a different security question. Instead, they will see 
a warning message, “This security question is deprecated and is recommended to be changed.” 
This approach gives existing users time to select a new security question. Once they selected a 
different security question, the message is no longer displayed.

The following screenshot shows the screen presented to existing users: 
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Figure 55: Existing users are informed that the 9/11 security question is deprecated.

These changes apply to the Producer Portal and End-User Portal.

Features and Enhancements in 2025.02
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.02 
release:

• Data Analytics Enhancements in 2025.02

• Entitlement Management Enhancements in 2025.02

• SOAP and REST Web Services Enhancements in 2025.02

Data Analytics Enhancements in 2025.02
The following enhancement was made to the Analytics functionality in 2025.02.

New Report to Analyze Denied Access Requests
The License Server Usage report (under Analytics > License Server Usage) has been expanded to 
include a new chart, called Denials Distribution, covering denials data. To reflect this new capability, 
the License Server Usage report has been renamed to License Server Usage and Denials. 

The License Server Usage and Denials report analyzes the denials made by a Cloud Licensing Service 
(CLS) instance, Dynamic Monetization instance or a local license server and provides insights into 
causes and patterns where requests to access licensed software were rejected. The report reveals 
details about:

• Denial reasons—Reasons are grouped by the denial status code, along with the percentage 
distribution per denial code. Identifying the most common reasons for denials—such as, for 
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example, insufficient feature counts or elastic tokens, expired features, features not available due 
to rule rejection—allows producers and their customer to take corrective action.

• Denial patterns—Discover which accounts are experiencing the highest number of denials. This 
information helps producers uncover key accounts that might not be sufficiently provisioned with 
licenses to meet their day-to-day operational requirements.

• Denial trends—Patterns in denied requests can help producers forecast future demand for certain 
features, products, or license types. This insight supports better resource allocation, product 
development, and infrastructure planning to meet anticipated growth.

Clicking the Denials Distribution chart opens a new page which shows the Denials Distribution pie 
chart, the Denials by Account bar chart, and the Denials Summary table (described below).

Note • For usage data from a local license server to be available in the Data Warehouse, the following 
policy settings must be configured:

• usageService.sync.enabled—Must be set to true.

• usageService.sync.url—Must point to the usage service URL, which is

https://<siteId>.compliance.flexnetoperations.com/usage/api/1.0/sync

where <siteId> is replaced with the specific site ID supplied by Revenera, for example: 

https://flex1234.compliance.flexnetoperations.com/usage/api/1.0/sync 

• licensing.trackDeniedRequests—Must be set to true if the usage data should also include denied 
request information. To disable tracking of denied requests, licensing.trackDeniedRequests set to 
false. 

For more information, see the topic “Pushing Usage Data to the Data Warehouse” in the FlexNet 
Embedded License Server Producer Guide (available from the Product and License Center). 

Denials Distribution Pie Chart

The Denials Distribution pie chart visualizes the different types of denials along with their percentage 
distribution, providing insights into denial patterns. Hover over a pie slice to see the following 
information:

• Denial status code and description

• Absolute number of denials

• Percentage of denials

You can filter the pie chart using the using the widget filter at the top, to focus on specific denial status 
codes, accounts, or other criteria.

https://flexerasoftware.flexnetoperations.com/
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Figure 56: Example of a Denials Distribution pie chart

Denials by Account Bar Chart

The Denials by Account bar chart shows the denials segmented by account, offering valuable insights 
into the key accounts that should be prioritized for revenue generation opportunities.

Figure 57: Example of a Denials by Account bar chart



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  127

Denials Summary Table

The Denials Summary table offers detailed insights into denials, showing data such as users/clients, 
features and timestamp, enabling data-driven conversations with customers.

Insights Gained From the Denials Distribution Report

The following example illustrates how producers might benefit from the insights provided by the 
Denials Distribution report.

Let’s assume that your Software as a Service (SaaS) company offers subscription-based software 
licenses, but users frequently face license checkout denials when trying to access the software. You 
generate a Denials Distribution report to analyze the issue. The screenshot below shows the findings 
of the report:
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The report lists the most common denial reasons, which enables you to take action and turn the 
denials into upsell or cross-sell opportunities. This in turn also reduces the impact on your customer 
support team.

Table 7 • Example Findings of a Denials Distribution report

Denial Reason
Denial 
Rate (%) Insights Opportunity

Insufficient feature 
count available 

Insuffient elastic tokens 
available (Dynamic 
Monetization) 

45% The main reason for 
denials is that 
demand exceeds the 
current subscription 
plan.

Upselling additional licenses:

Sales, the Renewals team or 
Customer Sucess Managers can 
leverage the report’s insights to 
discuss upgrading the subscription 
plan, introduce dynamic license 
allocation or on-demand scaling with 
the customer.

Feature expired

No valid active line 
items (Dynamic 
Monetization)

25% Loss of revenue due 
to missed renewals.

Increase renewal opportunities: 

Engage the Renewals team to lead 
data-driven conversation with the 
customer. 

Send proactive renewal reminders, set 
up automated renewal reminders, or 
enable auto-renewal.

Feature unavailable

Item not found in any 
effective rate table 
(Dynamic Monetization)

15% User attempting to 
access a premium 
product not included 
as part of the 
current subscription 
plan.

The Sales or Renewals team can 
leverage this opportunity for cross-
selling or upselling.
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Entitlement Management Enhancements in 2025.02
The following enhancements to entitlement management were added in the 2025.02 release.

• Error Message When Activating Obsolete/Inactive Line Items

• Overhaul of the “Show Line Items with Zero Copies by Default” Configuration Option

Error Message When Activating Obsolete/Inactive Line Items
(Case 02954549, SWM-23892) 

Previously, attempting to activate an obsolete or inactive line item on a device using a FlexNet 
Embedded toolkit failed as expected, but no error message was displayed. This lack of error messages 
while activating obsolete or inactive line items made it difficult for producers to notice and resolve 
errors in a timely manner. 

From the 2025.02 release onwards, attempting to activate an obsolete or inactive line item will result 
in an error being displayed. For example, the response might include a status like this:

Status=("Activation ID not permitted": 5f4d-123e-a456-7894-b123-66f4-88h7-56f3)

This screenshot shows a sample response: 

Feature unavailable, 
checkout filter rejection

Feature unavailable, 
rule rejection

10% Users unable to 
activate software 
due to rules of 
access or feature 
selectors.

Opportunity to upsell additional 
licenses:

The denials might indicate additional 
demand for a feature.

Customer Sucess Managers could 
share this report with the enterprise 
license administrator to enable them 
to:

• Identify users/clients unable to 
activate software due to certain 
restrictions, but who require 
access to features.

• Adjust feature selectors and rules 
of access to allocate licenses to 
users/client/departments that 
derive the most value from the 
software. 

Table 7 • Example Findings of a Denials Distribution report

Denial Reason
Denial 
Rate (%) Insights Opportunity
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This enhancement enables producers to identify the cause of the error and take corrective action, if 
required.

Overhaul of the “Show Line Items with Zero Copies by Default” 
Configuration Option
(Case 02876825, SWM-24336)

In previous releases, the configuration option Show Line Items with Zero Copies by Default (under 
System > Configure > FlexNet Operations > General Options) did not work as expected. It has now 
undergone an overhaul to fix functional issues and broaden its scope:

• In previous releases, even if the configuration option was disabled, the List Entitlements in the 
End-User Portal page erroneously displayed line items with zero copies remaining. This has now 
been resolved.

• The previous description of the configuration was misleading, because it referred to the page 
names “Activatable Items” and “Entitlements” that do not exist in the End-User Portal. The 
wording has now been corrected to refer to the “List Entitlements” page.

• The scope of the configuration option has been broadened. Whereas previously it controlled only 
which entitlements would be displayed on the List Entitlements page in the End-User Portal, it 
now also controls which entitlements are displayed on the List Entitlements page of the Producer 
Portal. To reflect this, the description has been changed as follows: “Select to show line items 
with zero copies by default in the List Entitlements page in the Producer Portal and End-User 
Portal.”

This enhancement gives producers and their end-users greater control over the content displayed 
on the List Entitlements pages.

How the option affects which line items are displayed in 2025.02 

When Show Line Items with Zero Copies by Default is selected, the Producer Portal and the End-User 
Portal show line items with zero copies remaining on their List Entitlements pages. The List 
Entitlements page is available in the Producer Portal under Entitlements > List Entitlements and in the 
End-User Portal under Activation & Entitlements > List Entitlements. 

When Show Line Items with Zero Copies by Default is unselected (the default), line items with zero 
copies are hidden on the List Entitlements pages.

Note • A known issue exists; see SWM-24042: Input Sanitization Disabled.
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SOAP and REST Web Services Enhancements in 2025.02
The following enhancements were added to the SOAP and REST Web Services module in the 2025.02 
release.

• Returning Fulfillment and License Information for Non-Embedded Technologies Using Web 
Services

• New Operation for Getting Host Count in License Service SOAP Web Service

Returning Fulfillment and License Information for Non-Embedded 
Technologies Using Web Services
(Case 02370066, SWM-22714) 

In the Producer Portal, producers can list fulfillment or license information for non-embedded 
licensing technology (such as FlexNet Publisher) for specific hostids on the Support Licenses and 
Maintenance page (under Licenses > Hosts). The following screenshot shows the Support Licenses 
and Maintenance page along with the search options:

To provide the same functionality using web services, the 2025.02 release now introduces version 2 of 
the LicenseService SOAP web service. This enhancement enables producers to do the following:

• Collect all hostids to provide a list of current hostids for new activations

• Collect all active fulfillments for a dedicated server in preparation to create "emergency" licenses 
for that server

• Collect fulfillment and license information in preparation to rehost a server

Implementation of getHostQuery

Version 2 of the LicenseService SOAP web service includes the new operation getHostQuery. The 
following XML fragment illustrates a getHostQuery message:

<operation name="getHostQuery">
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<input message="tns:getHostQueryRequest"/>
<output message="tns:getHostQueryResponse"/>

</operation>

The operation getHostQuery extracts the same information as that available on the Support Licenses 
and Maintenance page: Host ID, Sold To, Account, License Technology, and Host Type. In addition, 
producers can filter for hosts that have active or inactive fulfillments.

Tip • For pagination, producers can use the getHostCount operation to determine the number of hosts 
and specify that number in the batchSize parameter (see New Operation for Getting Host Count in 
License Service SOAP Web Service).

The following snippet shows sample XML code: 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v2.webservices.operations.flexnet.com">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:getHostQueryRequest>
         <!--Optional:-->
         <urn:queryParams>
            <!--Optional:-->
            <urn:hostId>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:hostId>
            <!--Optional:-->
            <urn:soldTo>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:soldTo>
            <!--Optional:-->
            <urn:licenseTechnology>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:licenseTechnology>
            <!--Optional:-->
            <urn:hostType>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:hostType>
            <!--Optional:-->
            <urn:account>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:account>
            <!--Optional:-->
            <urn:fulfillmentState>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:fulfillmentState>
         </urn:queryParams>
         <urn:pageNumber>?</urn:pageNumber>
         <urn:batchSize>?</urn:batchSize>
      </urn:getHostQueryRequest>



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  133

   </soapenv:Body>
</soapenv:Envelope>

For detailed information about the changes made to the LicenseFulfillmentService.wsdl and the 
.xsd files that it references, see the Change Log for 2025.02.

New Operation for Getting Host Count in License Service SOAP Web Service 
(Related to Case 02370066, SWM-25245) 

Along with the getHostQuery operation (see Returning Fulfillment and License Information for Non-
Embedded Technologies Using Web Services), version 2 of the LicenseService SOAP web service also 
introduces the getHostCount operation. getHostCount returns the number of hosts that match 
specified criteria. 

This operation is equivalent to displaying the number of hosts that fit certain criteria by filtering hosts 
using the Search for option in the Producer Portal in the Support Licenses and Maintenance page:

Implementation of getHostCount

The following XML fragment illustrates a getHostCount message:

<operation name="getHostCount">
<input message="tns:getHostCountRequest"/>
<output message="tns:getHostCountResponse"/>

</operation>

The operation getHostCount returns the number of hosts that fit specified criteria. The following 
search criteria are available: Host ID, Sold To, Account, License Technology, and Host Type. 
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Tip • The returned number can be used as the batch size input for getHostQuery (see Returning 
Fulfillment and License Information for Non-Embedded Technologies Using Web Services).

The following snippet shows sample XML code: 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v2.webservices.operations.flexnet.com">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:getHostCountRequest>
         <!--Optional:-->
         <urn:queryParams>
            <!--Optional:-->
            <urn:hostId>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:hostId>
            <!--Optional:-->
            <urn:soldTo>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:soldTo>
            <!--Optional:-->
            <urn:licenseTechnology>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:licenseTechnology>
            <!--Optional:-->
            <urn:hostType>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:hostType>
            <!--Optional:-->
            <urn:account>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:account>
            <!--Optional:-->
            <urn:fulfillmentState>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:fulfillmentState>
         </urn:queryParams>
      </urn:getHostCountRequest>
   </soapenv:Body>
</soapenv:Envelope>

For detailed information about the changes made to the LicenseFulfillmentService.wsdl and the 
.xsd files that it references, see the Change Log for 2025.02.
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Features and Enhancements in 2025.01
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.01 
release:

• Entitlement Management Enhancements in 2025.01

• User Experience Enhancements in 2025.01 

• Device Management Enhancements in 2025.01

• Dynamic Monetization Enhancements in 2025.01

Entitlement Management Enhancements in 2025.01
The following enhancement to entitlement management was added in the 2025.01 release.

Instance ID Merge Tag Now Available in Entitlement Email Template
(Case 02875263, SWM-21918) 

Previously, the merge tag [[DEFAULT_GLS_INSTANCE_ID]] (available in the Entitlement email template)  
could only be included above the email text, but not in the email within LicenseModel or 
EntitlementLineItem tags. 

In the 2025.01 release, the merge tag [[DEFAULT_GLS_INSTANCE_ID]] can be nested inside the 
LicenseModel or EntitlementLineItem tag, and producers can now insert the Cloud Licensing Service 
(CLS) instance ID into the table in an Entitlement email. (This allows an Entitlement email, for example, 
to contain a table with rows for each line item, and to specify the CLS ID in the rows related to the CLS.)

The following sample shows how the merge tag [[DEFAULT_GLS_INSTANCE_ID]] is nested inside the 
EntitlementLineItem tag:

[[FOR-EACH TAG="EntitlementLineItem"]]
[[DEFAULT_GLS_INSTANCE_ID]]

[[END FOR-EACH]]

User Experience Enhancements in 2025.01
The following user experience enhancement was added in the 2025.01 release.

New Configuration Hides Menu Options for Making Entities Obsolete 
(Case 02902521, SWM-22852) 

In FlexNet Operations, the status "Obsolete" is typically used to remove entities (for example, products, 
features, feature bundles, devices, suites, and license models) from use permanently. This status 
helps distinguish outdated or superseded entities from those currently in use, without completely 
deleting them from the system.

However, producers need to use great care when setting an entity’s status to Obsolete, because the 
status Obsolete is permanent and cannot be reverted. The 2025.01 release therefore introduces the 
configuration option Allow state change of entities to obsolete (under System > Configure > FlexNet 



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  136

Operations > General Options), which enables producers to hide the Obsolete or Make Obsolete menu 
options in the Producer Portal. Specifically, when the option is unselected, the Obsolete or Make 
Obsolete menu options are no longer displayed in the following locations in the Producer Portal:

• Entitlements > List Entitlements By Order > Change State menu

• Entitlements > Create  > Line Items and Maintenance Line Items tabs > Change State menu

• Devices > Devices > clicking the hyperlinked device name opens the Device or View Server page > 
Edit menu

• Products > Products > Change State menu

• Products > Features > Change State menu

• Products > Feature Bundles > Change State menu

• Products > Suites > Change State menu

• Administer > License Models >  Change State menu

Unselecting Allow state change of entities to obsolete prevents users from—accidentally or 
intentionally—changing the state of products, features, feature bundles, devices, suites, license 
models, and similar entities, to Obsolete using the user interface. However, entities can still have their 
status changed to Obsolete using an API web service call.

By default, Allow state change of entities to obsolete is selected.

Note • Operations that involve changing an entity’s state to Obsolete as part of a transfer or upgrade 
process are not impacted.

Device Management Enhancements in 2025.01
The following enhancement to device management was added in the 2025.01 release:

Reassigning Returned Standalone Devices
(Case 01948947, SWM-20276) 

This release includes an enhancement for returned standalone devices.

Returning a device is intended for devices that no longer receive capability responses or license files, 
or servers that no longer serve devices or communicate with the FlexNet Operations back office. 
Previously, returning a device was an irreversible action. When a device was returned, it was 
permanently disassociated from its account. 

The 2025.01 release introduces the ability to reassign returned standalone devices to an account and 
reactivate such devices. This enables producers to take returned standalone devices back into service.

Reassigning a Device Using the Producer Portal 

Producers can reassign a returned device to an account using the menu item Reassign Account from 
the Edit menu on the Device page. (To access the Device page for a returned device, click Devices > 
Devices  > click a hyperlinked device name.) 
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Note • Returned devices have a status of Returned and are by default not listed on the Devices page 
(under Devices > Devices) even when searched. To display returned devices on the Devices page, 
select the option Inactive in the filter above the devices list.

The following screenshot shows the new menu item Reassign Account on the Device page:

Clicking Reassign Account opens the Assign account page, where you can select a new account for 
the device. 
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After a standalone device has been reassigned to an account, the device status is changed to Active. 
The device can now have entitlements mapped to it. 

Reassigning a Standalone Device Using Web Services

Returned standalone devices can also be reassigned using the updateDevice operation of the 
ManageDeviceService web service. 

The following code snippet illustrates how to use the updateDevice operation:

<urn:updateDeviceRequest>
<urn:device>
<urn:deviceIdentifier>
<urn:deviceType>CLIENT</urn:deviceType>
<!-- Note: This is the device to be updated, currently in RETURNED state -->
<urn:deviceId>Test123</urn:deviceId>
<urn:deviceIdType>STRING</urn:deviceIdType>
<urn:publisherName>fnepublisher</urn:publisherName>

</urn:deviceIdentifier>
<urn:updateChannelPartners>
<urn:channelPartners>
<urn:channelPartner>
<!-- Note: Only END CUSTOMER is supported as per existing functionality-->
<urn:tierName>bo.constants.partnertiernames.endcustomer</urn:tierName>
<!-- Note: This is the account to which the device is to be reassigned -->
<urn:accountUnit>
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<urn:primaryKeys>
<urn:name>MyAccount</urn:name>

</urn:primaryKeys>
</urn:accountUnit>

</urn:channelPartner>
</urn:channelPartners>
<!-- Note: Only REPLACE is supported as per existing functionality-->
<urn:opType>REPLACE</urn:opType>

</urn:updateChannelPartners>
</urn:device>

</urn:updateDeviceRequest>  

There have been no changes to any of the .wsdl or .xsd files for SOAP services.

Reassigning a Standalone Device Using the End-User Portal 

To use a returned standalone device in the End-User Portal, the device must first be reassigned to an 
account using the Producer Portal. Once it has been assigned to an account, an end user can claim the 
device in the End-User Portal by clicking Devices > Claim and Activate.

Note • The Claim and Activate option only appears in the Devices menu of the End-User Portal for 
users with roles specifically granted the End-User Portal permissions Claim Device and Activate and 
Generate Licenses.

Dynamic Monetization Enhancements in 2025.01
The following enhancement for Dynamic Monetization was added in the 2025.01 release.

Allowing Overdrafts in Elastic Access
(SWM-23936)

When end customers run out of Elastic Access tokens before the expiration of a line item, producers 
may want to allow them to continue using capabilities and to consume tokens until a new purchase of 
tokens can be arranged. To enable end customers to consume tokens beyond their entitled count, 
Elastic Access now allows an overdraft limit to be provided on line items. The recorded usage data 
provides a basis for subsequent billing.

In the Producer Portal, Elastic Access license models can be set up using a new overdraft attribute. 
Producers can specify the overdraft using one of the following settings:

• Not used

• Unlimited

• Specify # now

• Specify % now

• Specify % at entitlement time

The default setting is Not used, and a zero overdraft limit will be enforced if this setting is chosen.
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When an overdraft is set, line items using this license model will be configured with the value, allowing 
end customers to consume tokens from the line item up to the overdraft limit above the entitled 
quantity.

If Unlimited is selected, then an “infinite” overdraft limit is used, and end customers can consume 
tokens without constraint. 

In the Producer Portal, producers set the overdraft for Elastic Access license models on the Package 
Products - License Models | Create A License Model page (under Administer > License Models > 
Create new license model), as shown here: 

Producers who use a back office other than FlexNet Operations can set the overdraft directly in the 
/line-items API, using the attributes parameter and the overdraftLimit and overdraftType 
properties. 

To allow an unlimited overdraft, set overdraftType to Unlimited. 
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To allow a limited overdraft, set  overdraftType to Number and set overdraftLimit to the number of 
tokens that can be consumed from the line item above the entitled quantity. 

The following snippet shows a sample request for a limited overdraft:

{
"activationId": "string",
"state": "string",
"quantity": 1,
"start": 0,
"end": 0,
"attributes": {

"elastic": false,
"rateTableSeries": "",
"overdraftLimit": 100,
"overdraftType": "Number"

}
}

For details about this API, see the Dynamic Monetization API documentation, topic Map a line item to 
an instance (https://fnoapi-dynamicmonetization.redoc.ly/#operation/addActivation).

The overdraft details are recorded in the Usage Metrics table in the Snowflake Data Warehouse (field 
OVERDRAFT_COUNT) and can also be returned using the Data Access API (field overdraftCount). For 
more information, see the Data Access API and Data Share Entity Relationship Details.

System Requirements
Detailed system requirements for FlexNet Operations include the following.

Requirement Description

Web browsers • Microsoft Edge 

• Mozilla Firefox 75.0 

• Google Chrome 80.0.3987.163 

FlexNet licensing module • FlexNet Publisher Toolkit 11.12.0 or later 

• FlexNet Embedded Toolkit 2015 R2 or later 

Note • FlexNet Operations supports these FlexNet Embedded 
host ID types: ETHERNET, INTERNET, INTERNET_6, FLEXID9, 
FLEXID10, STRING, USER, VM_UUID, EXTENDED, 
PUBLISHER_DEFINED, and CONTAINER_ID.

https://fnoapi-dynamicmonetization.redoc.ly/#operation/addActivation
https://fnoapi-dynamicmonetization.redoc.ly/#operation/addActivation
https://fnoapi-dynamicmonetization.redoc.ly/#operation/addActivation
https://docs.revenera.com/fno_CURRENT/fnoapi-da/fnoapi_dataaccess_reportfields.htm
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Resolved Issues
The following sections describe the issues that have been resolved in the FlexNet Operations 2025 
releases to date:

• Issues Resolved in 2025.12

• Issues Resolved in 2025.11

• Issues Resolved in 2025.10

• Issues Resolved in 2025.09

• Issues Resolved in 2025.08

• Issues Resolved in 2025.07

• Issues Resolved in 2025.06

• Issues Resolved in 2025.05

• Issues Resolved in 2025.04

• Issues Resolved in 2025.03

• Issues Resolved in 2025.02

• Issues Resolved in 2025.01

Issues Resolved in 2025.12
Issues in the following areas were resolved in the FlexNet Operations 2025.12 release:

Vendor certificate generator The current versions of the VCG kit are 12.11.0 and 16.2.2.0. 

These VCGs were tested with the following compilers: 

• Windows—Visual Studio 2010 Professional Edition 

• Linux—gcc 4.1.2 (RHEL 5.0) 

• Linux—gcc 4.4.4 (RHEL 6.0) 

Note • The 12.11.0 VCG is built with FlexNet Publisher 11.11.1 
and shares the same minimum C compiler requirements on each 
supported platform. (See the FlexNet Publisher 11.11.1 release 
notes for C/C++ compiler support.) 

High Speed File Upload If you intend to use the High Speed Upload option to upload files, 
the following plug-in is required:

Aspera Connect 3.10.0 or later

Requirement Description
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• Device Management Issues Resolved in 2025.12

• Entitlement Management Issues Resolved in 2025.12

• User Experience Issues Resolved in 2025.12

Device Management Issues Resolved in 2025.12
The following issue involving the management of devices was resolved in the 2025.12 release.

Email Notifications for Obsolete Inactive Devices Job Alert 
(Case 03032649, SWM-29520) 

Previously, users subscribed to the alert for the Obsolete Inactive Devices job did not receive email 
notifications after the job was executed because no email template was associated with the alert. 

This issue has been fixed by adding a new template that sends notifications to subscribed users when 
the job runs. The email now includes details such as the inactivity date and the number of devices that 
were obsoleted.

The following screenshot shows an example of an email based on the new template:

Note • The alert templates do not appear on the Templates page and cannot be modified by users.

Entitlement Management Issues Resolved in 2025.12
The following issue was resolved for entitlement management in the 2025.12 release.

• Preventing Deployment of Inactive Line Items When Entitlement Is Inactive

• Fixed Incorrect Date Display on Active Clients Tab
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Preventing Deployment of Inactive Line Items When Entitlement Is Inactive
(SWM-29442)

Previously, the system allowed inactive line items to be deployed even when their associated 
entitlement was inactive. This behavior could lead to inconsistencies by permitting deployments that 
should not occur.

The issue has been fixed. The system now prevents deployment of an inactive line item if its 
entitlement status is inactive. When such an attempt is made, an error message is displayed:

“Cannot deploy line item <activation id>. The parent entitlement <entitlement id> is not deployed.”

Figure 58: Screenshot showing the error message when attempting to deploy a line item whose 
entitlement status is inactive (Draft).

Fixed Incorrect Date Display on Active Clients Tab
(SWM-30473)
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Previously, on the Cloud License Server Details page, the Active Clients tab displayed incorrect date 
values. The Expiry Date column showed the start date, and the Start Date column showed the expiry 
date. 

Figure 59: Example of the reversed dates on the Active Clients tab.

This issue did not affect the dates in the line item itself, as shown by this screenshot for the same 
entitlement line item:

Figure 60: The actual line item dates were correct.
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This issue no longer occurs in the 2025.12 release. 

User Experience Issues Resolved in 2025.12
The following issue related to user experience was addressed in the 2025.12 release.

Localized Error Messages for Japanese Locale in End-User Portal
(SWM-30267)

Previosly, when users selected the “Japanese” locale from the login page dropdown in the End-User 
Portal, error messages displayed during the Forgot Password workflow were shown in English instead 
of Japanese. This occurred in the following cases:

• When the user provided a wrong answer to the secret question.

• When the user clicked the Submit button without entering a user ID.

This issue has been fixed, and error messages now display in Japanese, as shown in the following 
screenshots:

• Incorrect secret question answer

• No user ID entered
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Issues Resolved in 2025.11
Issues in the following areas were resolved in the FlexNet Operations 2025.11 release:

• Account and User Management Issues Resolved in 2025.11

• Device Management Issues Resolved in 2025.11

• Entitlement Management Issues Resolved in 2025.11

• Security Issues Resolved in 2025.11

• SOAP and REST Web Services Issues Resolved in 2025.11

• User Experience Issues Resolved in 2025.11

Account and User Management Issues Resolved in 2025.11
The following issue involving the management of accounts and users was resolved in the 2025.11 
release.

• Improved User Sync Between ALM, ESD, and Harbor

• Role Details Page in End-User Portal Now Loads Without Error

Improved User Sync Between ALM, ESD, and Harbor 
(SWM-30159)

In the 2025.02 release, we optimized the syncing process between FlexNet Operations ALM and the 
Electronic Software Delivery (ESD) module to improve performance (see Increased Download Speed in 
End-User Portal). However, this change introduced an issue where newly created users in ALM were 
not syncing correctly to ESD. For customers using Registry Service, this also prevented these users 
from syncing to Harbor, blocking access to images and charts.
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As a temporary workaround, resaving the user triggered an update event that resolved the issue.

In the 2025.11 release, this problem has been fixed. Newly created Customer and Producer users in 
ALM now sync properly to ESD and Harbor.

Role Details Page in End-User Portal Now Loads Without Error
(SWM-29535)

Previously, clicking on any role link within the Edit Account or Edit User pages in the End-User Portal 
triggered an error message, preventing users from accessing role-specific information.

Figure 61: Clicking a role (highlighted in red) resulted in an error message.

This issue has now been resolved. Clicking a role link correctly opens the Role Details page, which 
displays the permissions associated with that role.
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Figure 62: In 2025.11, clicking a role now opens the Role Details page.

This enhancement improves usability by allowing customers to easily view and understand the 
permissions tied to their roles, supporting better transparency and role management.

Device Management Issues Resolved in 2025.11
The following issue involving the management of devices was resolved in the 2025.11 release.

Fixed Label on Named License Pools Tab for Cloud License Server
(FNE-23801) 

Previously, on the newly introduced Named License Pools tab (on the Cloud License Server Details 
page), the Existing License Pools subtab displayed the feature name next to the pool ID instead of the 
expected license pool name. This mislabeling has been fixed in the 2025.11 release: 
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Figure 63: The list on the Existing License Pools subtab now correctly shows the license pool names.

Entitlement Management Issues Resolved in 2025.11
The following issue was resolved for entitlement management in the 2025.11 release.

• Resolved Bulk Upgrade Failures with Custom License Generators

• Corrected Display of Account Name in Email Templates

Resolved Bulk Upgrade Failures with Custom License Generators
(Case 03036320, SWM-26777)

Bulk upgrade operations no longer fail when a custom license generator is used to generate the 
upgraded licenses.

Corrected Display of Account Name in Email Templates
(Case 04171893, SWM-29538)

The [[Name]] merge tag in some email templates was previously resolving to a value from the License 
Model custom attribute instead of the intended Account Name. While previews showed the correct 
value, the final email output showed an incorrect value.

The following templates were affected: 

• License Template

• Multiple Licenses Template

• Consolided License

• Multiple Consolided Licenses
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This issue has been fixed. The [[Name]] tag now correctly resolves to the Account Name in all relevant 
templates.

Security Issues Resolved in 2025.11
The following issues related to FlexNet Operations security were addressed in the 2025.11 release.

• Refined Access Control for Agreement Transactions

• Enforced Permission Checks for License Pages in Producer Portal

• JWT Signature Verification for apiCookie Requests

Refined Access Control for Agreement Transactions 
(SWM-30096)

The 2025.09 release addressed an access control vulnerability, where low-privilege users could 
access transaction details for agreements beyond their permission scope (see Resolved Access 
Control Vulnerability for Agreements). Essentially, permissions to view, update, download and search 
transaction details were restricted to high-privilege users. However, this approach inadvertently 
limited basic visibility for users with lower privileges. 

To address this, the 2025.11 release introduces a refined access control model:

• Download and Update operations remain restricted to high-privilege users.

• View and Search operations are now permitted for low-privilege users, enabling them to locate 
and inspect transactions they are authorised to access, without compromising data security.

This change ensures that only high-privilege users can modify or extract transaction data, while still 
allowing basic visibility for low-privilege users. The update aligns with best practices for role-based 
access control and enhances usability without sacrificing security.

Enforced Permission Checks for License Pages in Producer Portal 
(SWM-29912)

This release resolves a vulnerability in the Producer Portal, where low-privilege users could access 
restricted license-related pages via direct URLs.

Prior to this fix, users without access to certain pages available from the Licenses menu could bypass 
UI restrictions and access the following pages directly by navigating to the corresponding URL:

UI Path and Page Header URL

Licenses > Support Licenses and 
Maintenance

{ENVIRONMENT 
URL}/flexnet/operations/supportLicenses_VIEW.do

Batch Rehost > Support Licenses and 
Maintenance | Batch Rehost - Select 
Customer Account and Hosts 

{ENVIRONMENT 
URL}/flexnet/operations/batchRehostSelectSourceHo
st_START.do



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  152

This behaviour allowed unauthorised users to perform actions reserved for higher-privilege roles. 

Figure 64: Low-privileged users could access the highlighted menu items via direct URLs. 

To prevent unauthorised access, permission checks have now been enforced for each of the above 

pages. The required permissions are as follows:

Transfer Licenses > Support Licenses 
and Maintenance | Transfer Licenses 

{ENVIRONMENT 
URL}/flexnet/operations/transferLicensesSelectSou
rceAndTargetHost_START.do

Host Transfer Jobs > Host Transfer 
Jobs

{ENVIRONMENT 
URL}/flexnet/operations/transferHostJob_simpleSea
rch.action

Manual Activation > Manual Activation {ENVIRONMENT 
URL}/flexnet/operations/manualActivation_VIEW.do

UI Path and Page Header Required Permissions

Licenses > Support Licenses and 
Maintenance

View Licenses

Batch Rehost > Support Licenses and 
Maintenance | Batch Rehost - Select 
Customer Account and Hosts 

View Licenses and Rehost Licenses

Transfer Licenses > Support Licenses 
and Maintenance | Transfer Licenses 

View Licenses and Rehost Licenses

UI Path and Page Header URL
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This update ensures that only users with the appropriate role-based permissions can access and 
perform actions on these pages, thereby aligning with best practices for secure access control.

JWT Signature Verification for apiCookie Requests
(SWM-29861)

Previously, requests containing apiCookie were not validated for JWT (JSON Web Token) signature 
integrity. This posed a potential security risk by allowing tokens with invalid signatures to be 
processed.

Starting with the 2025.11 release, JWT signature verification can be enforced for all apiCookie 
requests. Any request with an invalid JWT—such as a tampered or malformed signature—will result in 
a 401 Unauthorized response and redirect the user to the No Access page:

This change enhances security by ensuring only valid tokens are accepted, preventing unauthorized 
access and improving the security of the application.

Note • JWT signature verification is disabled by default. Customers who wish to enable this feature 
should contact Support.

SOAP and REST Web Services Issues Resolved in 2025.11
The following issue related to FlexNet Operations Web Services was addressed in the 2025.11 release.

Host Transfer Jobs > Host Transfer 
Jobs

View Licenses

Manual Activation > Manual Activation View Licenses and Manual Activation

UI Path and Page Header Required Permissions
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• EntitlementOrderService No Longer Returning Error for accountUnitName Query

• Case Sensitivity in DownloadPackagingService Authentication

EntitlementOrderService No Longer Returning Error for accountUnitName 
Query 
(Case 03955183, SWM-29389)

In the 2025.10 release, a regression was identified in certain EntitlementOrderService operations 
(versions 1 through 7) where using the accountUnitName query parameter with the EQUALS operator 
could incorrectly trigger error 21073—“Count of Account names exceeded the limit of 10”—if the 
specified account name contained a space.

The following operations were impacted: 

• getActivatableItemCount

• getActivatableItemsQuery

• getEntitlementLineItemPropertiesQuery

This issue has been resolved in the 2025.11 release.

To address the regression, versions 8 and 9 of EntitlementOrderService now use the newly 
introduced accountUnitNameList parameter, which accepts multiple account names. Customers can 
provide multiple account unit names using repeated <urn:value>?</urn:value> elements.

Example for Using accountUnitNameList

The following example code shows how to pass multiple account names.

<soapenv:Body>
<urn:searchEntitlementLineItemPropertiesRequest>

<urn:queryParams>
<urn:accountUnitNameList>

<!--1 or more repetitions:-->
<urn:value>Road Runner Corporation</urn:value>
<urn:value>Acme Corporation</urn:value>
<urn:value>Wily Inc.</urn:value>

</urn:accountUnitNameList>
</urn:queryParams>

...
</soapenv:Body>

For detailed information about the changes made to the EntitlementOrderService.wsdl and the .xsd 
files that it references, see the Change Log for 2025.11.

Guidelines for Using accountUnitName and accountUnitNameList in 2025.11

• In versions 1 through 9, use the accountUnitName parameter for operations that require only a 
single account name. Account names may include spaces. 

• In versions 8 and 9, use the accountUnitNameList parameter for operations that require multiple 
account names, for example, getEntitlementLineItemPropertiesQuery. Account names may 
include spaces. 
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Note • By default, you can pass up to ten account names, or as defined by the configuration option 
Maximum number of Account names accepted to search for Entitlement Line Item Properties.

Case Sensitivity in DownloadPackagingService Authentication 
(Cases 03047680, 04214918; SWM-27781)

The DownloadPackagingService previously failed to authenticate users when the username contained 
uppercase letters, due to case-sensitive handling of credentials. This issue has now been resolved by 
updating the authentication logic to treat usernames in a case-insensitive manner, ensuring 
consistent and successful authentication regardless of letter casing.

User Experience Issues Resolved in 2025.11
The following issue related to user experience was addressed in the 2025.11 release.

Error Messages in End-User Portal’s “Forgot Password” Workflow Now 
Correctly Localized
(SWM-26451)

Previously, error messages displayed during the End-User Portal's "Forgot Password" workflow were 
not correctly localized. Even when users selected a non-English language from the login page 
dropdown, error messages continued to appear in English.

The screenshot below illustrates the issue, showing an English error message displayed despite 
“German” being selected as locale:

Unlocalized error messages were displayed in the following scenarios:

• Entering an incorrect answer to the secret question.
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• Leaving the User ID field blank.

• Providing an invalid user ID.

In the 2025.11 release, the login session now correctly applies the user’s selected locale. All error 
messages within the "Forgot Password" flow are properly localized according to the chosen language 
on the login page.

Note • The following related known issue remains that are being tracked separately: SWM-26453: 
Secret Question on Forgot Password Page Not Localized..

Issues Resolved in 2025.10
Issues in the following areas were resolved in the FlexNet Operations 2025.10 release:

• Account and User Management Issues Resolved in 2025.10

• Security Issues Resolved in 2025.10

Account and User Management Issues Resolved in 2025.10
The following issue involving the management of accounts and users was resolved in the 2025.10 
release.

Expanded Permissions for Merging Entitlements
(Case 03042145, SWM-26989)

In earlier releases, only users with the View and Manage Users permission could reassign users to 
other accounts. Users with only the View and Manage Customer Users permission were restricted, as 
the relevant Users checkbox on the List Entitlements by Order | Merge Entitlements page (under 
Entitlements > Merge) was disabled.
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Figure 65: The Merge Entitlements page showing the active Users checkbox, available to users with 
the View and Manage Customer Users or View and Manage Users permission.

This restriction has been lifted in the 2025.10 release. Users who hold either the View and Manage 
Customer Users permission or the View and Manage Users permission—or both—can now reassign 
users to other accounts.

Security Issues Resolved in 2025.10
The following issues related to FlexNet Operations security were addressed in the 2025.10 release.

• Secure Access to Swagger Documentation

• Phone Number Validation on Edit Profile Page

• Special Character Validation for Accounts & Users in End-User Portal

Secure Access to Swagger Documentation
(SWM-28832)

As of the 2025.10 release, direct access to the Swagger documentation hosted at 
https://<siteID>.flexnetoperations.com/flexnet/swagger-ui.html is no longer permitted without 
authentication. Users attempting to access this page are now redirected to the FlexNet Operations 
login screen. Upon successful login, the Swagger interface is displayed. No additional permissions are 
required.

This change ensures that sensitive endpoints—such as token controllers—are only visible to 
authenticated FlexNet Operations users, strengthening platform security and protecting critical API 
resources.

Phone Number Validation on Edit Profile Page
(SWM-28833)
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Previously, users could enter malformed or otherwise invalid values into the Phone field when editing 
their profile; such as non-numeric characters, incorrectly short or long numbers, or missing required 
digits. 

The 2025.10 release introduces validation for the Phone field on the Edit Profile page (available by 
opening the User menu and clicking My Profile). The field now enforces acceptable phone-number 
formats, rejects inputs with invalid characters or incorrect length, and normalizes input where 
appropriate.

Figure 66: User input in the fields Phone and Country is validated.

Validation Rules and Handling of Failed Validation

The following validation rules apply to the Phone field:

• Allowed characters: digits (0-9), hyphens (-), plus signs (+), and spaces.

• Examples: +91 9123456789, 07123 456789, +1-555-867-5309

• If a user attempts to save a profile with a phone number containing invalid characters, this error 
message will appear: 

“Phone number must contain only digits and allowed symbols.”

Additionally, the phone number must correspond to the country selected in the Country dropdown:

• If the phone number does not match the selected country’s format or numbering plan, the 
following error message is displayed:
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“Invalid phone number for the selected country.”

• Example: The phone number 07123 456789 with the country set to United States will be flagged as 
invalid for the selected country.

Special Character Validation for Accounts & Users in End-User Portal 
(SWM-28834)

To improve data integrity and prevent malformed input, the 2025.10 release introduces validation for 
special characters in the input fields for all submenus under Accounts & Users in the End-User Portal. 
Fields now reject entries containing disallowed characters such as :<>{}@;=\,!/|?"#$%~^'`.

If a user attempts to enter invalid characters—for example, in the First Name field—they will receive 
the following error message:

“The field [First Name] contains the following illegal characters: :<>{}@;=,!/|?"#$%~^`'. Remove 
these characters before saving.”

No validation is currently applied to fields where special characters are typically expected, such as 
Description, Address 1 and Address 2. Special character checks for these fields will be introduced in a 
future release.

This update helps ensure consistent and clean data entry across key user and account fields.

Issues Resolved in 2025.09
Issues in the following areas were resolved in the FlexNet Operations 2025.09 release:

• Security Issues Resolved in 2025.09

• SOAP and REST Web Services Issues Resolved in 2025.09

• User Experience Issues Resolved in 2025.09

Security Issues Resolved in 2025.09
The following issues related to FlexNet Operations security were addressed in the 2025.09 release.

• HTML Injection Vulnerability Mitigation for FlexNet Operations Portals

• Resolved Access Control Vulnerability for Agreements

HTML Injection Vulnerability Mitigation for FlexNet Operations Portals
(SWM-28029, SWM-28051, SWM-28025)

FlexNet Operations was found to be vulnerable to HTML injection across several input fields in both the 
End-User Portal and the Producer Portal. The affected areas included:

• Fields in the End-User Portal on the Create Account and Edit Account pages:

• Account ID

• Account Name
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• Fields in the Producer Portal on the Create Server Host Type page and Edit Server Host Type 
pages:

• Server Host Type Name

• Description

• Name

• Fields in the Producer Portal on the Entitle Customers to Licenses page:

• Description

• Ship-to email

• Ship-to mail

These fields previously allowed injection of unauthorized HTML content, posing significant security 
risks. To mitigate these vulnerabilities, input sanitization and validation mechanisms have been 
implemented. The affected fields now properly handle and neutralize any malicious HTML content. If a 
user attempts to inject HTML, they will receive an “HTML tags not allowed” error message, as shown in 
the following screenshots:

Figure 67: Error message when attempting to use HTML in the input fields of the Edit Account page.
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Figure 68: Error message when attempting to use HTML in the input fields of the Create Server Host 
Type page.
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Figure 69: Error message when attempting to use HTML in the input fields of the Entitle Customers To 
Licenses | Create An Entitlement page.

Note • These changes do not affect existing fields that already contain HTML tags. 

Resolved Access Control Vulnerability for Agreements 
(SWM-28053)

This release addresses a previously identified broken access control vulnerability that allowed low-
privilege users to access transaction details for agreements they were not authorized to view (under 
Products > List Agreements).

Low-privilege users can no longer view, download, or access transaction details for agreements 
outside their permission scope.

SOAP and REST Web Services Issues Resolved in 2025.09
The following issue related to FlexNet Operations Web Services was addressed in the 2025.09 release.

upgradeLicenseRequest Now Correctly Establishes Upgrade Relationship 
Between Entitlement Line Items 
(Case 02760756, SWM-16718)

Previously, the upgradeLicense operation of the EntitlementOrderService SOAP web service (all 
versions) failed to create an upgrade relationship between entitlement line items. When submitting an 
UpgradeLicenseRequest to create an upgrade line item for a product configured with an Embedded 
Counted license model, the request returned a NullPointerException.

This issue has been resolved. The upgradeLicense operation now correctly establishes the upgrade 
relationship between line items when the upgrade path is defined between products. 
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User Experience Issues Resolved in 2025.09
The following issue related to user experience was addressed in the 2025.09 release.

Multilingual Input in Email Templates
(Case 03031323, SWM-26966)

In previous releases, email templates did not support multilingual input—such as Japanese, Chinese, 
or Korean—in the Html Content and Text Content fields. As a result, templates containing these 
characters were saved with corrupted content, typically displayed as '?????'.

Figure 70: Example of Chinese characters not rendered correctly.

The 2025.09 release introduces full support for multilingual character encoding in both fields during 
template creation. Email content will now render correctly in the user's preferred language, based on 
their locale settings.

Issues Resolved in 2025.08
Issues in the following areas were resolved in the FlexNet Operations 2025.08 release:

• Account and User Management Issues Resolved in 2025.08

• Entitlement Management Issues Resolved in 2025.08

• Security Issues Resolved in 2025.08

Account and User Management Issues Resolved in 2025.08
The following issue involving the management of accounts and users was resolved in the 2025.08 
release.
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New Permission for Managing Part Numbers
(SWM-27450)

Prior to the 2025.08 release, users with the View Products, Suites, and Maintenance permission could 
still perform Create, Update, and Delete operations on part numbers.

To support more granular access control, the 2025.08 release updates the existing Create Part 
Numbers permission—renaming it to Manage Part Numbers and expanding its scope. This revised 
permission now explicitly governs the ability to add, modify, or delete part numbers.

Roles that previously included the Create Part Numbers permission have been automatically updated 
to include Manage Part Numbers, ensuring continuity of access for affected users.

Only users assigned a role that includes Manage Part Numbers can perform these operations. Users 
that do not have the Manage Part Numbers permission will no longer have access to part number 
management actions.

Entitlement Management Issues Resolved in 2025.08
The following issue was resolved for entitlement management in the 2025.08 release.

Upgrade Activation Warning Extended to Activation ID Logins 
(Case 02733304, SWM-27200)

The 2025.03 release introduced a new configuration option Display warning message when activating 
upgrade line item linked to parent line item (under System > Configure > FlexNet Operations > 
General Options). The option controls whether the Producer Portal and the End-User Portal displays a 
warning message to alert users that activating a certain upgrade line item means that they can no 
longer activate previous versions of that line item. For details, see Warning Message When Activating 
Licenses for Upgrade Line Items.  

However, the changes made in 2025.03 meant that the warning message (if configured) would only be 
displayed in cases where the user logs into the End-User Portal using their user name or entitlement 
ID. The warning was not displayed when a user logged in using an activation ID and then proceeded to 
activate an upgrade line item by navigating to the List Entitlements page, selecting an entitlement and 
clicking Activate.

The 2025.08 release now addresses this gap. If Display warning message when activating upgrade 
line item linked to parent line item is selected, and a user tries to activate an upgrade line item that is 
linked to the parent line item, the following warning is displayed:

“If you activate the selected upgrade line item, you will no longer be able to activate previous 
versions of that line item. Are you sure you want to activate the upgrade line item?“

This warning will be displayed irrespective of whether the user logged into the End-User Portal using a 
user name, entitlement ID, or activation ID.

Security Issues Resolved in 2025.08
The following issues related to FlexNet Operations security were addressed in the 2025.08 release.

• HTML Injection Vulnerability Mitigation Across FlexNet Operations
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• Access Restriction on Email Templates Module

HTML Injection Vulnerability Mitigation Across FlexNet Operations 
(SWM-28050, SWM-28027)

FlexNet Operations was found to be vulnerable to HTML injection across multiple areas, posing 
potential security risks in user input fields. These vulnerabilities could have allowed unauthorized 
HTML content to be injected, potentially leading to cross-site scripting (XSS) attacks.

Affected Areas and Input Fields 

• Device Creation (Devices > Create Device) 

Affected input fields:

• Name

• ID

• Site Name

• Notes

• Update Creation (Products > Updates > Create)

Affected input fields:

• Name

• Update ID

• Description

Mitigation and Improvements

To mitigate HTML injection vulnerabilities, input sanitization and validation mechanisms have been put 
in place. These enhancements ensure that affected fields now properly detect and neutralize malicious 
HTML content. As a result, the application's security posture is strengthened, effectively preventing 
cross-site scripting (XSS) attacks and promoting safe handling of user-supplied data. 

Any attempt to include HTML tags in restricted fields now triggers specific error messages to prevent 
misuse and guide users, as shown in the following screenshots:

• Device Creation:
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Figure 71: Error message when attempting to use HTML in the input fields of the Create Device 
page.

• Update Creation:

Figure 72: Error message when attempting to use HTML in the input fields of the Update page.

Note • These changes do not affect existing fields that already contain HTML tags. 
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Access Restriction on Email Templates Module
(SWM-28022)

Previously, low-privilege users were able to access the Email Templates module through force 
browsing, bypassing intended access controls.

With this release, access control has been enforced. Low-privilege users can no longer access the 
Email Templates module, even via force browsing attempts.

If a low-privilege user attempts to access the module through force browsing, they will now be 
presented with a "No Access" error message on the FlexNet Operations UI:

Figure 73: Error message when a low-privilege user attempts to access the Email Templates module.

Issues Resolved in 2025.07
Issues in the following areas were resolved in the FlexNet Operations 2025.07 release:

• Entitlement Management Issues Resolved in 2025.07

• License Management Issues Resolved in 2025.07

• Security Issues Resolved in 2025.07

• SOAP and REST Web Services Issues Resolved in 2025.07

• User Experience Issues Resolved in 2025.07

Entitlement Management Issues Resolved in 2025.07
The following issue was resolved for entitlement management in the 2025.07 release.

• Faster Attribute Search

• Correct Line Item Selection in Entitlement Notification Emails

Faster Attribute Search
(SWM-27365)
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Previously, performing advanced searches on custom entitlement attributes, custom attributes, and 
custom line item attributes resulted in slow response times on the List Entitlements by Order and List 
Entitlements pages.

In the 2025.07 release, the underlying queries have been optimized, significantly improving response 
times for these advanced searches. Users can now expect faster and more efficient retrieval of 
entitlement data when using custom attribute filters.

Correct Line Item Selection in Entitlement Notification Emails
(Case 03047793, SWM-27343)

In the 2025.05 release, an enhancement was introduced to allow producers to select individual line 
items on the List Entitlement By Orders page for inclusion in entitlement notification emails, rather 
than including all line items in the notification email by default. 

Previously, this functionality did not work as intended: while the email preview displayed only the 
selected line items, the actual email sent to customers included all line items, ignoring the applied 
filters.

This issue has now been fixed. The system correctly sends entitlement notification emails containing 
only the line items selected by the producer.

License Management Issues Resolved in 2025.07
The following issue involving license management has been resolved in the 2025.07 release.

Filtering By Predefined Host Type
(SWM-25288)

In earlier versions, searches on the Support Licenses and Maintenance | Hosts page (under Licenses > 
Hosts) using predefined host types—such as Server, Nodelocked, Custom, and Trusted—did not return 
any results, even though searches using custom host type names functioned correctly.

As of release 2025.07, this issue has been resolved. Searches using predefined host types now return 
the expected host records, ensuring consistent and reliable search behavior across all host type 
categories.
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Security Issues Resolved in 2025.07
The following issue related to FlexNet Operations security was addressed in the 2025.07 release.

Encoding of Special Characters in Role Names and Descriptions 
(Case 02889178, SWM-22286)

To enhance security and prevent potential vulnerabilities, role names and descriptions that include 
specific special characters are now encoded before being stored in the database. These values are 
automatically decoded when displayed to users.

If a role name or description contains any of the special characters listed in the following table, it will 
be encoded using hexadecimal format during storage. Upon retrieval, the encoded values are decoded 
to ensure proper display in the user interface.

Character Name

! Exclamation mark

“ Quotation mark (double quote)

# Number sign (hash or pound)

$ Dollar sign

% Percent sign

& Ampersand

' Apostrophe (single quote)

( Left parenthesis
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This change applies to existing roles as well as newly created roles.

) Right parenthesis

* Asterisk

+ Plus sign

, Comma

- Hyphen (minus sign)

. Period (dot)

/ Slash (forward slash)

: Colon

; Semicolon

< Less-than sign

= Equals sign

> Greater-than sign

? Question mark

@ At sign

[ Left square bracket

] Right square bracket

^ Caret

_ Underscore

` Grave accent

{ Left curly brace

| Vertical bar (pipe)

} Right curly brace

~ Tilde

Character Name



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  171

Note • Role names containing any of the special characters listed in the table will be stored in an 
encoded format in the Reporter database.

Updating Users with Existing Roles with Special Characters

When an existing role name contains special characters, calling the updateUser operation of the 
UserAcctHierarchy SOAP web service will return the error "Invalid Role Name". 

As a workaround, save the role name using the Roles page in the Producer Portal. This ensures that 
the role name is converted to encoded format in the database. Once the role has been saved, calling 
updateUser will no longer return an error. 

This issue does not occur when managing roles via the Producer Portal.

Adding or Editing Roles

Role names and descriptions are entered in the Producer Portal on the Add Role page (available by 
clicking Accounts & Users > All Roles > Add), as shown in this screenshot:

Figure 74: The Add Role page with the Name and Description fields. 

To edit a role, click Accounts & Users > All Roles to open the Roles page. Then click a role name, make 
your edits and save. 

SOAP and REST Web Services Issues Resolved in 2025.07
The following issues related to FlexNet Operations Web Services were addressed in the 2025.07 
release.

• updateEntitlementLineItem Web Service Now Supporting Upsells and Renewals

• Improved Error Message For Country Code Validation in createUser API

updateEntitlementLineItem Web Service Now Supporting Upsells and 
Renewals
(SWM-22395)
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The updateEntitlementLineItem method of the EntitlementOrderService web service has been 
enhanced to support Upsell and Renewal operations through the lineItemType field. 

This enhancement improves automation capabilities for producers managing complex product 
relationships. 

Previously, attempts to set an upsell or renewal relationship between entitlement line items using the 
updateEntitlementLineItem operation were unsuccessful. Although the operation returned a SUCCESS 
response, the line item type remained unchanged (e.g., stayed in NEW state).

To address this, the updateEntitlementLineItem method has been enhanced to support Upsell and 
Renewal values for the lineItemType field. When there are multiple entitlement line items, the 
updateEntitlementLineItem method can be used to establish Upsell and Renewal relationships 
between two valid line items.

The enhancement affects the EntitlementOrderService web service version 7 and above.

The following section shows sample code for updateEntitlementLineItem.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v8.webservices.operations.flexnet.com">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:updateEntitlementLineItemRequest>
         <!--1 or more repetitions:-->
         <urn:lineItemData>
            <urn:entitlementIdentifier>
               <urn:primaryKeys>
                  <urn:entitlementId>Ent_150</urn:entitlementId>
               </urn:primaryKeys>
            </urn:entitlementIdentifier>
            <!--Zero or more repetitions:-->
            <urn:lineItemData>
               <urn:lineItemIdentifier>
                  <urn:primaryKeys>
                     <urn:activationId>c3a8-da3d-ba22-4014-a7ac-2e18-55cf-
289d</urn:activationId>
                  </urn:primaryKeys>
               </urn:lineItemIdentifier>
               <urn:product>
                  <urn:primaryKeys>
                     <urn:name>p00002</urn:name>
                     <urn:version>1.0</urn:version>
                  </urn:primaryKeys>
               </urn:product>
               <urn:licenseModel>
                  <urn:primaryKeys>
                     <urn:name>akFloatingCounted</urn:name>
                  </urn:primaryKeys>
               </urn:licenseModel>
               <urn:parentLineItem>
                  <urn:primaryKeys>
                     <urn:activationId>ffbd-b450-176f-4570-a7b6-d260-4b63-
0166</urn:activationId>
                  </urn:primaryKeys>
                  <!--Optional:-->
                  <urn:lineItemType>UPSELL</urn:lineItemType>
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               </urn:parentLineItem>
               </urn:lineItemData>
            <urn:autoDeploy>false</urn:autoDeploy>
         </urn:lineItemData>
      </urn:updateEntitlementLineItemRequest>
   </soapenv:Body>
</soapenv:Envelope>

If valid values for an existing lineItem are provided as parentLineItem, and the lineItemType is set to 
UPSELL, a new upsell relationship will be created between the lineItemIdentifier and the 
parentLineItem.

Similarly, if valid values for an existing lineItem are provided as parentLineItem, and the lineItemType 
is set to RENEWAL, a new renewal relationship will be created between the lineItemIdentifier and the 
parentLineItem.

Improved Error Message For Country Code Validation in createUser API
(SWM-27390) 

In the 2025.06 release, the createUser API of the UserAcctHierarchyService web service was 
enhanced to validate the provided two-letter country code (see Country Code Validation in createUser 
API). 

In the 2025.07 release, the error message that is returned when the createUser or updateUser API 
fails due to an invalid country code has been updated. The previous message has been replaced with 
the following clearer and more descriptive version:

Invalid country code format. Enter a valid two-letter country code based on the ISO 
3166-1 Alpha-2 code standard, such as "US" or "CA".

User Experience Issues Resolved in 2025.07
The following issue related to user experience was addressed in the 2025.06 release.

• Country Name “Türkiye” No Longer Contains Invalid Characters

• Performance Improvements of Bulk Upgrade Operations

• Bulk Upgrade Jobs with Auto-Fulfill No Longer Failing

Country Name “Türkiye” No Longer Contains Invalid Characters
(Cases 03039999, 03048568; SWM-27007)

Previously, the country name “Türkiye” was not displayed correctly and appeared as “TÃ¼rkiye”. This 
occurred in the following cases: 

• When creating a user or account in the Producer Portal

• When creating a user or a sub-account in the End-User Portal
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Figure 75: Screenshot showing the Create A User page in the Producer Portal, where the country 
name “Türkiye” is now displayed correctly.

Performance Improvements of Bulk Upgrade Operations
(Case 03048145, SWM-27660)

In earlier releases, bulk upgrade operations processing large data volumes could encounter failures 
and timeouts due to a missing filter.

In the 2025.07 release, the missing filter has been added, significantly improving the reliability and 
performance of bulk operations.

Bulk Upgrade Jobs with Auto-Fulfill No Longer Failing
(Case 03036671, SWM-26914)

Bulk operation jobs with auto-fulfill for FlexNet Embedded are no longer failing.

Issues Resolved in 2025.06
Issues in the following areas were resolved in the FlexNet Operations 2025.06 release:

• SOAP and REST Web Services Issues Resolved in 2025.06

• User Experience Issues Resolved in 2025.06

SOAP and REST Web Services Issues Resolved in 2025.06
The following issue related to FlexNet Operations Web Services was addressed in the 2025.06 release.
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• Country Code Validation in createUser API

• updateProduct API Call No Longer Fails to Update Product Fields

Country Code Validation in createUser API
(SWM-26045) 

Starting with the 2025.06 release, the createUser API of the UserAcctHierarchyService web service 
now validates the provided two-letter country code (if a code country is specified). If the country code 
is invalid, the request fails and the API returns an error. The validation is performed in all versions of 
the UserAcctHierarchyService web service. 

Specifying a country code is optional. If provided, the country codes must follow the two-letter format 
based on the ISO 3166-1 Alpha-2 standard. If no country code is provided, the user will be created 
with the default country code “US” (United States). 

Note • The default country code can be changed under System > Configure > FlexNet Operations > 
General Options > Default Country for Users and Account Addresses.

This change addresses an issue whereby users created without a supported country code were 
previously instead assigned a default country code, which resulted in incorrect data. These users were 
not synced with the Electronic Software Delivery (ESD) system and were therefore unable to access 
their software downloads in the End-User Portal. In addition, because a default country code was 
assigned, the process did not return an error, and customers were not aware of the discrepancy.

Sample Code for createUser API

This section contains example code for the following scenarios:

• Soap request with an invalid country code

• Soap response for a request with an invalid country code

• Soap request with a valid country code

• Soap response for a request with a valid country code

Soap request with an invalid country code

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v6.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:createUserRequest>
<!--1 or more repetitions:-->
<urn:user>

<urn:firstName>Dev008</urn:firstName>
<urn:lastName>New008</urn:lastName>
<urn:displayName>Dev008 New008</urn:displayName>
<urn:emailAddress>testtrial0015@revenera.com</urn:emailAddress>
<urn:street>Pehani</urn:street>
<urn:city>Gaya</urn:city>
<urn:state>NA</urn:state>
<urn:zipcode>54879</urn:zipcode>
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<urn:country>Ind</urn:country>
<urn:canLogin>1</urn:canLogin>
<urn:acctRolesList>

<urn:acctRoles>
<urn:account>

<urn:primaryKeys>
<urn:id>123</urn:id>

</urn:primaryKeys>
</urn:account>
<urn:roles>

<urn:role>
<urn:primaryKeys>

<urn:name>Portal User Role</urn:name>
</urn:primaryKeys>

</urn:role>
</urn:roles>

</urn:acctRoles>
</urn:acctRolesList>

</urn:user>
<urn:opType>CREATE_OR_UPDATE</urn:opType>

</urn:createUserRequest>
</soapenv:Body>

</soapenv:Envelope>

Soap response for a request with an invalid country code

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Body>
<createUserResponse xmlns="urn:v6.webservices.operations.flexnet.com">

<statusInfo>
<status>FAILURE</status>
<reason>All input data in the request failed. Please check the specific reasons in 

returned data.</reason>
</statusInfo>
<failedData>

<failedUser>
<user>

<firstName>Dev0091</firstName>
<lastName>New0091</lastName>
<displayName>Dev0091 New0091</displayName>
<emailAddress>testtrial0091@revenera.com</emailAddress>
<street>Pehani</street>
<city>Gaya</city>
<state>NA</state>
<zipcode>54879</zipcode>
<country>Ind</country>
<canLogin>true</canLogin>
<acctRolesList>

<acctRoles>
<account>

<primaryKeys>
<id>123</id>

</primaryKeys>
</account>
<roles>
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<role>
<primaryKeys>

<name>Portal User Role</name>
</primaryKeys>

</role>
</roles>

</acctRoles>
</acctRolesList>

</user>
<reason>9999: [Incident# 1863-943] Please provide correct format of 

country</reason>
</failedUser>

</failedData>
</createUserResponse>

</soapenv:Body>
</soapenv:Envelope>

Soap request with a valid country code

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v6.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:createUserRequest>
<!--1 or more repetitions:-->
<urn:user>

<urn:firstName>Dev0091</urn:firstName>
<urn:lastName>New0091</urn:lastName>
<urn:displayName>Dev0091 New0091</urn:displayName>
<urn:emailAddress>testtrial0091@revenera.com</urn:emailAddress>
<urn:street>Pehani</urn:street>
<urn:city>Gaya</urn:city>
<urn:state>NA</urn:state>
<urn:zipcode>54879</urn:zipcode>
<urn:country>IN</urn:country>
<urn:canLogin>1</urn:canLogin>
<urn:acctRolesList>

<urn:acctRoles>
<urn:account>

<urn:primaryKeys>
<urn:id>123</urn:id>

</urn:primaryKeys>
</urn:account>
<urn:roles>

<urn:role>
<urn:primaryKeys>

<urn:name>Portal User Role</urn:name>
</urn:primaryKeys>

</urn:role>
</urn:roles>

</urn:acctRoles>
</urn:acctRolesList>

</urn:user>
<urn:opType>CREATE_OR_UPDATE</urn:opType>

</urn:createUserRequest>
</soapenv:Body>

</soapenv:Envelope>
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Soap response for a request with a valid country code

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Body>
<createUserResponse xmlns="urn:v6.webservices.operations.flexnet.com">

<statusInfo>
<status>SUCCESS</status>

</statusInfo>
<responseData>

<user>
<uniqueId>HID-75</uniqueId>
<userName>testtrial0091@revenera.com</userName>
<primaryKeys>

<firstName>Dev0091</firstName>
<lastName>New0091</lastName>
<emailAddress>testtrial0091@revenera.com</emailAddress>

</primaryKeys>
</user>

</responseData>
</createUserResponse>

</soapenv:Body>
</soapenv:Envelope>

updateProduct API Call No Longer Fails to Update Product Fields
(Cases 03043898, 03047906, 03048567, 03050705; SWM-27193)

In the 2025.05 release, the updateProduct API of the ProductPackagingService web service (all 
versions) failed to update product fields such as description, part number, and product line. The API 
returned the following reason for the failure: “All input data in the request failed. Please check the 
specific reasons in returned data.”

This issue has been resolved in the 2025.06 release. The API now correctly updates all relevant 
product fields as expected.

User Experience Issues Resolved in 2025.06
The following issues related to user experience were addressed in the 2025.06 release.

• Password Reset Now Working As Expected

• “View Server” or “Device” Page in End-User Portal Now Displaying Custom Logo

• Analytics Menu and Configure Single Sign-On Page Now Accessible from Electronic Software 
Download Module Pages

Password Reset Now Working As Expected
(Case 03238562, SWM-27609)
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Previously in certain environments of the Producer Portal and End-User Portal, the password reset 
feature did not function correctly. Specifically, this issue occurred intermittently in the Production 
NAM5 environment.

On the Create A User page, clicking the Reset password button would send an email with a temporary 
password. However, the password could not be used to log in to the Producer Portal or End-User 
Portal. 

This issue has now been resolved, and the password reset process is working as intended.

“View Server” or “Device” Page in End-User Portal Now Displaying Custom 
Logo
(Case 03030863, SWM-26718)

In the End-User Portal, the Device or View Server page (available from the Devices menu) no longer 
incorrectly displays the Revenera logo and “FlexNet Operations” product name, instead of a custom 
logo (if a custom logo has been specified).  

Figure 76: Example of the View Server page in the End-User Portal with a custom logo.

Note • Producers can upload an image file to serve as custom logo in the End-User Portal using the 
Upload Company Logo configuration option (under System > Configure > End-User Portal Setup > 
Custom Branding). 

Analytics Menu and Configure Single Sign-On Page Now Accessible from 
Electronic Software Download Module Pages 
(SWM-23190)
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Previously in the Producer Portal, when navigating to any page that is part of the Electronic Software 
Download module, the Analytics menu and the Configure Single Sign-On option (under the Administer 
menu) were not displayed and therefore could not be accessed.

The Electronic Software Download module includes the areas Download Packages, Files, Agreements 
and Producers under the Products menu. 

This issue has been resolved. The Analytics menu and the Configure Single Sign-On option now appear 
consistently, regardless of the navigation path taken. 

Issues Resolved in 2025.05
An issue in the following area was resolved in the FlexNet Operations 2025.05 release:

• Data Analytics Issues Resolved in 2025.05

• Entitlement Management Issues Resolved in 2025.05

• Export and Import Issues Resolved in 2025.05

• Security Issues Resolved in 2025.05

• User Experience Issues Resolved in 2025.05

Data Analytics Issues Resolved in 2025.05
The following issue was resolved for the Analytics functionality in the 2025.05 release.

Changes to Download Data and File Size in Analytics Dashboard
(SWM-26838)

The following changes were made which affect the Software Delivery Download History report 
(available from the Analytics menu).

Download Data

Previously, no date filter was applied to the data in the Software Delivery Download History report; its 
figures were based on all data available at the time in the Data Warehouse and therefore lacked 
relevance from a business perspective. 

To address this, a default filter is now active which restricts download data to the last 12 months. For 
example, on April 18th, 2025, the data fetched ranges from April 18, 2024 to April 18, 2025.

This filter allows producers to gain insights into software downloads within the past 12 months. 

To fetch data for a shorter or longer period, producers can edit the DOWNLOAD_START_DATE filter in the 
Filters panel.
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Figure 77: By default, the DOWNLOAD_START_DATE filter is set to show download data for the last 12 
months from the current date.

File Sizes

File sizes are now measured using the decimal system (base 10), rather than binary conversion. This 
means that 1 KB equals 1000 bytes, not 1024 bytes as in the binary system.

This way of calculating data sizes is now consistent between the Analytics functionality and FlexNet 
Operations Reporter.

Entitlement Management Issues Resolved in 2025.05
The following issue was resolved for entitlement management in the 2025.05 release.

Download Now Link in End-User Portal Now Working As Expected
(Case 02989988, SWM-25688)

In the End-User Portal, download packages could previously not be downloaded from either the New 
Versions or Previous Versions tab on the Download Order page. (The Download Order page is available 
by selecting Activation & Entitlements > List Entitlements and clicking the Download Now link for an 
entitlement). Instead of a download link, both tabs showed the error message “There are currently no 
available downloads defined for your account.” However, downloads were indeed available, as 
confirmed on the List Downloads page.

This problem has now been resolved. If a user has an entitlement that has download packages 
associated, they will be able to download the download packages from the New Versions tab. 

In addition, expired or archived download packages are now displayed and can be downloaded from 
the Previous Versions tab. 
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Figure 78: The Download Order page now shows expired or archived download packages on the 
Previous Versions tab. 

Export and Import Issues Resolved in 2025.05
The following issue related to the Data Export and Import functionality was resolved in the 2025.05 
release.

Account Data Export
(Cases 03030706, 03032924; SWM-26609)

In this release, the functionality for exporting accounts information has been restored. 

In its Export menu, the Manage Accounts page (available from Accounts & Users > All Accounts) now 
shows the correct option, Data Import Template. Clicking Export > Data Import Template triggers an 
export job, which creates a downloadable Data Import Template (.xlt) file containing the relevant 
entities.
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The image below shows the option Data Import Template which is used to export accounts 
information: 

Figure 79: The Export menu now contains the correct option, Data Import Template, for exporting 
accounts information.

Previously, in its Export menu, the Manage Accounts page showed the options Selected Items and 
Selected Items with Their Dependencies, which had no underlying functionality (.JAR export is not 
available for accounts and users). 

Security Issues Resolved in 2025.05
The following issue related to FlexNet Operations security was addressed in the 2025.05 release.

Upgraded Chart.js
(Case 02999121, SWM-25776)

The Chart.js library has been upgraded to version 2.9.4 to address potential security vulnerabilities.

User Experience Issues Resolved in 2025.05
The following issue related to user experience was addressed in the 2025.05 release.

• System Roles No Longer Visible in Portals

• Resolved Issue of Incorrectly Formatted Page in End-User Portal

System Roles No Longer Visible in Portals
(Cases 03009399, 03009414, 3011796; SWM-26277)

The system roles Default Producer Role and Manage Impersonated Access Tokens PP, and Default 
Portal Role and Manage Impersonated Access Tokens EP are no longer visible in the Producer Portal 
and the End-User Portal, respectively.

These roles are not intended for selection by producers or end users. To avoid that they are mistakenly 
assigned they are now hidden from the Producer Portal and End-User Portal.
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Note • The roles Manage Impersonated Access Tokens PP and Manage Impersonated Access Tokens 
EP contain permissions for issuing so-called impersonated access tokens, which are a means to 
securely authorize SOAP and REST web service calls to FlexNet Operations. While the term 
“impersonated” might sound concerning, it simply refers to a mechanism where a privileged user can 
securely act on behalf of another user with limited permissions.

Resolved Issue of Incorrectly Formatted Page in End-User Portal 
(Case 02411062, SWM-26279)

In the End-User Portal, when associating an existing user to an account, the page for selecting users 
was not correctly formatted. 

The issue could be seen by following these steps: 

1. Click Accounts & Users > List Accounts. 

2. On the Accounts page, click a hyperlinked account ID. 

3. In the Account Users section, click Actions > Link existing users.  

4. Click the pagination arrow to see the next set of users.

5. You will see the page with formatting issues:

This issue no longer occurs. 

Issues Resolved in 2025.04
An issue in the following area was resolved in the FlexNet Operations 2025.04 release:

• Electronic Software Delivery Issues Resolved in 2025.04
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Electronic Software Delivery Issues Resolved in 2025.04
The following issue was resolved for Electronic Software Delivery (ESD) in the 2025.04 release.

Uploading New File Versions Will Update Existing Content
(Cases 02225917, 02567912, 02680773, 02834194, 02918066, 02918272, 02995536, 03003837, 
03008991; SWM-19909)

Previously, when uploading a new version of a file (or package) whose previous version existed in the 
Software Delivery system, it was recommended to use a new file name. This best practice prevented 
the delivery of “stale” file content to customers, because uploading a new file with the same file name 
would not reliably overwrite the existing file. 

Now, you can upload new content using an existing file name, which will replace the existing content. 

Issues Resolved in 2025.03
Issues in the following areas were resolved in the FlexNet Operations 2025.03 release:

• Account and User Management Issues Resolved in 2025.03

• Electronic Software Delivery Issues Resolved in 2025.03

• Entitlement Management Issues Resolved in 2025.03

• Export and Import Issues Resolved in 2025.03

• Security Issues Resolved in 2025.03

Account and User Management Issues Resolved in 2025.03
The following issues involving the management of accounts and users were resolved in the 2025.03 
release.

• Users With Expired Accounts No Longer Fail to Update

• Partners Can Now Filter Devices by Account Name and ID in End-User Portal

Users With Expired Accounts No Longer Fail to Update
(Case 02917771, SWM-24640)

In previous releases, when an account was linked to a user whose association with a different account 
had expired, the account could not be updated. When attempting to update such an account, FlexNet 
Operations returned an error message. The following example illustrates the scenario in which the 
error was displayed:

1. The following two end-customer accounts exist: account ACME and account INDIGO.

2. User A is linked to account ACME. The expiry date was set using the Data Import template; and the  
association between user A and account ACME is set to expire on January 10. 

3. On January 28, you want to link user A to the INDIGO account. This fails with the error message 
“Expiry date should be either today or after date”
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If the user expiry was set via web services or the Producer Portal user interface, and the date has 
passed, the user could be linked to another account. The problem occurred only when the expiry date 
was set via the Data Import template.

This issue has now been resolved. Users whose expiry dates are set using the Data Import template 
are allowed to be linked to other accounts when those expiry dates have passed. If a user is expired on 
one account, this does not prevent the linking on another account.

Partners Can Now Filter Devices by Account Name and ID in End-User Portal 
(Cases 02114107, 02908843; SWM-6311) 

Previously, when a channel partner logged in to the End-User Portal and tried to filter the Devices page 
for devices by account ID or account name, the query did not return any devices. This limitation made it 
difficult for partners to assist their customers with license allocation and troubleshooting.

In the 2025.03 release, this limitation has been addressed, and channel partners can now filter the 
Devices page for devices by account ID or account name.

Figure 80: Example screenshot showing filtering devices by account name 

Electronic Software Delivery Issues Resolved in 2025.03
The following issue was resolved for Electronic Software Delivery (ESD) in the 2025.03 release.

Download Package Search No Longer Returns Duplicate Counts 
(Case 02988915, SWM-25228)

When retrieving download package counts using the getDownloadPackageCount operation of the 
DownloadPackagingService web service or using the Search Download Packages page in the Producer 
Portal, the query could return incorrect counts. This issue occured in the following scenarios:

• The getDownloadPackageCount operation returned an incorrect count if a download package had 
multiple values set for a multi-value text custom attribute.
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• The Search Download Packages page returned duplicate values when searching for a download 
package using a wildcard character (*) in a custom attribute. 

Figure 81: Previously, using a wildcard (*) in a custom attribute when searching for download 
packages could cause the Producer Portal to return duplicates.

This issue has now been resolved. The fix for the getDownloadPackageCount operation applies to all 
versions of the DownloadPackagingService web service.

Entitlement Management Issues Resolved in 2025.03
The following issues were resolved for entitlement management in the 2025.03 release.

• Google reCAPTCHA Challenge Now Displays Complete Set of Pictures, Allowing to Send 
Entitlement Emails

• Saving a Feature with Space in Version Number Triggers Meaningful Error Message

• Rearranging Features on the Products Page in the Producer Portal

• Filter "Is remaining copies more than zero?" Now Working as Expected in Producer Portal

• Resolved Discrepancy Between Number of Entitlements in End-User Portal and Producer Portal

• Retriggering Stuck Jobs for Bulk Upgrade Operations

Google reCAPTCHA Challenge Now Displays Complete Set of Pictures, 
Allowing to Send Entitlement Emails
(Case 02552507, SWM-20758)

In the Producer Portal, if the Google reCAPTCHA challenge is active, the Google reCAPTCHA challenge 
now displays a complete set of pictures when attempting to send entitlement emails from the List 
Entitlements page. 
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To send an email from the List Entitlements page (under Entitlements > List Entitlements), select an 
entitlement and click Email. On the next page, click I’m not a robot. The Google reCAPTCHA challenge 
displays a set of pictures and prompts you to select certain pictures to prove that you are human 
before sending the email.

Previously, some of the pictures were missing, making it impossible for users to complete the 
challenge and send emails from the List Entitlements page (by selecting an entitlement and clicking 
Email). 

The following screenshots show an example of the reCAPTCHA screen with missing pictures and the 
same page with the fix:

Figure 82: Entitlement email with corrupted reCAPTCHA panel
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Figure 83: Entitlement email with fixed reCAPTCHA panel, showing all pictures. 

Note • To use Google reCAPTCHA, the following configuration options must be set: 

• Recaptcha Site key and Recaptcha Secret password (under System > Configure > FlexNet 
Platform Server > General Options)

• Use Recaptcha validation when sending entitlement emails (under System > Configure > FlexNet 
Operations > General Options) must be selected.

Saving a Feature with Space in Version Number Triggers Meaningful Error 
Message
(Case 02990348, SWM-25307)

In previous releases, when a feature was created with the Version Format Type set to Fixed and the 
Version field included a space (for example, “1.0 “), the feature was created successfully. However, 
adding such features to a product later failed with the following error message:  

The version string "2.0  " for feature "TestSpaceInVersionField" is not a valid 
FlexNet version: must be <number>.<number> [Incident# 9379-0620915R]

To be able to map the feature to a product, producers had to return to the feature and modify the 
version to remove spaces, which caused frustration and wasted producers’ time.



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  190

New Behavior

In the 2025.03 release, producers are alerted during the feature creation process that a feature with 
the Version Format Type set to Fixed cannot have a version number containing spaces. If a feature’s 
Version Format Type is set to Fixed and the Version field contains a space, upon saving the feature the 
following error message is displayed: 

The version format is invalid. Please follow the standard format and avoid any spaces. 

The following screenshot shows the Package Products | Create a Feature page with the red banner 
and the error message, because the version includes a space (“1.0 “):

Figure 84: The Package Products | Create a Feature page with the red banner and error message 

Rearranging Features on the Products Page in the Producer Portal
(SWM-22618)

On the Products page (under Products > Product > click a product name), features and feature 
bundles (on the Features tab) can now be sorted based on the date they were added to the product. By 
default, they are arranged in ascending order (the oldest feature or feature bundle is displayed at the 
top of the list). The order can be reversed by clicking the header of the Feature or Feature Bundle 
Name column.

The following screenshot shows the Feature or Feature Bundle Name column where the order of 
features can now be changed.
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Figure 85: On the Package Products | Create a Product page, the order of features can now be 
changed.

Note • When exporting feature information (using either .jar or Data Import template (.xlt) format), 
the feature to product linkage is reset to have the timestamp of the import.

Filter "Is remaining copies more than zero?" Now Working as Expected in 
Producer Portal
(Case 02905595, SWM-25218)

This release resolves an issue with the option Is remaining copies more than zero? that is available in 
the Advanced search panel on the List Entitlements page. In previous releases, regardless of whether 
the option was set to Yes or No, the List Entitlements page showed entitlements with copies greater 
than 0 as well as those with 0 copies. 

In the 2025.03 release, the option Is remaining copies more than zero? works as expected:

• Yes—The List Entitlements page shows only entitlements with copies greater than 0.

• No—The List Entitlements page shows only entitlements with 0 copies.

• None—The List Entitlements page shows entitlements with copies greater than 0 and those with 0 
copies.

The following screenshot shows the option Is remaining copies more than zero?:
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Figure 86: The Advanced search panel on the List Entitlements page

Note • A related known issue exists for entitlements for Embedded license models, see SWM-24042: 
Input Sanitization Disabled.

Resolved Discrepancy Between Number of Entitlements in End-User Portal 
and Producer Portal
(Cases 02979909, 02553109; SWM-24947, SWM-23317)

Previously, when the configuration option Show Line Items with Zero Copies by Default (under System 
> Configure > FlexNet Operations > General Options) is unselected, there was a discrepancy between 
the number of entitlements listed on the List Entitlements page in the Producer Portal and on the List 
Entitlements page in the End-User Portal. The reason was a synchronization issue, which meant that 
entitlements with an available quantity of zero were erroneously displayed on the List Entitlements 
page in the End-User Portal. 

This issue no longer occurs, and the List Entitlements page shows the correct number of entitlements 
in both portals. 
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Figure 87: The List Entitlements page in the Producer Portal shows entitlements with zero available 
quantity only when the configuration option Show Line Items with Zero Copies by Default is selected.

Figure 88: An example of the List Entitlements page in the End-User Portal showing entitlements with 
zero available quantity.

Retriggering Stuck Jobs for Bulk Upgrade Operations
(Case 02969947, SWM-24096)

In the past, jobs for bulk upgrade operations could get stuck with the status “Submitted” or “In 
Progress”. There was no indication of whether the job was running. Restarting the job server had no 
impact on the job; it would remain stuck. The only solution for producers was to manually retrigger the 
job. 

This issue has now been resolved. If a job for a bulk upgrade operation gets stuck, restarting the job 
server triggers a new job which will pick up the work from the original job. This new job is scheduled to 
run within 2 minutes of the server restart.
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Export and Import Issues Resolved in 2025.03
The following issue related to the Data Export and Import functionality was resolved in the 2025.03 
release.

Import/Export Jobs No Longer Getting Stuck on Job Server Restart 
(Case 02874418, 02902735, 02909549; SWM-21535)

In previous releases, when an import/export job was running and at the same time the job server was  
restarted, the job was stuck in the "in Process" state and never completed until it was resubmitted.

This behavior was problematic, because producers had to resubmit those stuck import/export jobs, 
which took up extra time. 

This has now been resolved. If an import/export job is in process while a job server restart occurs, that 
job will be moved to a waiting state so that the next run can pick it up. Producers no longer need to 
manually resubmit the hanging job.

Security Issues Resolved in 2025.03
The following issue related to FlexNet Operations security was addressed in the 2025.03 release.

Enforcing Account Access Permissions for Portal Users
(SWM-25459)

Previously, users with the Portal User role could access information that they are not entitled to see, by 
manipulating URL parameters.

In the 2025.03 release, it is no longer possible to access information without the necessary 
permissions, by manipulating URL parameters.

Issues Resolved in 2025.02
Issues in the following areas were resolved in the FlexNet Operations 2025.02 release:

• Entitlement Management Issues Resolved in 2025.02

• Security Issues Resolved in 2025.02

• User Experience Issues Resolved in 2025.02

Entitlement Management Issues Resolved in 2025.02
The following issues were resolved for entitlement management in the 2025.02 release.

• Restrict Activations on Expired Line Items for FlexNet Publisher Products

• Resolved Issue With Entitlement Emails
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Restrict Activations on Expired Line Items for FlexNet Publisher Products 
(Case 02144139, SWM-23877)

Previously, when an end user attempted to activate an expired FlexNet Publisher line item (using web 
services or the appactutil utility) and that line item had previously been activated on a client, the 
request erroneously succeeded. The reason for this behavior was that FlexNet Operations located the 
relevant fulfilment record and treated the activation as a reinstall. However, this behavior resulted in 
clients being able to continue using the software beyond the license expiration date.

To address this issue, FlexNet Operations now checks the line item expiration date before activation. If 
a line item has expired then the activation request is denied and an error message is shown. 

This change applies to all types of activations (online, offline, manually, or via web services). Other 
license lifecycle operations such as return, repair, or rehost are not affected.

Resolved Issue With Entitlement Emails
(Case 02988204, 02988951; SWM-25192)

A change introduced in the 2025.01 release caused an issue which meant that no entitlement emails 
could be sent to end users. When attempting to send an entitlement email, the following error was 
displayed: Tenant nnn does not have an associated publisher/identity. 

This issue has now been resolved, and entitlement emails are sent to end users.

Security Issues Resolved in 2025.02
The following issue related to FlexNet Operations security was addressed in the 2025.02 release.

Improved Error Handling for Status 500 Errors
(Case 2889182, SWM-22287)

Previously, status 500 errors could reveal the server hostname in the fault details of the response, 
which is considered a security risk. Such an error could be triggered by sending a bad request using 
web services—for example, by attempting to update a user with a typo in the request, like 
<urn:lastNam>?</urn:lastName>. 

This issue has now been addressed, and status 500 errors no longer reveal implementation details.

User Experience Issues Resolved in 2025.02
The following issues involving user experience were resolved in the 2025.02 release.

• Increased Download Speed in End-User Portal

• Updated Link to Customer Community

• Removed Truncation in End-User Portal on View Server Page

Increased Download Speed in End-User Portal
(Case 02776698, SWM-19906)
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In the End-User Portal, end users associated with several accounts can now download content more 
quickly. The syncing process has been optimized, allowing users to access downloads shortly after 
their accounts and entitlements are provisioned.

Updated Link to Customer Community
(SWM-24485)

Following the recent introduction of the new Revenera Community, the link Customer Community 
(available in the Producer Portal from the System menu) has been updated to point to the Community’s 
new URL, https://community.revenera.com. 

Any users attempting to access the previous URL, http://flexeracommunity.force.com/customer/, will 
be redirected to the new URL.

Removed Truncation in End-User Portal on View Server Page
(Case 02981114, SWM-24922)

Previously, the menu options available from the View menu on the View Server page in the End-User 
Portal were truncated on the left side of the screen and not readable. To access the View Server page, 
click Devices > Devices, then click the hyperlinked name or ID for a server (Cloud Licensing Service 
instance or local license server). 

The following screenshot shows the fixed menu of the View Server page, with the menu options fully 
visible:

https://community.revenera.com
http://flexeracommunity.force.com/customer/
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Issues Resolved in 2025.01
Issues in the following areas were resolved in the FlexNet Operations 2025.01 release:

• Entitlement Management Issues Resolved in 2025.01

• User Experience Issues Resolved in 2025.01

Entitlement Management Issues Resolved in 2025.01
The following issues were resolved for entitlement management in the 2025.01 release.

• Request Button Now Triggering Renewal Email

• Entitlement Line Item Start or Expiry Updated Using "Change Start/Expiration Date" Button Now 
Reflected on CLS

• Confirmation Step No Longer Skipped During License Count Update

Request Button Now Triggering Renewal Email 
(Case 02890657, SWM-22556)

On the End-User Portal’s Expiring Entitlements page, end users can click a Request button to send an 
email message to the producer about their intent to renew selected entitlements. 

In previous releases, the End-User Portal failed to send such renewal emails. In the 2025.01 release, 
this issue has been resolved. When an end user clicks the Request button, the End-User Portal sends a 
renewal email to the email address specified in the configuration option Request Renewal Notification 
Email (under System > Configure > FlexNet Operations > Renewals). That email address is also used 
to populate the From field. The end user requesting the renewal will receive receive a copy of the 
renewal email, as their email address is included in the Cc field. 
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Important • Renewal emails are sent only if the following conditions are fulfilled:

• An email address is specified in the configuration option Request Renewal Notification Email 
(under System > Configure > FlexNet Operations > Renewals).  

• The email address specified in Request Renewal Notification Email has been verified in the 
Producer Portal on the Email/Domain Verification page (available from the Administer menu in 
the Email group). 

Entitlement Line Item Start or Expiry Updated Using "Change 
Start/Expiration Date" Button Now Reflected on CLS
(Case 02913332, SWM-24187) 

Previously, when an entitlement was mapped to a Cloud Licensing Service (CLS) instance and one of 
its line items had its start or expiration date changed using the Change Start/Expiration Date button on 
the Entitle Customers to Licenses | Create an Entitlement page (under Entitlements > List 
Entitlements by Order > click the entitlement’s hyperlinked ID), the new start or expiration date was 
not reflected on the CLS instance. This means that served clients' subsequent capability requests were 
not aligned with the new start or expiration date.

This issue no longer occurs. An entitlement line item’s changed start or expiration date is now 
immediately reflected on the mapped CLS instance, and can be viewed as follows:

• On the View Server page (Devices > Devices > click a hyperlinked device name > View > View 
Response) in the Capability Response section.

• Calling the /features endpoint.

Confirmation Step No Longer Skipped During License Count Update
(Case 02912962, SWM-24195)

Previously, when removing line items mapped to a local license server or a standalone device, FlexNet 
Operations was not enforcing the step where a confirmation of changes is needed before quantities on 
the device are updated, even though the configuration option Skip Confirmation or Skip Confirmation 
for Producer was unselected. 

The bug occurred when Generate Response was triggered on the View Server or Device page (under 
Devices > Devices > click hyperlinked name of a device), which changed the license status to License 
generated and decreased the license count on the device without waiting for the device to confirm the 
changes. This bypassed the expected Waiting for confirmation status, which should remain until the 
device explicitly sends a confirmation request.  

This has been fixed in the 2025.01 release. Clicking Generate Response now changes the license 
status to Waiting for confirmation. The license count is only updated on the device after it has sent a 
capability request to confirm the changes. 
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The following table shows the behavior and license status when a user clicks Generate Response after 
a license count change, depending on the selection of the Skip Confirmation and Skip Confirmation for 
Producer configuration options.

User Experience Issues Resolved in 2025.01
The following issue involving user experience was resolved in the 2025.01 release.

Configuration Changes Now Updated After Saving
(SWM-22817)

In previous releases, when changing a configuration setting under Embedded Devices (under System 
> Configure) and clicking Save Configs, the previous setting (either the previous value or 
selected/unselected state of the check box) was still shown. The updated setting was only visible after 
clicking Save Configs a second time. In addition, after saving changes, the confirmation message “The 
configuration was updated successfully” was formatted differently to other FlexNet Operations 
confirmation messages (using a white background instead of a blue banner). 

Both issues have been resolved in the 2025.01 release. Changes to configuration settings are now 
saved and visible after clicking Save Configs once, and the confirmation message is formatted as a 
blue banner. 

Known Issues
The following describes known issues in the current FlexNet Operations release.

Skip Confirmation
Skip Confirmation
for Producer Behavior in 2025.01

Unselected Unselected Status changes to Waiting for confirmation. Once a 
capability request is sent or uploaded, the status changes 
to License generated and the license count is updated on 
the device.

Selected Selected Status changes to License generated. Once a capability 
request is sent or uploaded in the Producer Portal and the 
End User Portal, the license count is updated on the 
device.

Selected Unselected Status changes to License generated. Once a capability 
request is sent or uploaded in the Producer Portal or the 
End User Portal, the license count is updated on the 
device.

Unselected Selected Status changes to License generated. Once a capability 
request is sent or uploaded in the Producer Portal (and 
optionally in the End User Portal), the license count is 
updated on the device.
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SWM-29531: Latest Changes to Line Item Custom Attributes Not Reflected 
in Transaction History
When updating a custom attribute for a line item, the transaction history does not reflect the latest 
changes. 

The following example illustrates the issue: 

Consider the OrderLine attribute for a line item was set to Pro Marketing Suite. It is then changed 
from Pro Marketing Suite to Advanced AI Content Generator in the Configure Line Item dialog, as 
shown below:

The change should be reflected in the Transaction Details page. However, the Transaction Details 
page still shows the previous value, Pro Marketing Suite, as shown in this screenshot:

As a workaround, re-save the line item for the latest update to be published.
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SWM-30699: Obsoleting Devices or Servers Across Accounts
In the End-User Portal, users with the Obsolete Devices/Servers permission can currently mark 
devices or servers as obsolete even if those assets belong to a different account. This behavior is 
unintended and violates account-level restrictions. Revenera plans to resolve this in the January 2026 
release.

SWM-26453: Secret Question on Forgot Password Page Not Localized
The secret question displayed on the Forgot Password page in the End-User Portal is currently not 
localized.

Figure 89: The secret question is not displayed in the language selected on the End-User Portal’s 
Login page.

The system retrieves and displays the security question in the original language it was configured and 
stored during the user's first login. This behavior persists regardless of the user's selected language 
preference in subsequent sessions.

SWM-24928: Email Addresses for “File Created User Email” Missing in 
Software Delivery Download History Report  
In the Software Delivery Download History report (available from the Analytics menu), the File Details 
table is not displaying email addresses in the File Created User Email column due to an issue with the 
field size. As a workaround, the File Created User Email column is populated with the same email 
addresses as those displayed in the File Uploaded User Email column, because these email addresses 
typically are identical.  

SWM-24042: Input Sanitization Disabled
(Case 02889178) 

The FlexNet Operations 2024.12 release introduced limitations to the characters allowed in certain 
Producer Portal fields (see Security Issues Resolved in 2024.12). The following special characters 
were no longer allowed in a number of input fields to protect against injection attacks: 

[ : < > { } @ ; = \ , ! / | ? " # $ % ~ ^ ` ' ]

This functionality has now been disabled to allow further impact assessment. This means that the 
character restrictions placed on fields listed in Security Issues Resolved in 2024.12 are no longer in 
force.

https://docs.revenera.com/fno2024/rn/Content/helplibrary/Security_Issues_Resolved_in_2024_12.htm
https://docs.revenera.com/fno2024/rn/Content/helplibrary/Security_Issues_Resolved_in_2024_12.htm
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SWM-23586: Hanging Bulk Operation Jobs Not Showing “Failed” Status
A fix made in the 2024.11 release (see description Import/Export Jobs Terminated Upon Job Server 
Restart) has been reverted for bulk operations. The fix remains in place for import/export jobs.

This means that any bulk operation jobs that hang when the job server is restarted are not terminated 
and are not automatically retriggered. 

SWM-19547: Download Search Page in End-User Portal Not Filtering Expired 
Accounts
In the End-User Portal, on the Download Search page (available from Downloads > Search Downloads), 
the Choose Account dropdown list does not filter out expired accounts. Instead, it erroneously displays 
expired and non-expired accounts. 

Note • The Choose Account dropdown list is only displayed if the user belongs to more than one 
account that is entitled to downloads.

SWM-15171: Auto-Fulfill Failing During Large Bulk Upgrade Jobs
Auto-fulfill might fail in bulk upgrade jobs that contain more than 2200 line items.

SSRE-20257: Upload of Large File Images Failing 
The upload of file images that exceed 1 GB using HTTP upload fails. For large file images, Revenera 
recommends using FTP upload.

SWM-19052: Feature Count Aggregation Not Working As Expected
If a feature’s aggregation type is changed, the relevant instance of the Cloud Licensing Service might 
not update the aggregated feature counts according to the new aggregation type. 

However, if the entitlement for the product that contains the features is mapped to a new Cloud 
Licensing Service instance, the feature counts are aggregated correctly as per the new aggregation 
type. 

FNO-69836: Variables in Vendor String Causing License Activation Issues
License activation fails for product upgrades or normal license activation when the product to be 
upgraded or activated is associated with a feature that has a vendor string which contains substitution 
variables that are enclosed in double quotes (for example, 
"activationId":"{EntitlementLineItem.activationId}").

FNO-69338: Navigation in Package Products Pages Skipping Review 
Features Page
When the user navigates through the Package Products pages (under Products > Features) using the 
Next button at the bottom of each page, the Review Features and Review Feature Bundles pages are 
erroneously skipped. 

https://docs.revenera.com/fno2024/rn/Content/helplibrary/Export_and_Import_Issues_Resolved_in_2024_11.htm
https://docs.revenera.com/fno2024/rn/Content/helplibrary/Export_and_Import_Issues_Resolved_in_2024_11.htm
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As a workaround, users who want to review the features and feature bundles that they just added can 
click the Review Features and Review Feature Bundles links, respectively, in the Packaging Guide 
section at the bottom of the page to access the Review Features page. 

SWM-15870: Mismatch Between User Name and Email Address Causing 
Issues with ESD (UserOrgHierarchyService)
When creating a user via the UserOrgHierarchyService web service (the predecessor of the User 
Account Hierarchy Service web service), it is possible to have different values for user name and email 
address. However, users whose user name and email address do not match cannot access downloads 
in the End-User Portal. 

Producers who use the UserOrgHierarchyService should use the methods from the User Account 
Hierarchy Service web service to avoid a mismatch between the user name and email address. 

Note • The following changes have recently been made to the User Account Hierarchy Service web 
service:

• From the 2023.07 release onwards, it is not possible to create users with a mismatched user 
name and email address. See “createUser Operation in User Account Hierarchy Service Web 
Service No Longer Allows Mismatch Between User Name and Email Address” in the FlexNet 
Operations 2023 Release Notes.

• From the 2023.10 release onwards, users cannot update their email address to be different from 
their user name. See “updateUser Operation in User Account Hierarchy Service Web Service No 
Longer Allows Mismatch Between User Name and Email Address” in the FlexNet Operations 2023 
Release Notes.

FNO-69182: Incorrect Email Format Accepted When Creating User Via 
Import Template 
It is possible to create or update a user with an invalid email address format by importing user 
information using the Account and User import template (downloadable from Administer > Import 
Data Objects > Data Import Templates in the Producer Portal). Email addresses of the format abcd@ef 
(that is, an email address consisting of a recipient name, @ symbol and domain name but without top-
level domain) are erroneously accepted. 

FNO-68962: Invalid Characters in Device ID Causing Issues 
When the FlexNet Embedded toolkit creates a device ID that contains an invalid character, an error 
occurs.

The following control characters are not allowed in device names or the device ID:

^B ^D ^E ^G ^N ^O ^P ^Q ^R ^S ^T ^U ^W ^X ^Y ^[ ^\ ^] ^F ^C ^^ ^A ^V ^_ 

https://docs.revenera.com/fno2023/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2023/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2023/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2023/rn/Content/helplibrary/fno_rn.htm


FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  204

SWM-10701: Search Functionality in End-User Portal Erroneously Displays 
Download Link 
In the End-User Portal, users who should be denied access to a file based on their geographical 
location are able to display the download link for a restricted file when searching for the file name 
(using the Search function with the Files option on the Download Search page). However, users are not 
able to download the restricted file. 

FNO-66018: Errors in UI Updated for Download Package Selection Across 
Multiple Pages
In 2021.09, the Download Packages window was updated to allow package selection across multiple 
pages. The following errors currently exist for the updated UI.

• Incorrect error message for EULA license on Review & Resolve page

• Search string not properly clearing

• No option to return to full (unfiltered) Download Package list when “failed validation” message 
displays

• Failed validation error displayed for search results

• Pagination control fields not showing correct information

• Inappropriate message displayed for already downloaded packages

Incorrect error message for EULA license on Review & Resolve page

When you attempt to download packages that fail validation, the following message is displayed: 
“Some of the selected packages failed validation. You need to review and resolve the validation 
errors.” Then, on the Failed Packages window that is displayed if you click the “review and resolve” 
link in the message, the error for an unaccepted EULA incorrectly shows the following:

 “EULA has not been accepted. To accept EULA, click on the Download package ID.” 

Instead of “click on the Download Package ID”, the message should instruct the user to “...click ‘I 
Agree’”. 

Search string not properly clearing 

After you filter the package list on the Download Packages window, the message “Results for 
Download package name: <name>” is appropriately displayed. However, if you then click the Clear link 
at the end of message, the search string used to filter the package list remains, the list remains 
filtered (even if you move to the next page), and the “Results for the Download package name...” 
message is still displayed. You must manually delete the search string and click Search to clear the 
filter.

No option to return to full (unfiltered) Download Package list when “failed validation” 
message displays

If the “failed validation” message is displayed after you attempt to download packages from a filtered 
list on the Download Packages window, no mechanism exists to clear the filter to display all packages. 
You must manually delete the search field contents and click Search.
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Failed validation error displayed for search results

After searching for and attempting to download a package containing an unaccepted EULA, the 
expected message “Some of the selected packages failed validation...” is displayed on the Download 
Packages window. However, if you then search for a package that does not contain an EULA (but do 
not attempt to download the package), you received the “failed validation” message instead of the 
correct message describing the filter results: “Results for Download package name: <name>”.

Pagination control fields not showing correct information

The pagination control fields on the Download Packages window are not displaying the correct totals 
for a filtered list of packages.

Inappropriate message displayed for already downloaded packages

When you select an entitlement line item whose packages have already been downloaded, the 
Download Packages window is displayed with incorrect message “Files sent for download. Please 
monitor the download manager pop up”. The message should be removed altogether or displayed only 
as package files are being sent to the Download Manager (before the actual Download Manager 
window is displayed).

SWM-7952: Not All Applicable Download Links Available on “List 
Downloads” Page in End-User Portal
When end users are logged in with an activation ID for an entitlement line item that is associated with 
multiple products, the Downloads page (accessed from Downloads > List Downloads) in the End-User 
Portal does not always show links to all applicable product downloads.

SWM-7786: SHA2 Checksum Value of Previous File Shown
If a user has provided a file’s expected SHA2 checksum value for an upload and the file image is 
subsequently deleted, the Upload File page, when opened again, might show the SHA2 checksum 
value of the previously loaded file image.

FNO-65909: Download Files Not Visible For Self-registered And Trial Users
Download files might not be visible in the End-User Portal for self-registered users and those users 
registered through the “Try Before You Buy” registration.

FNO-61266: Translation Issues with Localization
Per a previous enhancement in 2020 R3 to add more language support for End-User Portal 
localization, certain strings—such as alerts and validation messages—are not being translated 
properly when localization is in effect. These issues will be addressed in an upcoming release.

Special Notes
This section contains special information pertaining to FlexNet Operations.

• Communication of Changes in Data Access API, Data Share, and Analytics

• Plug-in Upgrade Needed for High-Speed File Uploads
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• Handling UI Conflicts When Using a Custom CSS for the End-User Portal

Communication of Changes in Data Access API, Data Share, and Analytics
(SWM-27132)

Revenera is committed to addressing customer requests and enhancement suggestions by expanding 
the existing Data Access API, the Data Share, and Analytics functionality. Starting with the 2025.06 
release, any modifications resulting from these requests will be managed and communicated as 
follows.

Refer to the following sections for details: 

• Addition of Fields and Columns

• Examples for Additional Columns

• Modification or Removal of Fields and Columns

• Examples for Removing or Changing Columns

• Consumer Implementation Requirements

Addition of Fields and Columns

Any additional fields or columns required for enhancing data accessibility or extending functionality 
will be incorporated directly into the existing version of the Data Access API and Data Share views.

There is no impact on the Analytics functionality, as any newly added fields will not appear in reports 
by default. Customers can choose to include them as needed.

These changes will not be announced prior to implementation; however, any schema modifications will 
be documented and communicated through release notes.

Examples for Additional Columns

This section provides examples illustrating how new fields will appear in:

• Data Share

• Data Access API

• Analytics

Data Share

The following screenshots show examples for additional columns in the Data Share.

Figure 90: An example view of SEC_VW_DEVICE before a change. 
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Figure 91: An example view of SEC_VW_DEVICE after columns have been added, with additions 
highlighted.

Data Access API

The following screenshots show examples for additional fields in the device data set of the Data 
Access API.

Figure 92: An example view of the device dataset before a change. 
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Figure 93: An example view of the device dataset after fields have been added, with additions 
highlighted.

Analytics

The following screenshot shows an example of the Devices Details table and newly added columns.

Figure 94: An example view of the Devices Details table in Analytics, with newly added columns being 
unselected by default. 
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Modification or Removal of Fields and Columns

If any fields or columns need to be modified or deprecated due to architectural changes, compliance 
updates, or optimization efforts, a structured communication approach will be followed:

• Stakeholders will be informed well in advance through official communication channels (release 
notes, documentation updates).

• Depending on the nature of the update, a new API version will be introduced.

• Legacy versions will be maintained for a defined period to facilitate migration.

Examples for Removing or Changing Columns

This section provides examples illustrating the removal of columns or fields in:

• Data Share

• Data Access API

Data Share

As an example, the following screenshots shows the renaming of the DEVICE_ALIAS column to 
DEVICE_DISPLAY_NAME and the deletion of the MACHINE_TYPE column in the Data Share.

Figure 95: An example view of SEC_VW_DEVICE before removing the MACHINE_TYPE column and 
changing the name of the DEVICE_ALIAS column. 

Figure 96: The same view of SEC_VW_DEVICE, where the MACHINE_TYPE column has been removed. 
The DEVICE_ALIAS column has been renamed to DEVICE_DISPLAY_NAME. 

Data Access API

This screenshot illustrates the following modifications in the Data Access API:
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• changing DeviceAlias to DeviceDisplayName and

• deleting the key DeviceMachineType.

Figure 97: An example view of the device dataset before renaming and removing fields. 
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Figure 98: An example view of the device dataset where fields have been renamed and removed. 

Consumer Implementation Requirements

To avoid any integration breakage, customers are required to implement their consumers as follows:

• Ensure consumers ignore unknown fields or column in the Data Access API and Data Share.

• Adopt robust parsing logic to improve data integrity, such as using keys and names instead of 
relying on indexes or hard-coded structures.

Plug-in Upgrade Needed for High-Speed File Uploads
If you intend to use the high-speed upload option to upload files, upgrade the Aspera plug-in to Aspera 
Connect 3.10.0 or later. 

Handling UI Conflicts When Using a Custom CSS for the End-User Portal
When you use your own CSS to customize the look of the End-User Portal, sometimes your custom CSS 
code conflicts with existing Revenera CSS code that is used to define certain buttons, pages, and other 
UI elements. When conflicts occur, handle each case individually, determining the basis of the conflict 
and adjusting the custom CSS as needed. If you require assistance, contact Revenera Technical 
Support (see Revenera Resources).
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SOAP API Change Log
The following sections describe the changes that have been made to the FlexNet Operations SOAP API 
in the FlexNet Operations 2025 releases to date:

• Change Log for 2025.11

• Change Log for 2025.09

• Change Log for 2025.07

• Change Log for 2025.06

• Change Log for 2025.05

• Change Log for 2025.02

Change Log for 2025.11
The following SOAP API changes were made in 2025.11:

• Entitlement Order Service Now Accepts Multiple Account Names

Entitlement Order Service Now Accepts Multiple Account Names
In the EntitlementOrderService SOAP web service (versions 8 and 9), a new accountUnitNameList 
parameter was added that accepts multiple account names.

In the 2025.10 release, a regression was identified in certain EntitlementOrderService operations 
where using the accountUnitName query parameter with the EQUALS operator could incorrectly trigger 
an error if the specified account name contained a space.

To address the regression, versions 8 and 9 of EntitlementOrderService now use the newly 
introduced accountUnitNameList parameter, which accepts multiple account names. Customers can 
provide multiple account unit names using repeated <urn:value>?</urn:value> elements.

The following operations were impacted:

• getActivatableItemCount

• getActivatableItemsQuery

• getEntitlementLineItemPropertiesQuery

To implement this change, the following file was modified:

• entitlementLineItemTypes.xsd

Note • This enhancement was tracked in SWM-29389.
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entitlementLineItemTypes.xsd

The following changes/additions were made to the entitlementLineItemTypes.xsd file. Changes and 
additions are highlighted.

Change Log for 2025.09
The following SOAP API changes were made in 2025.09:

• Ability to Retrieve Devices Not Associated to Any Account

Note • This enhancement was tracked in SWM-21765.

Ability to Retrieve Devices Not Associated to Any Account
In the ManageDeviceService SOAP web service (version 7), a new enum value IS_EMPTY has been 
added to the simpleSearchType to enable searching for devices/servers where soldToAcctId is blank 
(devices/servers that are not associated to any account).

 To implement this change, the following file was modified:

• manageDeviceTypes.xsd

manageDeviceTypes.xsd

The following change was made to the manageDeviceTypes.xsd file. Additions are highlighted.

# Change

1 <xs:complexType name="searchActivatableItemDataType">
<xs:sequence>       

<xs:element name="parentBulkEntitlementId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="entitlementId" type="tns:SimpleQueryType" minOccurs="0"/>

<xs:element name="activationIds" type="tns:activationIdList" minOccurs="0" />
. . .
<xs:element name="allowPortalLogin" type="xs:boolean" minOccurs="0"/>
<xs:element name="accountUnitName" type="tns:PartnerTierQueryType" minOccurs="0"/>
<xs:element name="accountUnitNameList" type="tns:AccountNamesQueryType"  minOccurs="0"/>
<xs:element name="currentOwnerName" type="tns:SimpleQueryType"  minOccurs="0"/>

# Change

1 <xs:simpleType name="simpleSearchType">
<xs:restriction base="xs:NMTOKEN">

<xs:enumeration value="STARTS_WITH"/>
<xs:enumeration value="CONTAINS"/>
<xs:enumeration value="ENDS_WITH"/>
<xs:enumeration value="EQUALS"/>
<xs:enumeration value="IS_EMPTY"/>

</xs:restriction>
</xs:simpleType>    
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Change Log for 2025.07
The following SOAP API changes were made in 2025.07:

• Change Log: Ability to Exclude Expired Activations

Note • This enhancement was tracked in SWM-27421.

Change Log: Ability to Exclude Expired Activations
In the EntitlementOrderService, a new optional input query parameter named excludeExpired has 
been introduced for the getEntitlementLineItemPropertiesQuery to enable you to exclude expired 
activations from search results. 

• True—When excludeExpired is set to true, all expired activations—those with expiration dates 
earlier than the current local date—will be excluded from the results. 

• False—If excludeExpired is omitted or set to false, all activations, including expired ones, will be 
included.

To implement this change, the EntitlementOrderService’s associated entitlementLineItemTypes.xsd 
file has been updated.

entitlementLineItemTypes.xsd

In the entitlementLineItemTypes.xsd file, the following changes were made. Additions are 
highlighted.

Change Log for 2025.06
The following SOAP API changes were made in 2025.06:

• Change Log: New API Commands to Report Custom Attributes for Entitlements and Line Items

• Change Log: Optional vendorAuthString parameter in getFeaturesQueryRequest API in 
ProductPackagingService v3

# Change

1 <xs:complexType name="searchActivatableItemDataType">
<xs:sequence>       

<xs:element name="parentBulkEntitlementId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="entitlementId" type="tns:SimpleQueryType" minOccurs="0"/>

<xs:element name="activationIds" type="tns:activationIdList" minOccurs="0" />
<xs:element name="productName" type="tns:SimpleQueryType" minOccurs="0"/>
.
.
.
<xs:element name="activatableItemOwnersSearch" type="tns:ActivatableItemOwnersType" minOccurs="0"/>
<xs:element name="excludeExpired" type="xs:boolean" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
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Change Log: New API Commands to Report Custom Attributes for 
Entitlements and Line Items
The 2025.06 release introduced a number of enhancements that enables users to search using 
specific custom entitlement attributes when using the SOAP API getActivatableItemsQuery command 
in the EntitlementOrderService wsdl. The new API command returns all entitlements and line items 
with their custom attributes. Previously, the request only supported searching using custom license 
attributes. 

To implement these new actions, the EntitlementOrderService.wsdl file and its associated .xsd files 
have been updated from v8 to v9:

/schema-public/v9/EntitlementOrderService.wsdl
/schema-public/v9/bulkEntitlementTypes.xsd
/schema-public/v9/commonEntitlementTypes.xsd
/schema-public/v9/commonIdentifierTypes.xsd
/schema-public/v9/commonTypes.xsd
/schema-public/v9/entitlementLifeCycleTypes.xsd
/schema-public/v9/entitlementLineItemTypes.xsd
/schema-public/v9/entitlementOrderTypes.xsd
/schema-public/v9/simpleEntitlementTypes.xsd

In additional to updating the version, additions were made to the following files:

• EntitlementOrderService.wsdl

• entitlementLineItemTypes.xsd

• entitlementOrderTypes.xsd

• entitlementAttributeTypes.xsd, a new .xsd file that was added in this release

Note • This enhancement was tracked in SWM-19774 (see also New API Commands to Report Custom 
Attributes for Entitlements and Line Items).
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EntitlementOrderService.wsdl

In addition to updating the version number from 8 to 9 in multiple locations in the 
ManageDeviceService.wsdl file, the following additional changes were made. Additions are 
highlighted.

# Change

1 <message name="unlinkMaintenanceLineItemResponse">
<part name="msgparameters" element="tns:unlinkMaintenanceLineItemResponse"/>

</message>
<message name="searchEntitlementAttributeRequest">

<part name="msgparameters" element="tns:searchEntitlementAttributeRequest"/>
</message>
<message name="searchEntitlementAttributeResponse">

<part name="msgparameters" element="tns:searchEntitlementAttributeResponse"/>
</message>
<message name="getEntitlementAttributeCountRequest">

<part name="msgparameters" element="tns:getEntitlementAttributeCountRequest"/>
</message>
<message name="getEntitlementAttributeCountResponse">

<part name="msgparameters" element="tns:getEntitlementAttributeCountResponse"/>
</message>

2 <operation name="unlinkMaintenanceLineItem">
<input message="tns:unlinkMaintenanceLineItemRequest"/>
<output message="tns:unlinkMaintenanceLineItemResponse"/>

</operation>
<operation name="getEntitlementsAttributeQuery">

<input message="tns:searchEntitlementAttributeRequest"/>
<output message="tns:searchEntitlementAttributeResponse"/>

</operation>
<operation name="getEntitlementAttributeCount">

<input message="tns:getEntitlementAttributeCountRequest"/>
<output message="tns:getEntitlementAttributeCountResponse"/>

</operation>

3 <operation name="getEntitlementsQuery">
<soap:operation style="document"/>
<input>

<soap:body use="literal" />
</input>
<output>

<soap:body use="literal" />
</output>

</operation>
<operation name="getEntitlementsAttributeQuery">

<soap:operation style="document"/>
<input>

<soap:body use="literal" />
</input>
<output>

<soap:body use="literal" />
</output>

</operation>
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entitlementLineItemTypes.xsd

In addition to updating the version number from 8 to 9 in the entitlementLineItemTypes.xsd file, the 
following additional changes were made. Additions are highlighted.

4 <operation name="getEntitlementCount">
<soap:operation style="document"/>
<input>

<soap:body use="literal" />
</input>
<output>

<soap:body use="literal" />
</output>

</operation>
<operation name="getEntitlementAttributeCount">

<soap:operation style="document"/>
<input>

<soap:body use="literal" />
</input>
<output>

<soap:body use="literal" />
</output>

</operation>

# Change

1 <xs:element name="sortBys" type="tns:activatableItemsSortBys" minOccurs="0"/>
<xs:element name="isEmbeddedLicenseModel" type="xs:boolean" minOccurs="0"/>
<xs:element name="lineItemState" type="tns:StateQueryType"  minOccurs="0"/>
<xs:element name="soldToDisplayName" type="tns:SimpleQueryType"  minOccurs="0"/>
<xs:element name="productLine" type="tns:SimpleQueryType"  minOccurs="0"/>
<xs:element name="expiresIn" type="tns:DurationType"  minOccurs="0"/>
<xs:element name="activatableItemOwnersSearch" type="tns:ActivatableItemOwnersType"  minOccurs="0"/>

2 <xs:element name="fetchCreatedBy" type="xs:boolean" minOccurs="0"/> 
<xs:element name="fetchLastModifiedBy" type="xs:boolean" minOccurs="0"/>
<xs:element name="activatableItemOwners" type="xs:boolean" minOccurs="0"/>

3 <xs:element name="transferredFromLineItem" type="xs:string" minOccurs="0"/>
<xs:element name="splitFromLineItem" type="xs:string" minOccurs="0"/>
<xs:element name="activatableItemOwners" type="tns:ActivatableItemOwnersType" minOccurs="0"/>

4 <xs:element name="unlinkMaintenanceLineItemRequest" type="tns:unlinkMaintenanceLineItemRequestType"/>
<xs:element name="unlinkMaintenanceLineItemResponse" type="tns:unlinkMaintenanceLineItemResponseType"/>

<xs:complexType name="ActivatableItemOwnersType">
<xs:sequence>

<xs:element name="activatableItemOwner" type="xs:string" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>

</xs:complexType>

# Change
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entitlementOrderTypes.xsd

In addition to updating the version number from 8 to 9 in the entitlementOrderItemTypes.xsd file, the 
following additional changes were made. Additions are highlighted.

entitlementAttributeTypes.xsd

The entitlementAttributeTypes.xsd file has been added in this release. It contains the following 
Elements:

<xs:complexType name="searchEntitlementAttributeDataType">
<xs:sequence>

<xs:element name="entitlementId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="activationIds" type="tns:activationIdList" minOccurs="0" />
<xs:element name="entDescription" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="productName" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="productVersion" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="productType" type="tns:ProductType" minOccurs="0"/>
<xs:element name="partNumber" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="isBulk" type="xs:boolean" minOccurs="0"/>
<xs:element name="soldTo" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="shipToEmail" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="contactEmail" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="shipToAddress" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="emailTemplateVariation" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="startDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="isPermanent" type="xs:boolean" minOccurs="0"/>
<xs:element name="expirationDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="isAutoRenewal" type="xs:boolean" minOccurs="0"/>
<xs:element name="renewalInterval" type="tns:DurationType" minOccurs="0"/>
<xs:element name="renewalExpirationDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="createdOn" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="versionDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="lastModifiedDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="description" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="state" type="tns:StateQueryType" minOccurs="0"/>
<xs:element name="licenseTechnology" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="createdUserId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="accountUnitName" type="tns:PartnerTierQueryType"  minOccurs="0"/>
<xs:element name="currentOwnerName" type="tns:SimpleQueryType"  minOccurs="0"/>
<xs:element name="maintStartDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="maintIsPermanent" type="xs:boolean" minOccurs="0"/>
<xs:element name="maintExpirationDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="entitlementAttributes" type="tns:entCustomAttributesQueryListType" 

minOccurs="0"/>
</xs:sequence>

</xs:complexType>

<xs:complexType name="entitlementAttributeDataType">
<xs:choice>

# Change

1 <xs:include schemaLocation="../../schema-public/v9/entitlementLifeCycleTypes.xsd"/>
<xs:include schemaLocation="../../schema-public/v9/entitlementAttributeTypes.xsd"/>
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<xs:element name="simpleEntitlement"   type="tns:simpleEntitlementDataType" minOccurs="0"/>
<xs:element name="bulkEntitlement"   type="tns:bulkEntitlementDataType" minOccurs="0" />

</xs:choice>
</xs:complexType>

<xs:complexType name="searchEntitlementAttributeRequestType">
<xs:sequence>

<xs:element name="entitlementAttributeSearchCriteria" 
type="tns:searchEntitlementAttributeDataType"/>

<xs:element name="batchSize" type="xs:integer"/>
<xs:element name="pageNumber" type="xs:integer" minOccurs="0"/>

</xs:sequence>
</xs:complexType>

<xs:complexType name="searchEntitlementAttributeResponseType">
<xs:sequence>

<xs:element name="statusInfo"   type="tns:StatusInfoType"/>
<xs:element name="entitlement"   type="tns:entitlementAttributeDataType" minOccurs="0" 

maxOccurs="unbounded"/>
</xs:sequence>

</xs:complexType>

<xs:complexType name="getEntitlementCountAttributeRequestType">
<xs:sequence>

<xs:element name="queryParams" type="tns:searchEntitlementAttributeDataType"/>
</xs:sequence>

</xs:complexType>

<xs:complexType name="getEntitlementCountAttributeResponseType">
<xs:sequence>

<xs:element name="statusInfo"   type="tns:StatusInfoType"/>
<xs:element name="count"   type="xs:integer" minOccurs="0"/>

</xs:sequence>
</xs:complexType>

<xs:element name="searchEntitlementAttributeRequest" type="tns:searchEntitlementAttributeRequestType"/>
<xs:element name="searchEntitlementAttributeResponse" type="tns:searchEntitlementAttributeResponseType"/>
<xs:element name="getEntitlementAttributeCountRequest" 
type="tns:getEntitlementCountAttributeRequestType"/>
<xs:element name="getEntitlementAttributeCountResponse" 
type="tns:getEntitlementCountAttributeResponseType"/>

Change Log: Optional vendorAuthString parameter in 
getFeaturesQueryRequest API in ProductPackagingService v3
The getFeaturesQueryRequest API in the ProductPackagingService web service (version 3) supports 
the new optional parameter vendorAuthString. Producers can use the new parameter to retrieve the 
vendor auth string alongside other feature properties and to query feature information.

Note • This enhancement was tracked in SWM-27118 (see also Optional vendorAuthString parameter 
in getFeaturesQueryRequest API in ProductPackagingService v3).

Modifications were made to the following file:
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• featureTypes.xsd

featureTypes.xsd

The following changes were made to this file. Additions are highlighted.

# Change

1 <xs:complexType name="featureDataType">
<xs:sequence>

<xs:element name="featureName" type="xs:string"/>
<xs:element name="versionFormat" type="tns:VersionFormatType"/>
<xs:element name="version" type="xs:string" minOccurs="0"/>
<xs:element name="maxVersion" type="xs:string" minOccurs="0"/>
<xs:element name="description" type="xs:string" minOccurs="0"/>
<xs:element name="aggregationType" type="tns:AggregationType" minOccurs="0"/>
<xs:element name="vendorAuthString" type="xs:string" minOccurs="0"/>
<xs:element name="featureOverrideParams" type="tns:featureOverrideParamsType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>

2 <xs:complexType name="featureOverrideParamsType">
<xs:sequence>

<xs:element name="vendorString" type="xs:string" minOccurs="0"/>
<xs:element name="notice" type="xs:string" minOccurs="0"/>
<xs:element name="borrowable" type="xs:string" minOccurs="0"/>
<xs:element name="serialNumber" type="xs:string" minOccurs="0"/>
<xs:element name="dupGroup" type="tns:dupGroupDataType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>  

3 <xs:complexType name="featureQueryDataType">
<xs:sequence>

<xs:element name="uniqueId" type="xs:string"/>
<xs:element name="featureName" type="xs:string"/>
<xs:element name="versionFormat" type="tns:VersionFormatType"/>
<xs:element name="version" type="xs:string" minOccurs="0"/>
<xs:element name="description" type="xs:string" minOccurs="0"/>
<xs:element name="state" type="tns:StateType"/>
<xs:element name="vendorAuthString" type="xs:string" minOccurs="0"/>
<xs:element name="featureOverrideParams" type="tns:featureOverrideParamsType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  221

Change Log for 2025.05
Zero Mapping of Activation IDs on Cloud Licensing Service Instances 
The 2025.05 release introduces version 7 of the ManageDevice SOAP web service. The new version 
contains a new operation, zeroCountAddonLineItems, which enables producers to explicitly set an 
activation ID with a zero allocation mapping on a Cloud Licensing Service (CLS) instance. 

To implement these new actions, the ManageDeviceService.wsdl file and its associated 
manageDeviceTypes.xsd file have been updated to v7 and modifications have been made. 

Note • This enhancement was tracked in SWM-25022. 

4 <xs:complexType name="updateFeatureDataType">
<xs:sequence>

<xs:element name="featureIdentifier" type="tns:featureIdentifierType" />
<xs:element name="featureName" type="xs:string" minOccurs="0"/>
<xs:element name="versionFormat" type="tns:VersionFormatType" minOccurs="0"/>
<xs:element name="version" type="xs:string" minOccurs="0"/>
<xs:element name="maxVersion" type="xs:string" minOccurs="0"/>
<xs:element name="description" type="xs:string" minOccurs="0"/>
<xs:element name="vendorAuthString" type="xs:string" minOccurs="0"/>
<xs:element name="aggregationType" type="tns:AggregationType" minOccurs="0"/>
<xs:element name="featureOverrideParams" type="tns:featureOverrideParamsType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>

5 <xs:complexType name="featureQueryParametersType">
<xs:sequence>

<xs:element name="featureName" type="tns:SimpleQueryType" minOccurs="0" nillable="true"/>
<xs:element name="version" type="tns:SimpleQueryType" minOccurs="0" nillable="true"/>
<xs:element name="versionFormat" type="tns:VersionFormatQueryType" minOccurs="0" nillable="true"/>
<xs:element name="description" type="tns:SimpleQueryType" minOccurs="0" nillable="true"/>
<xs:element name="state" type="tns:StateQueryType" minOccurs="0" nillable="true"/>
<xs:element name="creationDate" type="tns:DateQueryType" minOccurs="0" nillable="true"/>
<xs:element name="lastModifiedDate" type="tns:DateQueryType" minOccurs="0" nillable="true"/>
<xs:element name="vendorAuthString" type="tns:SimpleQueryType" minOccurs="0" nillable="true"/>

</xs:sequence>
</xs:complexType>  

# Change
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ManageDeviceService.wsdl

In addition to updating the version number from 6 to 7 in multiple locations in the 
ManageDeviceService.wsdl file, the following additional changes were made. Additions are 
highlighted.

# Change

1 <message name="decrementAddonLineItemsResponse">
<part name="msgparameters" element="tns:decrementAddonLineItemsResponse"/>

</message>
<message name="zeroCountAddonLineItemsRequest">

<part name="msgparameters" element="tns:zeroCountAddonLineItemsRequest"/>
</message>
<message name="zeroCountAddonLineItemsResponse">

<part name="msgparameters" element="tns:zeroCountAddonLineItemsResponse"/>
</message>

2 <operation name="incrementAddonLineItems">
<input message="tns:incrementAddonLineItemsRequest"/>
<output message="tns:incrementAddonLineItemsResponse"/>

</operation>
<operation name="zeroCountAddonLineItems">

<input message="tns:zeroCountAddonLineItemsRequest"/>
<output message="tns:zeroCountAddonLineItemsResponse"/>

</operation>

3 <operation name="incrementAddonLineItems">
<soap:operation style="document"/>
<input>

<soap:body use="literal" />
</input>
<output>

<soap:body use="literal" />
</output>

</operation>
<operation name="zeroCountAddonLineItems">

<soap:operation style="document"/>
<input>

<soap:body use="literal" />
</input>
<output>

<soap:body use="literal" />
</output>

</operation>
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manageDeviceTypes.xsd

In addition to updating the version number from 6 to 7 in multiple locations in the 
manageDeviceTypes.xsd file, the following Elements were added.

Change Log for 2025.02
Ability to List Fulfillment And License Information for Specified Host
The LicenseFulfillmentService.wsdl has been updated to v2. It includes the following:

• New getHostQuery operation to list fulfillment and license information by hostid. 

• New getHostCount operation to get the number of hosts that fit certain criteria. This number can 
be used as batchSize input in getHostQuery.

Note • These enhancements were tracked in SWM-22714 and SWM-25245, respectively (see 
Returning Fulfillment and License Information for Non-Embedded Technologies Using Web Services 
and New Operation for Getting Host Count in License Service SOAP Web Service). 

Changes to the WSDL and XSD Files

The LicenseFulfillmentService.wsdl file includes a reference to the licenseFulfillmentTypes.xsd file, 
and that .xsd file refers to the following additional .xsd files:

• licenseFulfillmentTypes.xsd

• trustedOfflineActivationTypes.xsd

• fulfillmentTypes.xsd

• commonTypes.xsd

# Change

1 <xs:element name="incrementAddonLineItemsResponse" type="tns:linkAddonLineItemsResponseType"/>
<xs:element name="zeroCountAddonLineItemsRequest" type="tns:linkAddonLineItemsRequestType"/>
<xs:element name="zeroCountAddonLineItemsResponse" type="tns:linkAddonLineItemsResponseType"/>
<xs:element name="decrementAddonLineItemsRequest" type="tns:linkAddonLineItemsRequestType"/>
<xs:element name="decrementAddonLineItemsResponse" type="tns:linkAddonLineItemsResponseType"/>
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LicenseFulfillmentService.wsdl

In addition to updating the version number from 1 to 2 in multiple locations in the 
LicenseFulfillmentService.wsdl file, the following additional changes were made. Additions are 
highlighted.

# Change

1 <message name="createLicenseResponse">
<part name="msgparameters" element="tns:createLicenseResponse"/>

</message>
<message name="createCVDFulfillmentsRequest">

<part name="msgparameters" element="tns:createCVDFulfillmentsRequest"/>
</message>
<message name="createCVDFulfillmentsResponse">

<part name="msgparameters" element="tns:createCVDFulfillmentsResponse"/>
</message>

2 <message name="createLicensesAsBatchAndConsolidateResponse">
<part name="msgparameters" element="tns:createLicensesAsBatchAndConsolidateResponse"/>

</message>
<message name="createCVDLicenseFileRequest">

<part name="msgparameters" element="tns:createCVDLicenseFileRequest"/>
</message>
<message name="createCVDLicenseFileResponse">

<part name="msgparameters" element="tns:createCVDLicenseFileResponse"/>
</message>

3 <message name="transferHostResponse">
<part name="msgparameters" element="tns:transferHostResponse"/>

</message>
<message name="getHostQueryRequest">

<part name="msgparameters" element="tns:getHostQueryRequest"/>
</message>
<message name="getHostQueryResponse">

<part name="msgparameters" element="tns:getHostQueryResponse"/>
</message>
<message name="getHostCountRequest">

<part name="msgparameters" element="tns:getHostCountRequest"/>
</message>
<message name="getHostCountResponse">

<part name="msgparameters" element="tns:getHostCountResponse"/>
</message>

4 <operation name="createLicense">
<input message="tns:createLicenseRequest"/>

<output message="tns:createLicenseResponse"/>
</operation>
<operation name="createCVDFulfillments">

<input message="tns:createCVDFulfillmentsRequest"/>
<output message="tns:createCVDFulfillmentsResponse"/>

</operation>
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5 <operation name="createLicensesAsBatchAndConsolidate">
<input message="tns:createLicensesAsBatchAndConsolidateRequest"/>
<output message="tns:createLicensesAsBatchAndConsolidateResponse"/>

</operation>
<operation name="createCVDLicenseFile">

<input message="tns:createCVDLicenseFileRequest"/>
<output message="tns:createCVDLicenseFileResponse"/>

</operation>

6 <operation name="transferHost">
<input message="tns:transferHostRequest"/>
<output message="tns:transferHostResponse"/>

</operation>
<operation name="getHostQuery">

<input message="tns:getHostQueryRequest"/>
<output message="tns:getHostQueryResponse"/>

</operation>
<operation name="getHostCount">

<input message="tns:getHostCountRequest"/>
<output message="tns:getHostCountResponse"/>

</operation>

7 <operation name="createLicense">
<soap:operation style="document"/>
<input>

<soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>
<operation name="createCVDFulfillments">

<soap:operation style="document"/>
<input>

<soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>

# Change
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licenseFulfillmentTypes.xsd

The only change made to the licenseFulfillmentTypes.xsd file between v1 and v2 was to update the 
version number from 1 to 2 in multiple locations in the file.

8  <operation name="createLicensesAsBatchAndConsolidate">
<soap:operation style="document"/>
<input>

<soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>
<operation name="createCVDLicenseFile">

<soap:operation style="document"/>
<input>

<soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>

9 <operation name="transferHost">
<soap:operation style="document"/>
<input>

<soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>
<operation name="getHostQuery">

<soap:operation style="document"/>
<input>

<soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>
<operation name="getHostCount">

<soap:operation style="document"/>
<input>

soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>

# Change
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trustedOfflineActivationTypes.xsd

The only change made to the trustedOfflineActivationTypes.xsd file between v1 and v2 was to 
update the version number from 1 to 2 in multiple locations in the file.

fulfillmentTypes.xsd

In addition to updating the version number from 1 to 2 in multiple locations in the 
fulfillmentTypes.xsd file, the following complexTypes were added.

# Change

1 <!-- START createCVDFulfillments -->
<xs:element name="createCVDFulfillmentsRequest" type="tns:createFulfillmentRequestType"/>
<xs:element name="createCVDFulfillmentsResponse" type="tns:createFulfillmentResponseType"/>
<!-- END createCVDFulfillments -->
<!-- START verifyCreateLicense -->
<xs:element name="verifyCreateLicenseRequest" type="tns:createFulfillmentRequestType"/>
<xs:element name="verifyCreateLicenseResponse" type="tns:createFulfillmentResponseType"/>
<!-- END verifyCreateLicense -->



FlexNet Operations 2025.12 ALM Release Notes  (December 2025)  228

2 <!-- END consolidatedFulfillments -->
<!-- START createCVDLicenseFile -->
<xs:complexType name="createCVDLicenseFileRequestType">

<xs:sequence>
<xs:element name="queryParams" type="tns:CVDLicenseFileQueryParametersType" minOccurs="0"/>
<xs:element name="vendorStringIsCumulative" type="xs:boolean"/>
<xs:element name="pageNumber" type="xs:integer" nillable="true"/>
<xs:element name="batchSize" type="xs:integer" nillable="true"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="CVDLicenseFileQueryParametersType">

<xs:sequence>
<xs:element name="hostId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="nodeLockHostId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="customHostAttributes" type="tns:customAttributesQueryListType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="createCVDLicenseFileResponseType">

<xs:sequence>
<xs:element name="statusInfo" type="tns:StatusInfoType"/>
<xs:element name="responseData" type="tns:CVDLicenseFileConsolidatedResponseDataType" 

minOccurs="0"/>
</xs:sequence>

</xs:complexType>
<xs:complexType name="CVDLicenseFileConsolidatedResponseDataType">

<xs:sequence>
<xs:element name="licenseTechnology" type="tns:CVDLicenseFileConsolidatedLicenseDataType" 

minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>

</xs:complexType>
<xs:complexType name="CVDLicenseFileConsolidatedLicenseDataType">

<xs:sequence>
<xs:element name="licenseTechnologyName" type="xs:string" minOccurs="0"/>
<xs:element name="soldTo" type="xs:string"/>
<xs:element name="criteria" type="xs:string"/>
<xs:element name="licenseGenerator" type="tns:CVDLicenseGeneratorType" minOccurs="0" 

maxOccurs="unbounded"/>
<xs:element name="state" type="tns:StateType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="CVDLicenseGeneratorType">

<xs:sequence>
<xs:element name="licenseGeneratorName" type="xs:string"/>
<xs:element name="consolidatedLicenseId" type="xs:string"/>
<xs:element name="consolidatedFulfillments" type="tns:fulfillmentIdentifierListType"/>
<xs:element name="licenseFiles" type="tns:licenseFileDataListType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:element name="createCVDLicenseFileRequest" type="tns:createCVDLicenseFileRequestType"/>
<xs:element name="createCVDLicenseFileResponse" type="tns:createCVDLicenseFileResponseType"/>
<!--  END createCVDLicenseFile -->

# Change
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3 <!-- end transferHost -->
<!--START getHostQueryTypes -->
<xs:complexType name="hostDataType">

<xs:sequence>
<xs:element name="soldTo" type="xs:string"/>
<xs:element name="licenseTechnology" type="tns:licenseTechnologyIdentifierType" minOccurs="0"/>
<xs:element name="state" type="tns:StateType" minOccurs="0"/>
<xs:element name="hostID" type="xs:string" minOccurs="0"/>
<xs:element name="hostType" type="xs:string" minOccurs="0"/>
<xs:element name="account" type="xs:string" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="hostQueryParametersType">

<xs:sequence>
<xs:element name="hostId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="soldTo" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="licenseTechnology" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="hostType" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="account" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="fulfillmentState" type="tns:fulfillmentStateQueryType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="getHostQueryRequestType">

<xs:sequence>
<xs:element name="queryParams" type="tns:hostQueryParametersType" minOccurs="0"/>
<xs:element name="pageNumber" type="xs:integer" nillable="true"/>
<xs:element name="batchSize" type="xs:integer" nillable="true"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="getHostQueryResponseDataType">

<xs:sequence>
<xs:element name="hostData" type="tns:hostDataType" minOccurs="0" maxOccurs="unbounded"/>
<xs:element name="fulfillmentState" type="xs:string" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="getHostQueryResponseType">

<xs:sequence>
<xs:element name="statusInfo" type="tns:StatusInfoType"/>
<xs:element name="responseData" type="tns:getHostQueryResponseDataType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:element name="getHostQueryRequest" type="tns:getHostQueryRequestType"/>
<xs:element name="getHostQueryResponse" type="tns:getHostQueryResponseType"/>
<!-- END getHostQueryTypes -->

# Change
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commonTypes.xsd

In addition to updating the version number from 1 to 2 in multiple locations in the commonTypes.xsd 
file, the following additional changes were made. Additions are highlighted in blue.

# Change

1 <xs:simpleType name="CreateOrUpdateOperationType">
<xs:restriction base="xs:NMTOKEN">

<xs:enumeration value="CREATE_OR_UPDATE"/>
<xs:enumeration value="CREATE_OR_IGNORE"/>

</xs:restriction>
</xs:simpleType>
<xs:simpleType name="CreateOrUpdateOperationAccountType">

<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="CREATE_OR_UPDATE"/>
<xs:enumeration value="CREATE_OR_IGNORE"/>

</xs:restriction>
</xs:simpleType>
<xs:simpleType name="CollectionOperationType">

<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="REPLACE"/>
<xs:enumeration value="ADD"/>
<xs:enumeration value="DELETE"/>

</xs:restriction>
</xs:simpleType>
<xs:simpleType name="CollectionOperationAccountType">

<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="REPLACE"/>
<xs:enumeration value="ADD"/>
<xs:enumeration value="DELETE"/>

</xs:restriction>
</xs:simpleType>
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2 <xs:complexType name="OrgTypeList">
<xs:sequence>

<xs:element name="orgType" type="tns:OrgType" minOccurs="1" maxOccurs="unbounded" />
</xs:sequence>

</xs:complexType>

<xs:simpleType name="accountType">
<xs:restriction base="xs:NMTOKEN">

<xs:enumeration value="CUSTOMER"/>
<xs:enumeration value="PUBLISHER"/>
<xs:enumeration value="CHANNEL_PARTNER"/>
<xs:enumeration value="SELF_REGISTERED"/>

</xs:restriction>
</xs:simpleType>
<xs:complexType name="accountTypeList">

<xs:sequence>
<xs:element name="accountType" type="tns:accountType" minOccurs="1" maxOccurs="unbounded" />

</xs:sequence>
</xs:complexType>
<xs:complexType name="fulfillmentStateQueryType">

<xs:sequence>
<xs:element name="value" type="tns:fulfillmentStateType"/>
<xs:element name="searchType" type="tns:simpleSearchType"/>

</xs:sequence>
</xs:complexType>
<xs:simpleType name="fulfillmentStateType">

<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="ACTIVE"/>
<xs:enumeration value="OBSOLETE"/>
<xs:enumeration value="ON_HOLD"/>

</xs:restriction>
</xs:simpleType>

# Change
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Legal Information
Copyright Notice
Copyright © 2025 Flexera Software

This publication contains proprietary and confidential information and creative works owned by 
Flexera Software and its licensors, if any. Any use, copying, publication, distribution, display, 
modification, or transmission of such publication in whole or in part in any form or by any means 
without the prior express written permission of Flexera Software is strictly prohibited. Except where 
expressly provided by Flexera Software in writing, possession of this publication shall not be construed 
to confer any license or rights under any Flexera Software intellectual property rights, whether by 
estoppel, implication, or otherwise.

All copies of the technology and related information, if allowed by Flexera Software, must display this 
notice of copyright and ownership in full.

FlexNet Operations incorporates software developed by others and redistributed according to license 
agreements. Copyright notices and licenses for these external libraries are provided in a 
supplementary document that accompanies this one.

Intellectual Property
For a list of trademarks and patents that are owned by Flexera Software, see 
https://www.revenera.com/legal/intellectual-property.html. All other brand and product names 
mentioned in Flexera Software products, product documentation, and marketing materials are the 
trademarks and registered trademarks of their respective owners.

Restricted Rights Legend
The Software is commercial computer software. If the user or licensee of the Software is an agency, 
department, or other entity of the United States Government, the use, duplication, reproduction, 
release, modification, disclosure, or transfer of the Software, or any related documentation of any kind, 
including technical data and manuals, is restricted by a license agreement or by the terms of this 
Agreement in accordance with Federal Acquisition Regulation 12.212 for civilian purposes and 
Defense Federal Acquisition Regulation Supplement 227.7202 for military purposes. The Software was 
developed fully at private expense. All other use is prohibited.

https://www.revenera.com/legal/intellectual-property.html
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